When designing a system, always read the relevant manuals and give due consideration to safety. In addition, pay careful attention to the following points for proper handling during training.

[Precautions during training]

⚠️ **Danger**

- To prevent electric shock, do not touch the terminal block while the power is supplied.
- When opening the safety cover, turn off the power, or make sure that it is sufficiently safe.

⚠️ **Caution**

- Follow the instructor's directions during training.
- Do not remove training machine units or change wiring without permission. Doing so could cause a breakdown, faulty operation, injury, or fire.
- Turn the power OFF before mounting or removing a unit. Doing so while the current is ON could cause a breakdown or electric shock.
- If the training machine emits a strange odour or sound, press the "Power Switch" or the "Emergency Switch" to stop the machine.
- If any trouble occurs, contact the instructor right away.
<table>
<thead>
<tr>
<th>Print date</th>
<th>* Instruction manual number</th>
<th>Revised content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mar, 2006</td>
<td>SH(NA)-080633ENG-A</td>
<td>First edition printing</td>
</tr>
</tbody>
</table>

This manual is not a grant of license or guarantee regarding invocation of industrial property rights and other rights. Mitsubishi Electric Corporation bears no responsibility for any industrial property rights problems that may arise as a result of using this manual.
# Introduction

About the manuals .......................................................................................................................... (7)
System Configuration in this Textbook .......................................................................................... (9)

## Chapter 1 What is the GOT? 1-1 to 1-12

1.1 About the GOT ......................................................................................................................... 1-1
1.2 Procedures for monitoring the PLC CPU by GOT ................................................................. 1-1
1.3 GOT features ........................................................................................................................... 1-2
1.4 GOT function list ..................................................................................................................... 1-4
1.5 Applicable connection type between the GOT and the PLC CPU ....................................... 1-6
1.6 Equipments required for using GOT ....................................................................................... 1-9

## Chapter 2 About GOT Operation 2-1 to 2-10

2.1 Summary of operation ............................................................................................................ 2-1
2.2 Entering numerals into PLC .................................................................................................. 2-3
   2.2.1 Numerical input function ................................................................................................. 2-3
   2.2.2 How to operate numerical input ...................................................................................... 2-4
2.3 Switching the screen displayed .............................................................................................. 2-5
   2.3.1 The screen type ............................................................................................................... 2-5
   2.3.2 Screen switching device ................................................................................................. 2-6
   2.3.3 Base screen switching with the sequence program ...................................................... 2-7
   2.3.4 Base screen switching with the touch switch ............................................................... 2-8
   2.3.5 Window screen display and switching ......................................................................... 2-9

## Chapter 3 About GT Designer2 3-1 to 3-34

3.1 GT Designer2 Features ........................................................................................................... 3-1
3.2 GT Designer2 Screen Configuration and Basic Operations .................................................. 3-6
   3.2.1 Basic operations of dialog box ....................................................................................... 3-6
   3.2.2 Workspace operations .................................................................................................. 3-8
   3.2.3 Object placement area and display area on GOT (temporary area) ............................. 3-12
3.3 Menu Configuration ................................................................................................................ 3-14
3.4 Toolbar .................................................................................................................................. 3-17
3.5 Using Library .......................................................................................................................... 3-24
   3.5.1 What is the library? ......................................................................................................... 3-24
   3.5.2 Creating user library ...................................................................................................... 3-28
   3.5.3 Pasting objects or figures from library ......................................................................... 3-31
3.6 How to use the online manual .............................................................................................. 3-32
   3.6.1 Reading the online manual from the product CD-ROM ............................................ 3-32
   3.6.2 Reading the online manual from the GT Designer2 Help ........................................... 3-34
5.5 Operation Check 1 ................................................................. 5-42
5.6 Creating Original Library .................................................. 5-45
  5.6.1 Object Registration ...................................................... 5-45
  5.6.2 Editing registered objects and figures ............................ 5-46
  5.6.3 Pasting Objects or Figures from Library ....................... 5-47
5.7 Superimposition of Graph using Layers .................................. 5-48
  5.7.1 Layer ........................................................................ 5-49
  5.7.2 Trend graph setting ..................................................... 5-50
  5.7.3 Bar graph setting ....................................................... 5-53
  5.7.4 Layer display switching ............................................... 5-56
  5.7.5 Alternate (ALT) toggle switch settings ....................... 5-57
  5.7.6 Go To Screen Switch settings ....................................... 5-58
5.8 Operation Check 2 ............................................................... 5-59
5.9 Comment Display Settings .................................................. 5-60
  5.9.1 Comment display ...................................................... 5-60
  5.9.2 Comment registration ................................................ 5-62
  5.9.3 Comment display settings by bit device ...................... 5-64
  5.9.4 Comment display settings by word device .................. 5-67
  5.9.5 Go To Screen Switch settings ....................................... 5-70
5.10 Window Screen Settings ..................................................... 5-71
5.11 Operation Check 3 ............................................................... 5-76
5.12 Controlling the View and Operation of Objects Based on Conditions ........................................ 5-80
  5.12.1 Setting the states for objects ..................................... 5-80
  5.12.2 Setting the display/operation conditions for objects .... 5-86
5.13 Operation Check 4 ............................................................... 5-92
5.14 Offset Function ................................................................. 5-94
5.15 Operation Check 5 ............................................................... 5-99
5.16 Parts Movement Function .................................................. 5-100
  5.16.1 Parts .................................................................... 5-100
  5.16.2 Parts registration ..................................................... 5-102
  5.16.3 Parts movement display settings ............................... 5-104
5.17 Operation Check 6 ............................................................... 5-108
5.18 Recipe Settings ................................................................. 5-109
  5.18.1 Recipes ................................................................. 5-109
  5.18.2 Units and option OS required for the recipe function .... 5-112
  5.18.3 Screen setting examples .......................................... 5-113
  5.18.4 Numerical input settings for recipe operation test ....... 5-113
  5.18.5 Recipe settings ....................................................... 5-115
  5.18.6 Recipe 1 set switch settings ...................................... 5-117
  5.18.7 Recipe 2 set switch settings ...................................... 5-118
5.19 Operation Check 7 ............................................................... 5-119
5.20 Alarm history display function ............................................. 5-120
  5.20.1 About the alarm ..................................................... 5-120
  5.20.2 About the alarm history display function .................. 5-122
  5.20.3 Settings screen example .......................................... 5-126
  5.20.4 Alarm history display function settings .................... 5-127
Appendix 5.5 Operation check (2) ................................................................. Appendix -44
Appendix 5.6 System monitor function .......................................................... Appendix -45
Appendix 5.7 Operation check (device monitor operation) ............................... Appendix -48
Appendix 5.8 Training sequence program ...................................................... Appendix -55
Appendix 6 Installation of USB Driver ............................................................ Appendix -56
Appendix 7 Specifications of Available Object Functions ............................... Appendix -57
Appendix 8 Glossary .................................................................................. Appendix -69
Introduction

This textbook is the “practice” edition.
Practice how to use Mitsubishi Graphic Operation Terminal exercising the training in this textbook.
Chapters 1, 2, and 4 are the same as the ones for the basic edition.

[Basic edition]
Learn basic subjects relating to Mitsubishi graphic operation terminal skills.
Course content:
1. GOT1000 series function, performance, and system configuration
2. GOT basic operation and setup procedures
3. Figure and basic object function
   (Text, numerical display, numerical input, lamp display, comment display, touch switch, etc.)
4. Ladder monitor and system monitor function

[Practice edition]
Learn efficient methods to control screens using Mitsubishi graphic operation terminal.
Course content:
1. GOT operation and GT Designer2 basic operations
2. How to use advanced object functions
   (including Layer, graph, comment display, language switching, user-defined library, parts movement, alarm function)
About the manuals

Manual Selection

The GOT manuals are classified according to objectives. Refer to the following table and then read the manuals suited to understand GOT main unit and software handling, operation, and functions.

<table>
<thead>
<tr>
<th>Objective</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Using GOT for the first time</td>
<td>This textbook and the relevant manual (1)</td>
</tr>
<tr>
<td>- Learning about the GOT</td>
<td></td>
</tr>
<tr>
<td>- drawing by using GT Designer2</td>
<td></td>
</tr>
<tr>
<td>- Installing each GOT software in the personal computer</td>
<td>The relevant manual (1)</td>
</tr>
<tr>
<td>- Running each software</td>
<td></td>
</tr>
<tr>
<td>- Learning how to use the online manual</td>
<td></td>
</tr>
<tr>
<td>- Learning GT Designer2 screen configuration, how to customize the screens, and how to from create project data up to transfer data</td>
<td>The relevant manual (1)</td>
</tr>
<tr>
<td>- Learning the specifications and settings of each GT Designer2 object function</td>
<td>The relevant manual (2)</td>
</tr>
<tr>
<td>- Confirming the applicable connection types for GOT</td>
<td>The relevant manual (3)</td>
</tr>
<tr>
<td>- Confirming the system configuration for each connection type</td>
<td></td>
</tr>
<tr>
<td>- Confirming the setting method for the unit to be used</td>
<td></td>
</tr>
<tr>
<td>- Confirming the wiring diagram of connection cable for the unit to be used</td>
<td></td>
</tr>
<tr>
<td>- Converting the monitor screen data created with GOT900 series and Digital Electronics Corporation’s package into GOT1000 series data</td>
<td>The relevant manual (5)</td>
</tr>
<tr>
<td>- Using the function of GOT main unit and using the GOT debug to check the status of the target CPU, special function module, and network</td>
<td>The relevant manual (6)</td>
</tr>
<tr>
<td>- By Using a personal computer, reading and writing the data stored on the PC card and the PLC CPU devices monitored by GOT</td>
<td>The relevant manual (7)</td>
</tr>
<tr>
<td>- Sending the error occurrence and restored data of alarm history display function to personal computer or mobile phone by email</td>
<td></td>
</tr>
<tr>
<td>- By using the GOT, reading and writing PLC CPU devices monitored by the other GOT</td>
<td></td>
</tr>
</tbody>
</table>
Relevant manuals

The following table lists the relevant manuals for this product. Refer to this table as needed.

<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Manual Number (Model name code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) GT Designer2 Version2 Basic Operation/Data Transfer Manual (For GOT1000 Series)</td>
<td>SH-080529ENG (1D7M24)</td>
</tr>
<tr>
<td>Explanation of GT Designer2 installation operations, basic operations for drawing, and method of data transfer to GOT1000</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)*</td>
<td></td>
</tr>
<tr>
<td>(2) GT Designer2 Version2 Screen Design Manual (For GOT1000 Series) 1/3</td>
<td>SH-080530ENG (1D7M25)</td>
</tr>
<tr>
<td>GT Designer2 Version2 Screen Design Manual (For GOT1000 Series) 2/3</td>
<td></td>
</tr>
<tr>
<td>GT Designer2 Version2 Screen Design Manual (For GOT1000 Series) 3/3</td>
<td></td>
</tr>
<tr>
<td>* Explanation of the specifications and settings of all GOT1000 Series Object Function</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)*</td>
<td></td>
</tr>
<tr>
<td>(3) GOT1000 Series Connection Manual (1/2)GOT1000 Series Connection Manual (2/2)</td>
<td>SH-080532ENG (1D7M26)</td>
</tr>
<tr>
<td>* Explanation of the Applicable System Configuration and cable making method for the GOT1000 Series Connection Types</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)*</td>
<td></td>
</tr>
<tr>
<td>(4) GT15 User’s Manual</td>
<td>SH-080528ENG (1D7M23)</td>
</tr>
<tr>
<td>Explanation of Hardware Including All GT15 Main Body Parts Names, External Dimensions, Installation, Electrical Wiring, Specifications, and an Introduction to Optional Equipment</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)*</td>
<td></td>
</tr>
<tr>
<td>(5) GT Converter2 Version2 Operating Manual</td>
<td>SH-080533ENG (1D7M27)</td>
</tr>
<tr>
<td>Explanation of GT Converter2 operation methods</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)*</td>
<td></td>
</tr>
<tr>
<td>(6) GOT1000 Series Extended/Option Functions Manual</td>
<td>SH-080544ENG (1D7M32)</td>
</tr>
<tr>
<td>Explanation of the extended/option functions that can be used in the GOT1000 Series</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)*</td>
<td></td>
</tr>
<tr>
<td>(7) GOT1000 Series Gateway Functions Manual</td>
<td>SH-080545ENG (1D7M33)</td>
</tr>
<tr>
<td>Explanation of System Configuration, and Setting Method for the Gateway Function Specifications</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)*</td>
<td></td>
</tr>
</tbody>
</table>

*Stored in GT Works2 and GT Designer2, in PDF Format.
System Configuration in this Textbook

A multiple CPU version of the Q series training machines is composed of two CPUs.

Parameters need to be set in GX Developer to enable multiple CPUs to operate. Set parameters by following the procedures described below to write to both No. 1 and No. 2 of QCPU.

<Caution: The following settings are not required unless a multiple CPU system is used.>

<Setting procedure>
1) Double-click [PLC parameter] from the project list in GX Developer.
2) When the Qn (H) parameter setting appears, click the multiple CPU setting button.
3) Set "the number of CPUs" to "2" in the multiple CPU setting dialog box.
4) Click the setting completed button.

The PLC can also be monitored by GX Developer or any other relevant software via direct connection between the PC and the PLC through an RS-232 cable.
Chapter 1 What is the GOT?

1.1 About the GOT

The GOT (Graphic Operation Terminal) can be used as an electronic operation panel that enables such as switch operation, lamp display, data display, and message display on the monitor screen, which had been conventionally implemented with a control box.

1.2 Procedures for monitoring the PLC CPU by GOT

1) Create a screen to be displayed in GOT using GT Designer2, software for creating monitor screens.

2) Transfer the created monitor screen data to GOT.

3) Start monitoring after connecting to PLC CPU.
1.3 GOT features

(1) With its 256 colors, the color screen provides a sharp, clear display that yields a vivid, top quality image. Further, with the multi-color display board, 65,536-color display is available. (For GT15 only)

(2) With a memory card, high-speed data transfer of OS and screen data between personal computer and GOT is available. The CF card interface is standard equipment, so by mounting a memory card made for OS or screen data created on a personal computer, high-speed data can be exchanged. (Data can also be transferred via USB, RS-232, or Ethernet.)

(3) USB interface as standard equipment
The USB interface is provided as standard equipment. The interface is located at the front, so the cable can be connected without opening the panel. Data transferring time is reduced to approximately 1/20 compared with previous communication: RS-232. And setup time is also reduced significantly.

(4) For various connection types
Beginning with bus connection that allows for high-speed communication, GOT supports various connection types—including direct CPU, computer link, CC-Link, MELSECNET/10, and Ethernet connections. Select the connection type to suit the system.

(5) Heavy-duty body for an extreme environment or operation
Because the GOT display complies with IP67 standards for waterproof and dustproof, it can be used in various environments.

(6) Alarm function
When any breakdown or malfunction occur, the alarm messages are displayed. A history of the date, time, and frequency which the error occurred is held. The occurrence status can be displayed as a graph or saved to a memory card. Errors can be classified into groups or levels to help organize the error information.
(7) Parts overlay (Layer function)
With the layer function, parts(objects/figures) can be superimposed, which increases design flexibility.
For example, fluctuating numeric values and graphs, trend graphs and bar graphs, image data and pointers can be superimposed and displayed together.

(8) Expressive font variation
Two types of fonts are available: Mincho and Gothic. TrueType fonts and Windows® fonts are also available to display from small characters to large characters truly.

(9) Language switching function
The comment display created every language can be switched according to the device value.
Screens which all the characters on the screen switch to Japanese, English, and Korean are easy to create with a touch switch.

(10) Debug with enhanced compatibility with Mitsubishi PLC
All debug functions can be used to install the extended function OS to GOT from GT Designer2.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder Monitor Function</td>
<td>The sequence program can be monitored in ladder format. The primary source of coil ON/OFF status, the device, and contact point can be searched.</td>
</tr>
<tr>
<td>System monitor function</td>
<td>Controller devices can be monitored and modified. A function designed to increase the efficiency of maintenance operations so that maintenance can be performed to resolve trouble with the controller system.</td>
</tr>
<tr>
<td>Network Monitor Function</td>
<td>As MELSECNET line conditions are displayed, communication conditions can be checked by GOT only.</td>
</tr>
<tr>
<td>Intelligent Module Monitor Function</td>
<td>The data of the intelligent function module buffer memory can be monitored and changed using a dedicated screen. The I/O module signal condition can also be monitored.</td>
</tr>
<tr>
<td>Servo Amplifier Monitor Function</td>
<td>The parameter settings and reference/diagnosis of the error history for the servo amplifier connected by GOT can be performed.</td>
</tr>
<tr>
<td>CNC Monitor Function</td>
<td>The Position Display Monitor, Alarm Diagnosis Monitor, Tool Offset/Param, Program Monitor, and APLC release screen that are equal to those of MELDAS dedicated display device can be displayed on the MELDAS connected to GOT.</td>
</tr>
<tr>
<td>Q Motion Monitor Function</td>
<td>The Q motion controller CPU Servo Monitor and parameter settings can be performed on the GOT screen.</td>
</tr>
<tr>
<td>List Editor for A/List Editor for FX</td>
<td>MELSEC-A series, FX series sequence program can be edited in list (instruction word) format. Program changes can be made without peripheral.</td>
</tr>
</tbody>
</table>
## 1.4 GOT function list

The table below shows the list function for each GOT model.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display section</strong></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>TFT color liquid crystal (LCD of high intensity and wide angle view)</td>
</tr>
<tr>
<td>Screen size</td>
<td>10.4&quot;</td>
</tr>
<tr>
<td>Resolution</td>
<td>800x600 dots</td>
</tr>
<tr>
<td>Display size</td>
<td>211(8.31)(W) x 158(6.22)(H) [mm] [inch]</td>
</tr>
<tr>
<td>Display character</td>
<td>16-dot standard font: 50 characters x 37 lines</td>
</tr>
<tr>
<td></td>
<td>12-dot standard font: 66 characters x 50 lines</td>
</tr>
<tr>
<td>Display color</td>
<td>256color/65536color</td>
</tr>
<tr>
<td>Display angle</td>
<td>Left/Right: 50 degrees</td>
</tr>
<tr>
<td></td>
<td>Top: 35 degrees</td>
</tr>
<tr>
<td></td>
<td>Bottom: 45 degrees</td>
</tr>
<tr>
<td>Intensity of LCD only</td>
<td>280 [cd/m²]</td>
</tr>
<tr>
<td>Intensity adjustment</td>
<td>8-level adjustment</td>
</tr>
<tr>
<td>Life</td>
<td>Approx. 50,000 h (Operating ambient temperature: 25°C)</td>
</tr>
<tr>
<td>Backlight</td>
<td>Cold cathode fluorescent tube (replaceable) backlit shutoff detection function</td>
</tr>
<tr>
<td>Life</td>
<td>Approx. 40,000 h or longer (Time when display luminance reaches 50% at the</td>
</tr>
<tr>
<td></td>
<td>operating ambient temperature: 25°C)</td>
</tr>
<tr>
<td>Touch panel</td>
<td></td>
</tr>
<tr>
<td>Number of touch keys</td>
<td>1,900 objects/screen (Matrix structure of 38 lines x 50 columns)</td>
</tr>
<tr>
<td>Key size</td>
<td>Minimum 16 x 16 dots (per key)</td>
</tr>
<tr>
<td>Number of objects that</td>
<td>Maximum of 2 objects</td>
</tr>
<tr>
<td>can be simultaneously</td>
<td></td>
</tr>
<tr>
<td>touched</td>
<td></td>
</tr>
<tr>
<td>Life</td>
<td>1 million times or more (operating force 0.98 max.)</td>
</tr>
<tr>
<td>Human sensor</td>
<td></td>
</tr>
<tr>
<td>Detection length</td>
<td>None</td>
</tr>
<tr>
<td>Detection range</td>
<td>None</td>
</tr>
<tr>
<td>Detection delay time</td>
<td>None</td>
</tr>
<tr>
<td>Memory</td>
<td></td>
</tr>
<tr>
<td>C drive</td>
<td>Built-in flash memory 9M bytes (for storing project data and OS)</td>
</tr>
<tr>
<td>Life</td>
<td>100,000 times</td>
</tr>
<tr>
<td>Battery</td>
<td>GT-15BAT lithium battery (Option)</td>
</tr>
<tr>
<td>Backup target</td>
<td>Clock data and maintenance time notification data</td>
</tr>
<tr>
<td>Life</td>
<td>Approx. 5 years (Operating ambient temperature of 25°C)</td>
</tr>
</tbody>
</table>

(Continued to next page)
<table>
<thead>
<tr>
<th>Item</th>
<th>GT1575-STBA, GT1575-STBD</th>
<th>GT1575-VTBA, GT1575-VTBD</th>
<th>GT1575-VNBA, GT1575-VNBD</th>
<th>GT1572-VNBA, GT1572-VNBD</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Built-in interface</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RS-232</td>
<td>RS-232, 1ch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transmission speed:115,200/57,600/38,400/19,200/9,600/4,800 bps</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connector shape:D-sub 9-pin (Male)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application: For communicating with a controller or connecting a personal computer (Project data upload/download, OS installation, FA transparent function)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB</td>
<td>USB (Full Speed 12 Mbps), 1ch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connector shape: Mini-B</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application: For connecting a personal computer (Project data upload/download, OS installation and FA transparent function)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CF card</td>
<td>Compact flash slot, 1ch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connector shape: TYPE I</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application: Data transfer, data storage</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option function board</td>
<td>For option function board mounting, 1ch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multi-color display board</td>
<td>For multi-color display board mounting, 1ch</td>
<td>Cannot be used. (Even installed, 65536 colors will not be displayed.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communication unit/Option unit</td>
<td>For communication unit/option unit mounting, 2ch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Buzzer output</td>
<td>Single tone (tone length adjustable)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Protective structure</td>
<td>Outside the enclosure: IP67</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inside the enclosure: IP2X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>External dimensions</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Excluding USB environmental</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>protective cover)</td>
<td>303(11.93)(W)×214(8.43)(H)×49(1.93)(D)(mm)(inch)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Panel cutting dimensions</td>
<td>289(11.38)(W)×200(7.87)(H)(mm)(inch)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td>2.4 kg (mounting fixtures are not included)</td>
<td>2.3 kg (mounting fixtures are not included)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compatible software package</td>
<td>GT1575-STBA: 2.04E or later</td>
<td>GT1575-VTBA: 2.04E or later</td>
<td>GT1575-VNBA: 2.17T or later</td>
<td>2.17T or later</td>
</tr>
<tr>
<td>(GT Designer2 Version)</td>
<td>GT1575-STBD: 2.17T or later</td>
<td>GT1575-VTBD: 2.17T or later</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 Bright dots (always lit) and dark dots (unit) may appear on a liquid crystal display panel. It is impossible to completely avoid this symptom, as the liquid crystal display comprises of a great number of display elements. Please note that these dots appear due to its characteristic and are not caused by product defect.

*2 Full-color display (65536 colors) is available when the multi-color display board is mounted. (8.4 Multi-Color Display Board)

*3 The GOT screen saving/backlight off function prevents images from becoming permanently etched on the display screen and increases the backlight life.

*4 ROM in which new data can be written without deleting the written data.

*5 Compliant with IP67 when the USB environmental protection cover is attached. Compliant with IP2X at the USB interface only when a USB cable is connected. Note that this does not guarantee all users’ operation environment.
1.5 Applicable connection type between the GOT and the PLC CPU

The GOT can perform monitoring by connecting it to the PLC using the following connection types. Therefore, the connection type suitable for the system configuration or usage can be selected.

1) Bus connection
   Bus connection is a method using an extension connector of a base unit to connect a GOT (connection by I/O bus). This connection type enables the fastest response to a PLC CPU among all GOT connection types. By occupying one stage of the extension base unit, up to maximum 5 GOTs can be connected.

2) Direct CPU connection
   Direct CPU connection is a method using a RS-232/RS-422 to connect a GOT. Because no other equipment is required to connect the GOT to the PLC, this is the most economical connection type.

3) Computer link connection
   Computer link connection is a method using a computer link module or a serial communication module mounted together with a PLC CPU. Connection of multiple GOTs is available depending on the model type of the computer link module or the serial communication module mounted with the PLC CPU.
(4) MELSECNET/10 connection
GOT can be connected to the network as a normal station of the MELSECNET/10 (PLC to PLC network).
The cyclic data of the MELSECNET/10 (PLC to PLC network) and devices of the PLC CPU within the same network can be monitored.

(5) CC-Link connection
GOT can be connected to the network as an intelligent device station of the CC-Link System.
The cyclic data of the CC-Link System and devices of the PLC CPU on the master or local station can be monitored.

(6) Ethernet connection
GOT can be connected to the Ethernet connection (UDP/IP communications).
The networks can be configured with commercially available products such as hubs and cables.
(7) Applicable connections with third party PLCs
GOT can be connected to third party PLCs.
The system construction without regarding to PLC manufacture is available.
Refer to the product catalogue or manual about PLC models that can be connected.

(8) Connection to equipment other than the PLC
- Microcomputer
  Data can be read and written from a personal computer, microcomputer board, PLC to GOT virtual devices.
- Bar-code reader
  The data read with the bar-code reader can be written to PLC CPU.
- Temperature controller, Inverter, Servo amplifier, CNC
  The controllers can be monitored and changed the parameters.

(9) Multi-channel function
The GOT which installs multiple communication drivers can be monitored up to maximum 4 (4 channels) controllers (PLC CPU, temperature controller, inverter, etc.).
1.6 Equipments required for using GOT

The equipment required to connect the GOT to the PLC CPU is shown below.

**Equipment Name** | **Application**
---|---
[1] Personal computer | Writing the screen data to GOT.
[2] GT Designer2 | Software to create screen data
[3] USB/Cable | Cable to connect with the personal computer and GOT *1
[4] Communication Unit | Unit to connect the PLC CPU connection cable *1
[5] Connection Cable | Cable to connect with the GOT and PLC CPU *2

*1 The communication unit varies depending on the PLC connection type. When connecting to the PLC with the RS-232 port built-in on GOT (direct CPU connection, computer link connection, etc.), the communication unit is not required.

*2 The connection cable varies depending on the connection type.

The connection cables used for each connection type are shown below.

<table>
<thead>
<tr>
<th>Connection Type</th>
<th>Connection Cable *1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Connection</td>
<td>Bus Connection Cable</td>
</tr>
<tr>
<td>Direct CPU Connection</td>
<td></td>
</tr>
<tr>
<td>For RS-232 Connection</td>
<td>RS-232 Cable</td>
</tr>
<tr>
<td>For RS-422 Connection</td>
<td>RS-422 Cable</td>
</tr>
<tr>
<td>RS-232/422 Conversion Cable</td>
<td></td>
</tr>
<tr>
<td>Computer Link Connection</td>
<td></td>
</tr>
<tr>
<td>For RS-232 Connection</td>
<td>RS-232 Cable</td>
</tr>
<tr>
<td>For RS-422 Connection</td>
<td>RS-422 Cable</td>
</tr>
<tr>
<td>RS-232/422 Conversion Cable</td>
<td></td>
</tr>
<tr>
<td>CC-Link Connection</td>
<td>CC-Link Dedicated Cable</td>
</tr>
<tr>
<td>MELSECNET/10 Connection</td>
<td></td>
</tr>
<tr>
<td>For Optical Fiber Cable Connection</td>
<td>Optical Fiber Cable</td>
</tr>
<tr>
<td>For Coaxial Cable Connection</td>
<td>Coaxial Cable</td>
</tr>
<tr>
<td>Ethernet Connection</td>
<td>Ethernet Cable</td>
</tr>
</tbody>
</table>

*1 The connection cables are exclusive products.

(Only the Ethernet connection cable is commercially available.)
**Personal computer**

The personal computer is for creating and downloading the GOT1000 screen data.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>PC/AT compatible personal computer on which Windows® will operate</td>
</tr>
<tr>
<td>OS</td>
<td>Microsoft® Windows® 98 operating system English version</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition operating system English version</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Workstation 4.0 operating system English version *2</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional operating system English version *2</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Professional operating system English version *1 *2</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Home Edition operating system English version *1 *2</td>
</tr>
<tr>
<td>Computer</td>
<td>Refer to *3 below.</td>
</tr>
<tr>
<td>CPU Required</td>
<td>For Installation: 300MB or more</td>
</tr>
<tr>
<td>Memory</td>
<td>For execution: 100MB or more</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>CD-ROM Disk Drive</td>
</tr>
<tr>
<td>Drive</td>
<td>For Installation: 300MB or more</td>
</tr>
<tr>
<td></td>
<td>For execution: 100MB or more</td>
</tr>
<tr>
<td>Display Color</td>
<td>High Color (16 bits) or more</td>
</tr>
<tr>
<td>Display</td>
<td>Resolution 800 × 600 dots or more</td>
</tr>
<tr>
<td>Others</td>
<td>Internet Explorer Ver 5.0 or later must be installed.</td>
</tr>
<tr>
<td></td>
<td>Mouse, Keyboard, Printer and CD-ROM Driver should be compatible with the above OS.</td>
</tr>
</tbody>
</table>

*1 "Compatibility mode", "Fast user switching", "Changing desktop themes (font)", and "Remote desktop" are not supported.
*2 The Administrator authority is required to install GT Designer2 into Windows NT® Workstation 4.0, Windows® 2000 Professional, Windows® XP Professional or Windows® XP Home Edition.
The Administrator authority is also required to use GT Designer2 on Windows® XP Professional or Windows® XP Home Edition.
*3 The PC performance requirements are shown below, according to the operating system to be used.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Performance required for personal computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Windows® 98 operating system English version</td>
<td>Pentium® 200MHz or higher 64MB or more</td>
</tr>
<tr>
<td>Microsoft® Windows® Millennium Edition operating system English version</td>
<td>Pentium® 200MHz or higher 64MB or more</td>
</tr>
<tr>
<td>Microsoft® Windows® NT® Workstation 4.0 operating system English version</td>
<td>Pentium® 200MHz or higher 64MB or more</td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional operating system English version</td>
<td>Pentium® 200MHz or higher 64MB or more</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional operating system English version</td>
<td>Pentium II® 300MHz or higher 128MB or more</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Home Edition operating system English version</td>
<td>Pentium II® 300MHz or higher 128MB or more</td>
</tr>
</tbody>
</table>
## GT Works2 and GT Designer2 (CD-ROM)

<table>
<thead>
<tr>
<th>Products included</th>
<th>Product Name</th>
<th>GT Works2 Version</th>
<th>GT Designer2 Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>GT Designer2</td>
<td>Creates screens for the GOT1000 series and GOT900 series.</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>GT SoftGOT2</td>
<td>Enables to operate as the GOT-A900 series on the personal computer. (The License key or License FD is required to use this software.)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>GT Simulator2</td>
<td>Enables the simulation of GOT-A900 series or GOT1000 series operation on a personal computer by connecting with GX simulator or PLC CPU.</td>
<td>○</td>
<td>—</td>
</tr>
<tr>
<td>GT Converter2</td>
<td>Converts the project data for GOT-800 series or Digital Electronics Corporation’s package data into a GT Designer2 format file. GT Converter2 is not required to convert the project data for GOT900 series to those for GOT1000 series.</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>
Chapter 2  GOT Operation

GOT enables reading and writing to PLC CPU device memory (bit, word) with the switches, lamp display, numerical display/input, message display, etc. on the GOT screen.

2.1 Summary of operation

With GT Designer2, display pane figures called objects: —such as the switch figure, lamp figure, and numerical display, etc., —are pasted on the GOT screen. GOT functions can be executed by setting operation functions of the PLC CPU device memory (bit, word) to each pasted object.

This chapter explains the GOT operation in connection with the PLC CPU when the switch (touch switch) or numerical display are set as shown below.

<System example>

[Diagram showing PLC CPU, GOT, and connections]

<Settings of GOT for figures>

- Touch switch setting
  - Bit momentary
  - Write device: M0

- Touch switch setting
  - Bit momentary
  - Write device: M1

- Lamp display setting
  - Bit
  - Read device: Y10

- Numerical display
  - Read device: D10, unsigned BIN
  - Display: Unsigned decimal number
<Action description>

1. While the touch switch "Operation" on the GOT is being touched, the bit device "M0" has been ON.

2. When the bit device "M0" turns ON, the bit device "Y10" turns ON.
   
   Also, the ON figure is displayed on Operation Lamp in which the monitor device has been set to the bit device "Y10".

3. As the bit device "Y10" has been ON, "123" is stored into the word device "D10".
   
   "123" is also displayed in the numerical display on the GOT in which the monitor device has been set to the word device "D10".

4. While the touch switch "Stop" on the GOT is been touched, the PLC CPU bit device "M1" has been ON.
   
   The PLC CPU bit device "Y10" turns OFF, and Operation Lamp turns OFF.
2.2 Entering numerical values into PLC CPU

2.2.1 Numerical input function

The function that writes an arbitrary numerical value into a specified word device.
While not inputting the numerical value, current value of the numerical input has been displayed.
The Key window of the GOT is used to input numerical values.
Input the numerical value by displaying the below key window whose is prepared in GOT. (User-created key window is also available.)

Numerical input key window

For entering decimal numbers

For entering hexadecimal numbers

1): Numbers are displayed as you enter them.
2): Input range for data is displayed.

Point

User-created key window for numerical input is created by registering the window as the key window.
The registered key window is displayed instead of the standard key window.
Refer to GT Designer2 Version2 Screen Design Manual chapter 4 for details of user-created key window.
2.2.2 How to operate numerical input

Touch the numerical input to be input.

Input the numerical value on the key window to be displayed. To store the value, touch RET key.

The input numerical value is reflected (D100: 100 → 200), and the key window is closed.

---

**Point**

The display and operation of the cursor and key window for numerical input can be changed through settings.

1. Display or non-display of the cursor, and key window
   - When establishing conditions or switching screens, the cursor and key window are displayed, and when establishing the operating conditions, the cursor and window key are not displayed.
   - The key window is displayed on touch input and not displayed at pressing RET key.

2. Cursor key operations
   - The input order can be set to the multiple numerical input.

Refer to GT Designer2 Version2 Screen Design Manual chapter 4 for the operation setting methods of cursor and key window for numerical input.
2.3 Switching the screen to be displayed

2.3.1 The screen type

The GOT1000 comprises the following screen types.

(1) Base screen
   The basic screen display on the GOT.

(2) Window screen
   A screen overlapped the base screen.
   The following screen types are available.
   • Overlap window : A window overlapped the base screen is displayed. This type of window can be moved and closed manually. Maximum of two screens can be displayed.
   • Superimposed window : A window superimposed the base screen is displayed. By switching a superimposed window, the corresponding part of the base screen can be changed. Maximum of two screens can be displayed.
   • Key window : A pop-up window on the base screen is displayed when inputting numerical values. Two key types window: default key window and user-created key window are available.
2.3.2 Screen switching device

The screen switching device is set to switch the base screens or to display the window screen on the GOT.

Device types for screen switching are as follows.
- Device for base screen switching
- Device for overlap window1 switching
- Device for overlap window2 switching
- Device for superimposed window1 switching
- Device for superimposed window2 switching

1) Switching base screens
Switch base screens by setting a base screen No. to the device for base screen switching.

Example: When the switching device for base screen is D100.

2) Displaying or non-displaying window screen
Switch window screens by setting a window screen No. to the device for window screen switching. It stores 0 and then erases the window screens.

Example: When the switching device for window screen is D120

Remarks
- Refer to section 4.2.3 for setting methods of screen switching device.
2.3.3 Base screen switching with the sequence program

GOT display screen is switched when the screen switching device value is written with the sequence program.

Example: When the switching device for base screen is D0

The current value of D0 is stored six because the GOT displays screen No. 6.
Turn on X1 with the sequence program, and D0 value is changed to two.

The GOT displays screen No. 2 because D0 value is changed to two.
2.3.4 Base screen switching with the touch switch

GOT display screen is switched when the screen switching device value is written with the touch switch.

Example: In the case of device for base screen switching: D0

The current value of D0 is stored five because the GOT displays screen No. 5.
Set both of X1 and X2 in OFF with sequence program, and touch No. 10 touch switch.

The GOT displays screen No. 10 because the current value of D0 is changed to 10 with the touch switch.
2.3.5 Window screen display and switching

The window screen is displayed by writing the same No. as the window No. of the screen to be displayed into the switching device used in overlap windows 1, 2. Two types of writing in the screen switching device are available: writing with the sequence program, and writing with the GOT touch switch.

**Point**

When "zero" is written in the screen switching device, the window screen is not displayed.

Example: When the switching device for base screen is D0, and that for overlap window 1 is D1.

The current values of the switching device are the below because the GOT displays only base screen No. 15.

- D0 = "15"
- D1 = "0"

Turn ON X3 with the sequence program, and D1 value is changed to three.

The GOT displays window screen No. 3 because D1 value is changed to three.

When closing the window screen, operate either of the following methods.

- Touch in the upper right corner of the window screen.
- Write "zero" as the D1 value in the overlap window1 screen switching device.
Chapter 3 About GT Designer2

3.1 GT Designer2 Features

The GT Designer2 has various functions to improve the drawing efficiency. Main functions of the GT Designer2 are described below:

This section describes the screen configuration and various tools.

(1) The overall project is easy to understand (project workspace)

Settings of the overall project such as created screens or common settings are displayed on the tree.

It is convenient to know the current settings, to check progress of work and to copy the screen.

A screen can be created, copied, and deleted in the workspace.
(2) Easy to manage objects for each application. (Category workspace).
The overall project setting is displayed in a tree by Category (type).
Classification for each application allows simple management of objects.

(3) Easy to select parts frequently used (library workspace)

Objects or figures can be registered and pasted to the screen.
Objects or figures frequently used may be registered as buttons on the toolbar.

Easy parts editing
The registered parts (objects and figures) can be edited by the dedicated editor (library editor).
(4) Shortest setting without opening dialog box (property sheet)
All setting items and setting details being currently selected are displayed in a list. Objects and figures can be set without opening the dialog box and the setting details can be checked.

(5) Classifying objects for each application
Since the touch switches are classified for each application, the target touch switch to be set can be selected easily. The lamp display function and the part display function are also classified by application (for bit device and for word device), which makes the setting items reduced.

(6) Customizing screen
The screen can be customized, such as movement of workspace or property sheet, or display/non-display of toolbar in the preferred environment. The dialog box for object setting may also be customized.
Quick selection of desired screen to be edited

Double click the screen in the project workspace to display the desired screen to be edited.

Quick selection of desired parts to be edited (Data View)

Objects or figures drawn on the screen can be displayed in a data view list. If multiple objects or figures are overlapped, the desired object or figure can be simply selected from the Data View. Currently selected objects or figures can also be checked.

Confirming the settings in real time (View Direct)

The settings made in the property sheet or dialog box are reflected immediately on the corresponding figures or objects on the screen. As settings can be made while checking them on the screen, the screen can be created smoothly as desired.
(10) Wizard application supporting required settings (new project wizard)
When creating a new project, an interactive wizard appears. By following the interactive wizard, the settings required for the GOT1000 can be completed.

(11) Easy confirmation of images with preview.
Display images that are the same as those for GOT (language switching, security level changing, object ON/OFF setting, etc.) can be displayed and confirmed with GT Designer2.
3.2 GT Designer2 Screen Configuration and Basic Operations

3.2.1 Basic operations of dialog box

(1) Tab
Click to switch from one tab to the other.
Checking the Extended Function check box additionally displays the corresponding extended tab.
On the extended tab, more details can be set than on the basic tab.

(2) Radio button
Select an item by clicking the ○.

(3) List box
Click to display the selection list, and select an item.

(4) Extended Function check box
When displaying the extended tabs, click □ to put a check mark ✓.
The settings made on the extended tabs are valid even if this check box is unchecked and the tabs are hidden.

(5) Command button
The command buttons such as OK and Cancel are provided. Click the command button to execute the operation.

(6) Spin box
Enter a value directly, or change the numerical value by clicking ▲ ▼.

(7) Text box
Enter a text from the keyboard.
(8) Check box
When executing the item, click □ to put a check mark ✓.

(9) Go up one level
Displays contents of the directory above the current directory.

(10) Display menu
Select the viewing mode of the folders and files in the current folder.

(11) Creation of new folder
Creates a new folder.

(12) View of table
Select an item by clicking the corresponding leftmost field.
If the Extended Function check box in the object setting dialog is unchecked, the following message is displayed.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Initialize all unchecked function settings and hide the initialized page.</td>
</tr>
<tr>
<td>No</td>
<td>Leave all unchecked function settings as-is and hide the initialized page.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the message with no change. The page cannot be set to hide.</td>
</tr>
</tbody>
</table>

### 3.2.2 Workspace operations

(1) **Workspace**

The workspace displays the whole project settings by data type in the tree structure.

The data of the whole project can be managed/edited easily.

**Example 1) Screen registration**

A screen can be copied using the workspace.

Select the desired screen, right-click the screen, and select the [Copy] menu. (Up to 25 screens can be copied at a time.)

Right-click the mouse again and select the [Paste] menu. After the property setting for the screen is made, the screen is copied.
Example 2) Parts registration
A figure can be registered as a part using the workspace.

Select the figure to be registered, and drag it to the Parts folder in the workspace.

Set the number and name of the part to register the figure as a part.
(2) Workspace types
This section explains the workspace types.

(a) Project workspace
Displays the whole project settings, such as settings for created screens and common settings, in the tree structure.
It is convenient to confirm the currently set project contents, check the operation progress, or copy the screen.

Convenient functions

- Right click the mouse to select basic commands such as New Screen, Open or Copy.

Example: Right click the window screen.
(b) Category workspace
The set objects/figures are stored in one of the categories of switch, lamp, or others.
The user categories can be used for managing the objects and figures by categorizing them according to usages.

(d) Library workspace
Objects or figures can be registered and pasted to the screen. Refer to Section 3.5 for details.
3.2.3 Object placement area and display area on GOT (temporary area)

The drawing screen editor for Base Screen and Window Screen provides two areas: screen display area and temporary area. The temporary area is the area for temporary placement of objects and figures during screen layout change.

(1) Figures or objects placed on the area boundary
When placed on a boundary between the screen display area and temporary area, figures or objects will be handled as described below.

• Figures
  All the figures inside the screen display area will be displayed.

• Paints
  When paint marks ("X" shown below) are placed in the temporary area, the marked figures will not be painted.
• Objects
The object is displayed if its entire object frame is inside the screen display area (1, 2), but not displayed if any part of its object frame is outside the GOT display area (3, 4, 5, 6).

• When using Superimpose Window
If a character (nameplate) or frame figure object placed on the window screen protrudes to the temporary area, the protruding part is left on the base screen after the superimpose window is displayed then hidden.
(Switching the base screen erases the remaining character (nameplate) or frame figure.)

When placing an object, display "object" and "object frame" with GT Designer 2 to check for protrusion in the temporary area. Or use the data check function of GT Designer 2 to check. When performing the above check, select the longest comment among those, which are displayed as a character string (nameplate), as the preview number.
3.3 Menu Configuration

This section describes commands assigned to the menu bar.

**Project**

The Project menu contains functions of file management, preference settings and printing.

New creation of project, reading existing files, preference settings and printing of data being edited are available. The recent file record can also be displayed.

**Edit**

The Edit menu contains edit functions for created figures/objects.

If incorrect operation is done during edit, the screen can be returned to the previous status. Copy, paste and grouping of objects and figures are also allowed.

**View**

The View menu contains display functions on the GT Designer2.

Toolbars, status bar, workspace or property sheet can be displayed or not displayed.
The Screen menu contains functions of screen management and settings in a project.

New screen creation, opening/closing screen and change of window size are available.

The Common menu contains functions of common settings.

The object functions used for the overall project can be set. Comments, parts, etc. can also be registered.

The Figure menu contains functions of drawing figures.

Various figures can be drawn or figures can be filled. Image data can also be imported.
Object

The Object menu contains functions of objects such as lamps or switches which are placed on the screen.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch</td>
<td></td>
</tr>
<tr>
<td>Lamp</td>
<td></td>
</tr>
<tr>
<td>Numeric/Display</td>
<td></td>
</tr>
<tr>
<td>Decimal/Display</td>
<td></td>
</tr>
<tr>
<td>Data List</td>
<td></td>
</tr>
<tr>
<td>Numeric Input</td>
<td></td>
</tr>
<tr>
<td>Socket/Outlet</td>
<td></td>
</tr>
<tr>
<td>Date Display</td>
<td></td>
</tr>
<tr>
<td>File Display</td>
<td></td>
</tr>
<tr>
<td>Comment Display</td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm Display</td>
<td></td>
</tr>
<tr>
<td>Blank Memory</td>
<td></td>
</tr>
<tr>
<td>Alarm List</td>
<td></td>
</tr>
<tr>
<td>Parts Display</td>
<td></td>
</tr>
<tr>
<td>Parts Movement</td>
<td></td>
</tr>
<tr>
<td>Translate/View Screen</td>
<td></td>
</tr>
<tr>
<td>Window Position</td>
<td></td>
</tr>
<tr>
<td>Key Window Settings</td>
<td></td>
</tr>
<tr>
<td>My Parameter</td>
<td></td>
</tr>
</tbody>
</table>

Tools

The Tools menu contains functions of list display of set devices and error check of setting items.
The data view can be displayed or not displayed.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Edit</td>
<td></td>
</tr>
<tr>
<td>Device List</td>
<td></td>
</tr>
<tr>
<td>Data New</td>
<td></td>
</tr>
<tr>
<td>Data Check</td>
<td></td>
</tr>
<tr>
<td>Data Save</td>
<td></td>
</tr>
</tbody>
</table>

Communication

The Communication menu includes the functions that download and upload data, display GOT drive information and make the communication settings.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication</td>
<td></td>
</tr>
<tr>
<td>Drive Information</td>
<td></td>
</tr>
<tr>
<td>Communication Configuration</td>
<td></td>
</tr>
</tbody>
</table>

Window

The Window menu contains functions of placed multiple screens.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td></td>
</tr>
<tr>
<td>Tile Vertical</td>
<td></td>
</tr>
<tr>
<td>Tile Horizontal</td>
<td></td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
</tr>
<tr>
<td>3-D View Mode/Production Control</td>
<td></td>
</tr>
</tbody>
</table>

Help

The Help menu contains functions of viewing the PDF manual related to the GT Designer2 and checking the software version.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Operation Data Transfer Manual</td>
<td></td>
</tr>
<tr>
<td>Screen Design Manual</td>
<td></td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
<tr>
<td>About GT Designer2</td>
<td></td>
</tr>
<tr>
<td>Connect to MELFAWeb</td>
<td></td>
</tr>
</tbody>
</table>
### 3.4 Toolbars

The following types of toolbars are available. The toolbars can be displayed/non-displayed by checking the toolbars on the menu. The following pages also describe details of each toolbar.

<table>
<thead>
<tr>
<th>Toolbar Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the Main toolbar.</td>
<td>Displays the View toolbar.</td>
</tr>
<tr>
<td>Displays the View toolbar.</td>
<td>Displays the Figure toolbar.</td>
</tr>
<tr>
<td>Displays the Figure toolbar.</td>
<td>Displays the Object toolbar.</td>
</tr>
<tr>
<td>Displays the Object toolbar.</td>
<td>Displays the Edit toolbar.</td>
</tr>
<tr>
<td>Displays the Edit toolbar.</td>
<td>Displays the Align toolbar.</td>
</tr>
<tr>
<td>Displays the Align toolbar.</td>
<td>Displays the Draw toolbar.</td>
</tr>
<tr>
<td>Displays the Draw toolbar.</td>
<td>Displays the Communication toolbar.</td>
</tr>
<tr>
<td>Displays the Communication toolbar.</td>
<td>Displays the My Favorites toolbar.</td>
</tr>
<tr>
<td>Displays the My Favorites toolbar.</td>
<td>Displays the Comment toolbar.</td>
</tr>
<tr>
<td>Displays the Comment toolbar.</td>
<td>Displays the Toolbars tab of the Preferences dialog box.</td>
</tr>
</tbody>
</table>

When dragging a displayed toolbar onto the screen, it is displayed as a window.
### (1) Main

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>New project file is created.</td>
</tr>
<tr>
<td>Open</td>
<td>Existing project file is opened.</td>
</tr>
<tr>
<td>Save Project</td>
<td>Existing file is overwritten and saved on the existing file.</td>
</tr>
<tr>
<td>New Base Screen</td>
<td>New screen is created.</td>
</tr>
<tr>
<td>Open Screen</td>
<td>Specified screen is opened.</td>
</tr>
<tr>
<td>Cut</td>
<td>Figures and objects are cut.</td>
</tr>
<tr>
<td>Copy</td>
<td>Figures and objects are copied.</td>
</tr>
<tr>
<td>Paste</td>
<td>Figures and objects are pasted.</td>
</tr>
<tr>
<td>Undo</td>
<td>The last operation is cancelled to recover the status before change.</td>
</tr>
<tr>
<td>Redo</td>
<td>The last operation is repeated.</td>
</tr>
<tr>
<td>Screen Preview</td>
<td>Settings are displayed with the display image on the GOT.</td>
</tr>
<tr>
<td>Previous Screen</td>
<td>Screen with the number before the current screen number is opened.</td>
</tr>
<tr>
<td>Next Screen</td>
<td>Screen with the number next to the current screen number is opened.</td>
</tr>
<tr>
<td>UnOpened Screens</td>
<td>Unopened screen is opened with [Previous/Next Screen] in the ascending/descending order.</td>
</tr>
<tr>
<td>Screen Device List</td>
<td>List of devices used is displayed.</td>
</tr>
<tr>
<td>Data View</td>
<td>All figures and objects arranged on the screen are displayed in a list.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comment to be displayed with the object function is registered.</td>
</tr>
<tr>
<td>Figure and Object</td>
<td>Selection target is switched to [Figure and Object].</td>
</tr>
</tbody>
</table>
## View

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap</td>
<td>Snap movement of the cursor is set.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Screen display magnification rate/shrinking rate is set.</td>
</tr>
<tr>
<td>Grid Spacing</td>
<td>Grid spacing is set.</td>
</tr>
<tr>
<td>Grid Color</td>
<td>Grid color is set.</td>
</tr>
<tr>
<td>ON/OFF</td>
<td>Screen is switched to the display of device between ON and OFF.</td>
</tr>
<tr>
<td>Device, Object ID</td>
<td>Device (Dev) and object ID (ID) are displayed each object.</td>
</tr>
<tr>
<td>Screen Color</td>
<td>Screen background color is set.</td>
</tr>
<tr>
<td>Screen Pattern</td>
<td>Screen background pattern is set.</td>
</tr>
<tr>
<td>Screen Background Color</td>
<td>Screen background color is set.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace is displayed.</td>
</tr>
<tr>
<td>Property sheet</td>
<td>Property sheet is displayed.</td>
</tr>
<tr>
<td>Layer: Front</td>
<td>Only the front layer is displayed.</td>
</tr>
<tr>
<td>Layer: Back</td>
<td>Only the back layer is displayed.</td>
</tr>
<tr>
<td>Layer: Front and Back</td>
<td>The overlaid front and back layers are displayed.</td>
</tr>
</tbody>
</table>
### Table of Drawings and Descriptions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Line is drawn.</td>
</tr>
<tr>
<td>Line FreeForm</td>
<td>Continuous line is drawn.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Rectangle is drawn.</td>
</tr>
<tr>
<td>Rectangle (Filled)</td>
<td>Filled rectangle is drawn.</td>
</tr>
<tr>
<td>Polygon</td>
<td>Polygon is drawn.</td>
</tr>
<tr>
<td>Circle</td>
<td>Circle is drawn.</td>
</tr>
<tr>
<td>Circle (Filled)</td>
<td>Filled circle is drawn.</td>
</tr>
<tr>
<td>Arc</td>
<td>Arc is drawn.</td>
</tr>
<tr>
<td>Sector</td>
<td>Sector is drawn.</td>
</tr>
<tr>
<td>Scale</td>
<td>Scale is drawn.</td>
</tr>
<tr>
<td>Text</td>
<td>Text is input.</td>
</tr>
<tr>
<td>Paint</td>
<td>Polygon or closed area are painted with the selected pattern.</td>
</tr>
<tr>
<td>Import Image</td>
<td>Reads BMP file on the editing screen.</td>
</tr>
<tr>
<td>Import DXF</td>
<td>Reads DXF file on the editing screen.</td>
</tr>
</tbody>
</table>
(4) **Object**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch toolbar</td>
<td>Touch switch function is set.</td>
</tr>
<tr>
<td>Bit Lamp</td>
<td>Bit Lamp function is set.</td>
</tr>
<tr>
<td>Word Lamp</td>
<td>Word lamp function is set.</td>
</tr>
<tr>
<td>Numerical display</td>
<td>Numerical display function is set.</td>
</tr>
<tr>
<td>ASCII display</td>
<td>ASCII display function is set.</td>
</tr>
<tr>
<td>Numerical Input</td>
<td>Numerical input function is set.</td>
</tr>
<tr>
<td>ASCII Input</td>
<td>ASCII input function is set.</td>
</tr>
<tr>
<td>Time Display</td>
<td>Time display function is set.</td>
</tr>
<tr>
<td>Bit comment display</td>
<td>Bit comment function is set.</td>
</tr>
<tr>
<td>Word Comment display</td>
<td>Word comment function is set.</td>
</tr>
<tr>
<td>Advanced User Alarm Display</td>
<td>Advanced user alarm function display is set.</td>
</tr>
<tr>
<td>Advanced System Alarm Display</td>
<td>Advanced system alarm display function is set.</td>
</tr>
<tr>
<td>Alarm History</td>
<td>Alarm history function is set.</td>
</tr>
<tr>
<td>User Alarm</td>
<td>Alarm list function (user alarm) is set.</td>
</tr>
<tr>
<td>System Alarm</td>
<td>Alarm list function (system alarm) is set.</td>
</tr>
<tr>
<td>Bit Parts Display</td>
<td>Bit parts display function is set.</td>
</tr>
<tr>
<td>Word Parts Display</td>
<td>Word parts display function is set.</td>
</tr>
<tr>
<td>Fixed Parts Display</td>
<td>Fixed parts display function is set.</td>
</tr>
<tr>
<td>Panel meter</td>
<td>Panel meter display function is set.</td>
</tr>
<tr>
<td>Level</td>
<td>Level display function is set.</td>
</tr>
<tr>
<td>Trend Graph</td>
<td>Trend graph display function is set.</td>
</tr>
<tr>
<td>Line Graph</td>
<td>Line graph display function is set.</td>
</tr>
<tr>
<td>Bar graph</td>
<td>Bar graph display function is set.</td>
</tr>
</tbody>
</table>
(5) **Edit**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bring to Front of Layer</td>
<td>Places the selected figure or object on the front layer.</td>
</tr>
<tr>
<td>Send to Back of Layer</td>
<td>Places the selected figure or object on the back layer.</td>
</tr>
<tr>
<td>Group</td>
<td>Selected figures and objects are grouped.</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Grouping is canceled.</td>
</tr>
<tr>
<td>Flip Horizontal</td>
<td>Selected figure is flipped horizontally.</td>
</tr>
<tr>
<td>Flip Vertical</td>
<td>Selected figure is flipped vertically.</td>
</tr>
<tr>
<td>Rotate Left</td>
<td>Selected figure is rotated 90 degrees to the left.</td>
</tr>
<tr>
<td>Rotate Right</td>
<td>Selected figure is rotated 90 degrees to the right.</td>
</tr>
<tr>
<td>Edit Vertex</td>
<td>Length of freeform line or polygon line is changed.</td>
</tr>
<tr>
<td>Align</td>
<td>Selected figures and objects are aligned.</td>
</tr>
<tr>
<td>Selection: Figure</td>
<td>Only figures are selected.</td>
</tr>
<tr>
<td>Selection: Object</td>
<td>Only objects are selected.</td>
</tr>
<tr>
<td>Selection: Figure and Object</td>
<td>Figures and objects are selected.</td>
</tr>
</tbody>
</table>

(6) **Align**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Left</td>
<td>Aligned with the selected leftmost figure or object.</td>
</tr>
<tr>
<td>Align Center (Horizontally)</td>
<td>Aligned at the center horizontally.</td>
</tr>
<tr>
<td>Align Right</td>
<td>Aligned with the selected rightmost figure or object.</td>
</tr>
<tr>
<td>Align Top</td>
<td>Aligned with the selected uppermost figure and object.</td>
</tr>
<tr>
<td>Align Center (Vertically)</td>
<td>Aligned at the center vertically.</td>
</tr>
<tr>
<td>Align Bottom</td>
<td>Aligned with the selected lowmost figure and object.</td>
</tr>
<tr>
<td>Align Across (Horizontally)</td>
<td>Selected figures and objects are evenly aligned in the horizontal direction.</td>
</tr>
<tr>
<td>Align Down (Vertically)</td>
<td>Selected figures and objects are evenly aligned in the vertical direction.</td>
</tr>
</tbody>
</table>
(7) Draw

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line style</td>
<td>Line style is set or changed.</td>
</tr>
<tr>
<td>Line Width</td>
<td>Line width is set or changed.</td>
</tr>
<tr>
<td>Line Color</td>
<td>Line color is set or changed.</td>
</tr>
<tr>
<td>Fill Pattern</td>
<td>Fill pattern is set or changed.</td>
</tr>
<tr>
<td>Pattern Fg Color</td>
<td>Fill color is set or changed.</td>
</tr>
<tr>
<td>Pattern Bg Color</td>
<td>Fill background color is set or changed.</td>
</tr>
<tr>
<td>Text Color</td>
<td>Text color is set or changed.</td>
</tr>
<tr>
<td>Text Style</td>
<td>Text style is set or changed.</td>
</tr>
<tr>
<td>Text Solid Color</td>
<td>Text solid color is set or changed.</td>
</tr>
</tbody>
</table>

(8) Communication

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To/From GOT</td>
<td>Data is transferred to GOT.</td>
</tr>
<tr>
<td>To Memory Card</td>
<td>Data is transferred to the memory card.</td>
</tr>
<tr>
<td>Communication Configuration</td>
<td>Communication setting is made.</td>
</tr>
</tbody>
</table>

(9) Comment

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Comment</td>
<td>A new comment line is added.</td>
</tr>
<tr>
<td>New Comment Group</td>
<td>A new comment group is created.</td>
</tr>
<tr>
<td>Comment Group Property</td>
<td>The selected comment group property is selected.</td>
</tr>
<tr>
<td>Insert Row</td>
<td>A row is inserted in the specified position.</td>
</tr>
<tr>
<td>Insert Column</td>
<td>A column is inserted in the specified position.</td>
</tr>
<tr>
<td>Import</td>
<td>The existing CSV, text, or Unicode text file is imported.</td>
</tr>
<tr>
<td>Export</td>
<td>A comment list is exported to a CSV, text, or Unicode text file.</td>
</tr>
<tr>
<td>Attribute</td>
<td>The comment attribute setting dialog is opened.</td>
</tr>
<tr>
<td>Search</td>
<td>The character string search dialog is opened.</td>
</tr>
<tr>
<td>Jump</td>
<td>The jump dialog is opened.</td>
</tr>
<tr>
<td>Attribute Display/Non-Display</td>
<td>The attribute information is displayed/hidden.</td>
</tr>
</tbody>
</table>
3.5 Using Library

3.5.1 What is the library?

Figures and objects created by the user can be registered as a library. Registered figures and objects can be easily pasted on the screen. A preset library provided by GT Designer2 can be also used to facilitate placing lamps or switches on the screen.

(1) Details before using the library

(a) Screen used for library

In library, registration and readout are performed on the screen below:

"Library Workspace"  
Registered objects or figures are displayed in a tree. To display the library workspace, click the library tab of the workspace.

"Library Image List"  
The library can be operated while displaying image of registered objects or figures.

"Library Editor"  
Double click the registered objects or figures to edit them with the dedicated editor.
(b) Library types

1) User-created library
Objects and figures created by the user can be registered.

- My Favorites
  Objects or figures registered as [My favorites] are registered on the [My Favorites] toolbars. When frequently used objects/figures are registered on My Favorites toolbars, it is convenient to use them.

- User-created library
  It is a library to register user created figures/objects. When folders are classified for each type, it is convenient to use them.

2) System library
The library (not changed by a user) provided by the GT Designer2 has been registered in the system library. Lamps or switches are easy to set by retrieving a preset template and placing it on the screen. Libraries/templates in the system library cannot be registered, deleted or changed.
(c) Number of templates that can be registered
Up to 250 libraries can be created. For one library, up to 200 templates can be registered.

(2) Basic operation of library
(a) Basic operation of library workspace
Select the item for operation and right click the mouse to select the setting item.
As shown below, the display varies depending on the selected items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) New Template</td>
<td>New template is added to My Favorites or the user created library.</td>
</tr>
<tr>
<td>2) New User Library</td>
<td>A new library is added to the user created library.</td>
</tr>
<tr>
<td>3) Edit</td>
<td>Registered template is edited/modified with the library editor.</td>
</tr>
<tr>
<td>4) Cut</td>
<td>Registered library/template is cut.</td>
</tr>
<tr>
<td>5) Copy</td>
<td>Registered library/template is copied.</td>
</tr>
<tr>
<td>6) Paste</td>
<td>Cut and registered library/template is pasted to the new library/template.</td>
</tr>
<tr>
<td>7) Delete</td>
<td>Registered library/template is deleted.</td>
</tr>
<tr>
<td>8) Rename</td>
<td>The name of the registered library/template is changed.</td>
</tr>
<tr>
<td>9) Open Image View</td>
<td>Template image is displayed on the [Library Image list] screen.</td>
</tr>
<tr>
<td>10) Property</td>
<td>The &quot;No.&quot; and &quot;Name&quot; of the registered library/template is changed.</td>
</tr>
<tr>
<td>11) New User Library</td>
<td>Folder A new folder for saving library data (My Favorites and user libraries) is created.</td>
</tr>
<tr>
<td>12) Load User Library</td>
<td>Folder Library data (My Favorites and user libraries) is read-out.</td>
</tr>
<tr>
<td>13) Store to User Library</td>
<td>The current edited library data (My Favorites and user libraries) is saved.</td>
</tr>
<tr>
<td>14) Import User Library Folder</td>
<td>The currently unedited library data (My Favorites, user created library) is imported.</td>
</tr>
</tbody>
</table>
(b) Basic operation of Library Image List dialog box

Select the [View] → [Library] → [My Favorites] → [User Library]/[System Library] menu. The Library Image List appears.

The template image displayed in the Library Image List depending on the ON/OFF time display settings of the screen.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>Library type menu</td>
</tr>
<tr>
<td>2)</td>
<td>(Register) Objects or figures selected on the drawing screen are registered on the library.</td>
</tr>
<tr>
<td>3)</td>
<td>(New) Template is newly created.</td>
</tr>
<tr>
<td>4)</td>
<td>(Edit) Registered template is edited with the library editor.</td>
</tr>
<tr>
<td>5)</td>
<td>(Name) Template name is displayed/not displayed.</td>
</tr>
<tr>
<td>6)</td>
<td>(Cut) Selected template is cut.</td>
</tr>
<tr>
<td>7)</td>
<td>(Copy) Selected template is copied.</td>
</tr>
<tr>
<td>8)</td>
<td>(Paste) Template copied with the (Copy) button is pasted.</td>
</tr>
<tr>
<td>9)</td>
<td>(Delete) Selected template is deleted.</td>
</tr>
<tr>
<td>10)</td>
<td>(Property) Property of a template is displayed.</td>
</tr>
</tbody>
</table>
3.5.2 Creating user library

(1) Registering objects or figures on library
Register objects or figures to a My Favorites or user-created library.

1) Select an object/figure for registration.

2) Perform the operations below:
   • Using library workspace
     Drag the object or figure into the workspace.

   • Using library image list
     Click the (Register) button.

3) The Template Property dialog box is displayed.
   Input the template number and name and click the OK button.

4) Registration is completed.
(2) Editing a registered library/template

Different types of editing can be made for the figures and objects registered by user.

1) Select the user-created library/template for editing.
2) Perform the following operations according to the editing details.

<table>
<thead>
<tr>
<th>Function</th>
<th>Library workspace</th>
<th>Library image list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>1) Right click the mouse, and select [Copy] menu.</td>
<td>1) Click (Copy).</td>
</tr>
<tr>
<td></td>
<td>2) Right-click and select the [Paste] menu.</td>
<td>2) Click (Paste).</td>
</tr>
<tr>
<td>Delete</td>
<td>1) Right click the mouse, and select [Delete] menu.</td>
<td>1) Click the (Delete) button.</td>
</tr>
<tr>
<td>Editing registered</td>
<td>1) Right click the mouse, and select [Edit] menu.</td>
<td>1) Click the (Edit) button. (The template can be edited by double clicking.)</td>
</tr>
<tr>
<td>objects and figures</td>
<td>2) The library editor screen appears. Edit the template.</td>
<td>2) The library editor screen appears. Edit the template.</td>
</tr>
<tr>
<td></td>
<td>3) After editing the template, close the screen. (Click the button located in the</td>
<td>3) After editing the template, close the screen. (Click the button located in the top right of the screen.)</td>
</tr>
<tr>
<td></td>
<td>top right of the screen.)</td>
<td></td>
</tr>
<tr>
<td>Renumbering or renaming a</td>
<td>Right click the mouse, and select [Property] menu.</td>
<td>Click the (Property) button.</td>
</tr>
<tr>
<td>template</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
• Configuration of library file
   Each "User Library" including "My Favorites" is stored in the "User Lib" folder under the name "***.lbe."

![Library Configuration Diagram]

Display on Windows
![Library Workspace Diagram]

• Saving a library into files
   The My Favorites or user-created library can be saved into a new file.
   A library can be saved into two or more files in media such as PC hard disk to use them for different purposes.
   A library can be saved in a floppy disk to share it with different PCs.

   ![Library Saving Diagram]

• Templates can be distinguished between the ones with objects and the ones without objects by their icons shown on the library workspace.

   ![Library Templates Diagram]

- : User library file created in the GT Designer2 version 2.07H or lower
- : User library that contains objects
- : User library that does not contain objects
3.5.3 Pasting objects or figures from library

Objects or figures registered in the library are pasted on the screen.

1) Select the desired template and paste it on the drawing screen.
   • Pasting from the library workspace
     ![Diagram showing the process of pasting from the library workspace]
   • Pasting from the library image list
     ![Diagram showing the process of pasting from the library image list]

Remarks
Loading My Favorites library
Objects or figures registered in the My Favorites library can be read out from the My Favorites icon on the toolbar.

![Diagram showing the process of loading My Favorites library]
3.6 How to use the online manual

The online manual is contained in the product CD-ROM in PDF data. To view the PDF data, Adobe® Acrobat® Reader® must have been installed in the personal computer.

3.6.1 Reading the online manual from the product CD-ROM

(1) Operation procedures

1) Click GT Manual 1000 in the GT Manual Menu.

2) As the INDEX MENU screen is displayed, click the manual to be viewed.

3) The selected manual is displayed.
Remarks

The online manual can be viewed from the Start menu or GT Designer2 Help after installation of the GT Manual to the personal computer. Refer to the next page for how to view it from Help.
3.6.2 Reading the online manual from the GT Designer2 Help

With Help, the GT Designer2 PDF manuals can be viewed and the software version can be checked.

(1) Operation procedures
   1) Click on each Help menu.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Index]</td>
<td>Displays the PDF manual list.</td>
</tr>
<tr>
<td>[About GTD2...]</td>
<td>The GT Designer2 version can be confirmed.</td>
</tr>
<tr>
<td>[Connect to MELFANSweb...]</td>
<td>Connects to the Mitsubishi Electric FA Equipment Technology Information Service MELFANSweb.</td>
</tr>
</tbody>
</table>

(2) PDF manual viewing procedure (only when selecting [Index])
   1) After the 1) operation, the following screen is displayed, click the manual to be referenced.

2) The selected manual is displayed.
   (For details on using Adobe® Acrobat® Reader®, refer to Help in Adobe® Acrobat® Reader®.)

Switches the display to the page of the selected item.

Returns to INDEX MENU.
Chapter 4  From GOT Screen Creation up to the Test

4.1 Preparation before using the GOT

The procedures up to monitor the PLC by the GOT is described in this section.

1. Install the GT Designer2 software package (refer to the GT Designer2 Version2 Basic Operation/Data Transfer Manual).

2. Create project data (GT Designer2).
   - Create project (Refer to section 4.2.1). (Setting GOT/PC (PLC) type to use)
   - Set controllers (Refer to section 4.2.2.) (select connection method between GOT and PLC)
   - Screen switching device settings (Refer to section 4.2.3).
   - Create screen data for user (Refer to section 4.2.4)

3. Connect the PC and GOT (Refer to section 4.3.1)
   - USB cable  
   - RS-232 Cable  
   - Ethernet Cable  
   - * USB cables are used during training.

4. Transfer data to GOT
   - Install OS (standard monitor OS), PC communication drivers, etc. (Refer to section 4.3.3)
   - Download project data (Refer to section 4.3.5)

5. Mount communication interface (Refer to section 4.4.1) *1
   - *1 This is not required when an RS-232 is used for connection.

6. Connect GOT and PLC (Refer to section 4.4.2)
   - RS-232 Cable  
   - RS-422 Cable  
   - Bus connection cable  
   - Optical fiber cable (MELSECNET/10)  
   - Coaxial cable (MELSECNET/10)  
   - CC-Link dedicated cable  
   - 10BASE-T/100BASE-TX cable  
   - * Bus connection cables are used during training.

7. Communication check (refer to section 4.5).

8. Monitor start
4.2 Screen creation

4.2.1 Project creation

Projects comprise all the data and settings displayed in one GOT. The screens displayed in the GOT and connection method with the PLC are set in a project wizard. In this section, the settings for the type of GOT used for training and the type of PLC connected to the GOT are described.

1) Click [Start] → [All Programs] → [MELSOFT Application] → [GT Simulator2] menus to run GT Designer2.

2) The screen on the left is displayed when GT Simulator2 is started. Click the New button.

3) The initial screen of the Start New Project Wizard is displayed. (When no new wizard appears, go to section 4.2.2.) Click the Next button.

Various settings that can be made on the project wizard are described on the following pages.
(1) System settings for GOT
The GOT type to be used and the color are set.

1) When the left screen appears, set the GOT type and the color as follows.
   GOT type: GT15**-S (800 × 600)
   Color setting: 256 colors

2) After the selection is made, click the Next button.

3) The left screen is displayed.
   Confirm the settings.
   Click the Next button.

(2) Communication Settings
The connection method for the device to be connected to GOT is set.
(The settings made here can be changed later.)
For details on communication settings, refer to section 4.2.2.

1) When the left screen appears, set the device to be connected as follows.
   Controller: MELSEC-Q (multi)/Q motion
   (The training machine is a multiple CPU system, so select the multiple CPU system.)

2) Click the Next button.

3) When the left screen appears, set the connection I/F as follows.
   I/F: Extended I/F-1 (first stage)

4) Click the Next button.

(Note next page)
5) When the left screen appears, set the communication driver as follows.
Communication driver: Bus connection Q
<Note: Always change default setting from "A/QnA/QCPU, QJ71C24" to Bus connection Q.>
- There are two types of bus connection communication drivers. Select a driver that matches the PLC to be connected.
  Bus connection Q : With connection to the QCPU
  Bus connection A/QnA : With connection to the ACPU, QnACPU

6) Click the Details... button.

7) When the left screen appears, set the Stage No. and Slot No. as follows.
   Stage No.: 1
   Slot No.: 0

8) Click the OK button.

9) Click the Next button.
10) The left screen is displayed.
Confirm the settings.
Click the Next button.

(3) Setting of Screen Switch Device
The device for switching the screens displayed on GOT is set.
(The settings made here can be changed later.)
Refer to section 4.2.3 for details on screen switching device settings.
For details on screen switch device settings, refer to ~.

1) When the left screen appears, the screen switching device is set as follows.
Base screen: D0
Overlap window 1: D1
Overlap window 2: - (no setting)
Superimpose window 1: - (no setting)
Superimpose window 2: - (no setting)
Click the Next button.

2) The left screen is displayed.
Confirm the settings.
Click the Finish button.

(Next page)
(From previous page)

(4) Screen property
The base screen is created.

1) The Screen Property dialog box is displayed.
   Set the base screen1 title.

2) Enter a character string as the screen name.
   Enter "Base Screen" here.

3) Click the OK button.

4) Base screen1 is created.
   The screen is ready for drawing.

Point
Up to 32 characters can be entered as a screen name, regardless of whether
they are one-byte or two-byte characters.

Remarks
(1) The GOT/PC type and screen names can be changed
   GOT/PC type and screen title settings can be changed in the project
   workspace.

   • Changing the GOT/PC type
   • Changing the screen name

   1) Right click
   2) Update the screen title.

   • Change directly.
   • Screen properties
     Changing with dialog box

(2) Refer to chapter 7 of the GT Designer2 Version2 Basic Operation/Data
    Transfer Manual for details on GOT/PC type and screen name settings.
4.2.2 Communication Settings

**Point**
Settings described in this section are not required when settings are made on the new project wizard (Section 4.2.1).

The GOT and PLC CPU communication settings are performed. When the GOT is used first, set the channel No. of the communication interface and the communication driver, and download the settings to the GOT.

This section explains about using a bus connection between the GOT and CPU.

1) Double-click [Common Settings] → [System Environment] menu in the project workspace.

2) When the System Environment screen appears, double-click [Communication Settings].

(Next page)
(3) When the left screen appears, check [Use Communication Settings].
With the Communication Settings, perform the following settings.

1) Standard I/F Settings
Settings are performed for the communication interface on the GOT (Standard I/F-1:R-232, Standard I/F-2:USB).

- **CH No.** Select a CH No. that matches the usage.
  - 0 : not used
  - 1 to 4 : FA device, for microcomputer connection (The communication settings must be made according to the channel No. to be connected)
  - 8 : For bar code reader connection
  - 9 : For host (PC) connection (default)
- **I/F** Communication interface type is (2 types) displayed.
  - RS232 : For communication with PC (GT Designer2), PLC, and microcomputer.
  - USB : For communication with PC (GT Designer2). (default)
- **Driver** Select the PC communication driver to be installed in the GOT.
- **Detail setting** Perform the settings including driver baud rate, data size, etc.

2) Extend I/F Settings (first stage to third stage)
Settings are performed for the communication unit in the GOT extend interface.
- CH No. •• Select a CH No. that matches the usage.
  0 : not used
  1 to 4 : FA device, for microcomputer settings (settings to match the channel No. for connecting the controller)
  * : Gateway function, for Ethernet download
- Driver •• Select the PC communication driver to be installed in the GOT.
- Detail setting •• Perform settings including driver stage No., slot No., etc.

4) Extend I/F Settings.
Set the 1st stage extend I/F1-1 as described below.
(Settings for this item have already been performed in the new project wizard described in section 4.2.1.)
CH No.: 1
Driver: Bus connection Q

5) Click the Detail Setting... button.

6) When the left screen appears, set the stage No. and slot No. as follows.
(Settings for this item have already been performed in the new project wizard described in section 4.2.1.)
Stage No.: 1
Slot No.: 0

7) Click the OK button.
### Point

**Settings including QCPU (Q mode) Stage No. and Slot No.**

With a bus connection, the PLC CPU recognizes the GOT as a 16 I/O point intelligent function module.

A free PLC CPU I/O slot is allocated to the GOT, but when the PLC CPU connected is a QCPU, no free basic base/extended base I/O slot can be allocated.

On communication settings, build one stage (16 points $\times 10$ slot allotment) for GOT connection, so that the GOT can be allocated to an I/O slot.

### Remarks

- Refer to chapter 3 of the GT Designer2 Version2 Screen Design Manual for details on Communication Settings.
- Controller settings can also be performed with the GOT Utility. Refer to the GOT1000 Connection Manual for details on Utility Communication Settings.
4.2.3 Screen switching device settings

This section explains screen switching device settings.
Set the base screen switching device to "D0", and the Overlap window1 screen switching device to "D1".

1) Click on the [Common] – [System Environment] menu.

2) The System Environment dialog box is displayed.

3) Double click [Screen Switching].
4) The screen switches.

5) Click the **Dev...** button and set the base screen screen switching device.

6) The device dialog box is displayed.

7) Click **[ ]** and set to "D".

8) Click **[ ]** and set to "0".

9) After settings are completed, click the **OK** button.

10) Check that "D0" is set in the "switching device".

11) Check "Overlap window 1" and set the Overlap 1 screen switching device.

12) Click the **Dev...** button and set the "screen switching device" to "D1".

13) Click the **OK** button.
Remarks

- Screen switching device settings
  With the screen switching device, refer to the following to set the devices to be used.
  1) GOT internal device (GD)
     It is recommended to use this device only for switching the screen with the touch switch (screen switching switch).
     Screen switching cannot be controlled by the PLC CPU.
     With the screen switching device, the internal device (GD100) is set by default.
  2) PLC CPU device (D,W, etc.)
     It is recommended to use this device to control screen switching from the PLC CPU.
     Screen switching can also be performed by the touch switch (screen switching switch).
4.2.4 Data reading

In this section, training is performed using screen data prepared beforehand. (Specific creation methods for screen data are explained in chapter 5.)

Remarks

The settings for the data to be read, "school.GTE", are the same as the settings described in sections 4.2.1 and 4.2.2.

The screen (project data) is read.

2) When the dialog box appears, click \( \text{Browse} \) and then click "3½ Floppy [A:]".

3) Select the file format of the screen data file to be opened. Select the "GT Designer2 Files (*.GTD, *.GTE)".

4) Select school.GTE

5) Click the Open button. The screen data is read.

6) As the dialog box to confirm whether to save the project data created this time appears, click the No button.

7) The screen is read.
4.2.5 Saving the project data

This section explains operations to save the created project data. This section explains with an example of saving to a floppy disk (A drive).

1) Click on the [Project] – [Save As] menu.

2) When the dialog box appears, click and then click "3½ Floppy [A:]".

3) Enter the file name (project name) of the screen data file to be saved. Enter "BASIC" here.

4) Click the Save button to save the screen data.

Point

When the project data is saved, not only the created screen, but also common settings such as connection settings, parts Information, etc., are saved in one file. If saved files are copied onto another PC, they can be used as they are. However, only the user-made library information is saved in a separate file, so when using the user-made library information, it is necessary to make a separate copy of the library data. For details on saving the library, refer to the GT Designer2 Version2 Basic Operation/Data Transfer Manual.
4.3 Data transfer (PC to GOT)

This section explains procedures for writing data created on GT Designer2 to the GOT.

4.3.1 Connection from PC to GOT

Connect the PC and GOT.

![Connection diagram]

**Remarks**

To connect the personal computer and GOT, RS-232 or Ethernet can be used in addition to the USB cable. Use of the USB cable enables the data to be transferred at higher speed and reduces the operation time as compared with RS-232 communication. *1

*1 Download reference value: (GT15)

<table>
<thead>
<tr>
<th>Connection method</th>
<th>USB (12Mbps)</th>
<th>RS-232 (115Kbps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Data size</td>
<td>1MB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>20 sec</td>
<td>2 min 30 sec</td>
</tr>
</tbody>
</table>

*2 When using the RS-232 cable, use the GT01-C30R2-9S.
### 4.3.2 About data types transferred to the GOT

To operate the GOT, it is necessary to transfer the following types of data to the GOT.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Outline</th>
<th>Data transfer timing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot OS</td>
<td>The program needed to control GOT hardware, and during communication between GOT and PCs. Boot OS is installed in the GOT at factory shipment so installation is not usually necessary.</td>
<td>When returning the settings of the GOT main unit to the factory settings (normally, installation is not required)</td>
</tr>
<tr>
<td>OS</td>
<td>The GOT monitoring function, OS/screen data installation, OS/screen data deletion, touch key control, system screen/guidance display function and other features for controlling the GOT are installed.</td>
<td>When using GOT for the first time. When changing the functions to be used (Extended function, Option OS) and communication format. After an OS upgrade.</td>
</tr>
<tr>
<td>Standard monitor OS (Required)</td>
<td>The programs that operate the GOT, e.g. interface control, OS/screen data installation, OS/project data deletion, touch key control, and screen/guidance display functions.</td>
<td></td>
</tr>
<tr>
<td>Communication driver (Required)</td>
<td>The PC communication driver performs communication between the GOT and the PLC CPU. Always select and install a PC communication driver that is appropriate for the connection type.</td>
<td></td>
</tr>
<tr>
<td>Extended function OS</td>
<td>Needs to be installed when the extended function *1 is used.</td>
<td></td>
</tr>
<tr>
<td>Option OS</td>
<td>Needs to be installed when functions *2 available by connecting an option function board (including a board with extension memory) or a multi-color display board are used.</td>
<td></td>
</tr>
<tr>
<td>Project data (Required)</td>
<td>Data for user-made monitor screens, such as screen data, comments, common settings, etc.</td>
<td>When using GOT for the first time. When changing screens and settings.</td>
</tr>
<tr>
<td>Special data</td>
<td>Data used by the extended function (intelligent module/Q motion/servo amplifier monitor, etc.).</td>
<td>When changing the functions to be used.</td>
</tr>
<tr>
<td>Resource data</td>
<td>All types of data created in the GOT main unit, such as recipe file, alarm log file, etc.</td>
<td>Varies depending on each GOT function.</td>
</tr>
</tbody>
</table>

*1 Extended functions included the following.
- System monitor
- Bar code

*2 Option functions include the following.
- Advanced recipe function
- List editor function
- Gateway function
- Recipe function
- Standard font (Chinese: Simplified, traditional)
- Multi-channel function
- Logging function
- Object script
- Network monitor function
- Intelligent module monitor function
- Maintenance report function
- Kana-kanji conversion function
- Ladder monitor function
- Servo amplifier monitor function
- CNC monitor function
- Q motion monitor function

### Point

With GOT, data exchange between the PC and GOT is expressed in the following terms.
- **Download**: Writing the project data created by PC to the GOT.
- **Upload**: Reading the GOT project data on a PC.
- **Install**: Writing the system data required to run GOT (BootOS, OS) to GOT.
4.3.3 Communication settings

Settings for communication between the PC and the GOT are performed.

1) Click on the [Communication] – [Communication configuration…] menu.

2) When the dialog box appears, set the communication type to "USB". (In training, to connect the PC and GOT with the USB cable)

3) Click the OK button.
4.3.4 OS installation

This section explains operations for installing the communication driver and OS in the GOT as preparation before monitoring. This section explains with an example.

**Point**

The GOT does not include the monitor OS for monitoring or the driver for communication. Therefore, it is necessary to perform this operation only once before the first monitoring. It is not necessary after the first time. However, when the OS is updated or the communication method is changed, this operation is required. (Installation is completed on the training machine, so overwriting is necessary.)

1) Click on the [Communication] – [To/From GOT] menu.

2) When the dialog box appears, click the [OS installation → GOT] tab.

3) Select the standard monitor OS. The standard monitor OS is a program that performs monitor function control.

4) Select the communication driver. The communication driver performs communication between the GOT and the PLC CPU. Select the communication driver corresponding to the connection type.

   Check the "Q BUS" in the "BUS/network Group" of the "communication driver".

5) Click the Install button.
6) When the **Yes** button is clicked, OS installation is executed.

7) After OS installation is completed, click the **Close** button to close the dialog box.

### Point

**1. Installing the OS**

   If the Standard monitor OS is not installed in the GOT (Boot OS is installed at time of shipment), install the Communication drivers, Extended functions OS, and Option OS after installing the Standard monitor OS.

**2. Downloading Project data and Special data**

   When the OS (Standard monitor OS, Communication driver, Extended function OS, Option OS) used by GT Designer2 to which Project data and Special data is downloaded is newer than the OS installed in the GOT, new functions may be unavailable.

   Reinstalling the OS is recommended when downloading Project data and Special data to the GOT main unit.

**3. Installing the OS**

   The version numbers (both the major and minor version) of each OS (Standard monitor OS, Communication driver, Extended function OS, Option OS) must be the same.

   If their version numbers are different, the GOT will not operate.

   **(Example1)**
   - Standard monitor OS: 01.00.00
   - Communication driver: 01.00.00
   - Extended function OS: 01.00.00
   - Option OS: 01.00.00

   **(Example2)**
   - Standard monitor OS: 01.00.00
   - Communication driver: 02.00.00
   - Extended function OS: 01.00.00
   - Option OS: 01.00.00

   - GOT is operated.
   - GOT is not operated.
4.3.5 Screen data download

This section explains operations for downloading the created screen data to the GOT.

1) Click on the \([\text{Communication} – \text{To/From GOT}]\) menu.

2) The dialog box appears and the project configuration is displayed as a tree.
   1) Project Download -> GOT:
      The project configuration is displayed as a tree. Check the item to be downloaded.
   2) Drive name:
      Select the download destination of the project data.
      (A drive: Standard CF Card (only with GOT mounted), C drive: Built-in Flash Memory)
   3) Folder name:
      Displays the storage destination folder of the project data. Set the folder name in "System Settings" of the "System Environment" window.
   4) Boot drive (Project Data):
      Displays the drive in which the project data will be started. (Displays the drive name set as Drive.)
   5) Project ID:
      Project data ID number is displayed.
      With the project ID, downloaded project data is saved so that it is not mixed with any other data.
   6) Transfer size:
      The size of the data to be downloaded on the GOT is displayed.
   7) Buffering area size:
      Displays the total buffering area size capacity to be used by such as advanced alarms.
   8) Drive information:
      Displays the user area size, empty area size, and memory meter of the selected drive.
   9) Boot memory information:
      Displays the user area size and empty area size.
3) Check "Delete all old data in Project folder". When there is already screen data downloaded on the GOT, do not download the screen data described in this section.

4) Select the data to be downloaded on the GOT. Click the **Select All** button to download all the data.

5) Click the **Download** button.

6) When the **Yes** button is clicked, screen data is downloaded.

7) When download is completed and a completion message appears, click the **OK** button. The GOT automatically restarts when download is completed.
4.4 Connection to PLC CPU (bus connection)

4.4.1 Bus connection unit mounting

For bus communication, a bus connection unit must be mounted to the GOT. This section explains the installation procedures for the bus communication unit onto the GOT.

1) Power OFF the GOT.

2) Remove the expansion unit covers (I/F-1 side and I/F-2 side) of the GOT rear face.

3) Install the communication unit in the expansion unit interface of the GOT rear face. (When the expansion unit is installed to GOT, remove the installed extension unit. Do not touch the board of the GOT when installing the communication unit.)

4) After the installation, tighten the mounting screws (4 places) in the specified torque range (0.36 to 0.48N·m).

5) After installing the mounting screw, apply the supplied seal in order to avoid receiving static electricity.
4.4.2 Connecting the cable

This section explains connection procedures for connecting the GOT and PLC CPU with the bus connection cable.

1) Power OFF the PLC CPU and GOT.

2) Connect the bus connection cable to the PLC module.

3) Connect the bus connection cable to the bus connector (IN side) on the bus connection unit mounted on the GOT.
4.5 Checking that GOT is communicating normally with the PLC

4.5.1 Checking the OS

With the GT Designer2, check that the OS is properly installed on the GOT.

1) Click on the [Communication] – [To/From GOT] menu.

2) When the Communicate with GOT dialog box appears, click the [Drive Information] tab.

3) Select C: Built-in Flash Memory

4) Click the Get Latest button.

5) When the confirmation dialog box appears, click the Yes button.

6) The dialog box appears and a list of the items installed on the drive is displayed as a tree.

When the following is confirmed, the OS is properly installed on the GOT.

- Standard monitor OS
- Communication driver: Bus connection Group
4.5.2 Checking that the GOT recognizes the connected equipment

Check, that the GOT recognizes the connected equipment with the GOT utility.
To avoid problems, always perform checks.

1) Power ON the GOT.

2) When the screen downloaded in section 4.3.3 appears, touch the screen as shown on the left.

3) When the utility is displayed, touch "Main Menu" → "Communication Settings".

4) When "Communication Setting" is displayed, check that "ChNo1" in Extend I/F Setting is set to [Q BUS].
When the target communication driver is not set, perform one of the following operations.

1) Change the communication driver settings
   1) Touch the Channel - Driver assign button in the "Communication Settings" screen.
   2) In the "Channel - Driver assign" screen, touch the Change assignment button.
   3) When the communication driver installed in the GOT is displayed, touch the target communication driver and touch the OK button.

   The GOT automatically restarts after this setting is executed.
   If project data has been downloaded, the GOT starts monitoring of the controller after restarting.
   Execute this setting after carefully confirming the safety.

2) Reinstall with the GT Designer2
   With the above operation (1), when the target communication driver is not installed, install it from the GT Designer2.
4.5.3 System alarm

The system alarm is a function used to display error codes and error messages when error occurs in the PLC, GOT, servo amplifier, communication system, etc. Error messages displayed in the system alarm do not need to be registered. (They are registered in GOT.) If the system alarm is set in the screen beforehand, displaying system alarm allows a user to check how the error occurred and its cause.

System Alarm display area

- Under normal conditions

When nothing appears in the System Alarm, communication is normal.

- When an error occurs

When an error message appears in the System Alarm, check whether there is a cable disconnection, check the mounting condition of the communication unit, and check the condition of the PLC.
4.6 Executing the monitor

Operate the screen downloaded to the GOT, and monitor the PLC.

GOT Operation Image

Displays the value of D100.

Adds to the value of D100.

Sets the value of D100 to the number displayed on the switch.

Displays errors and error codes when a malfunction occurs in GOT or CPU.

System Alarm

(1) Monitoring/changing the bit device (X0, X1) values

1) When the Y71 ON switch is touched, the Y71 comes ON.

2) When the Y71 OFF switch is touched, the Y71 goes OFF.

3) Each time the Y70 ON/OFF switch is touched, the Y70 goes ON/OFF.
(2) Monitoring/changing the word device (D100) values

1) Each time the Numeral Increase switch is touched, the D100 value increases.

2) When the Set Numeral switch is touched, the D100 value is set.

(3) Displaying the error message

1) Power OFF the training machine and power OFF the PLC.

2) The error message appears in the system alarm.
Chapter 5 Drawing Fundamentals

Chapter 5 explains how to create actual screens for the GOT. The screen data created in this chapter works with the sequence program described in Section 5.25.

Screens to create

Screens to create in this chapter are as follows:
5.1 Before creating the screen

5.1.1 Operations before creating the screen

Set the project using the New Project Wizard in the following manner:

(1) System Settings for GOT

GOT Type: GT15**-S(800 x 600)
Color Settings: 256 colors

(2) Controller Settings

Communication Settings: MELSEC-Q (multiple) or Q motion
I/F: Extended I/F (first stage)
Communication driver: Bus connection/Q

(3) Switching screen device setting

Enter "Initial Screen".

(4) Screen property

Enter "Initial Screen".

(5) Saving project data

Save the project data.

Select the [Project] - [Save As] menu to save the project named "BASIC1".
5.1.2 Figure drawing

This section describes how to draw figures and how to edit the figures arranged on the screen.

(1) Types of drawable figures

The following figures can be drawn on GT Designer2:

<table>
<thead>
<tr>
<th>Shape</th>
<th>Drawing example</th>
<th>Operation Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Line</td>
<td>(Line)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Line] menu</td>
</tr>
<tr>
<td>Line free form</td>
<td>Line FreeForm</td>
<td>(Line FreeForm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Line FreeForm] menu</td>
</tr>
<tr>
<td>Rectangle</td>
<td></td>
<td>(Rectangle)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Rectangle] menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Rectangle (Filled))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Rectangle (Filled)] menu</td>
</tr>
<tr>
<td>Polygon</td>
<td></td>
<td>(Polygon)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Polygon] menu</td>
</tr>
<tr>
<td>Circle (including ellipse)</td>
<td></td>
<td>(Circle)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Circle] menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Circle (Filled))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Circle (Filled)] menu</td>
</tr>
<tr>
<td>Arc (including elliptic arc)</td>
<td></td>
<td>(Arc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Arc] menu</td>
</tr>
<tr>
<td>Sector</td>
<td></td>
<td>(Sector)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Sector] menu</td>
</tr>
<tr>
<td>Scale</td>
<td></td>
<td>(Scale)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Figure] - [Scale] menu</td>
</tr>
</tbody>
</table>
(2) How to draw a figure
This section describes how to draw a polygon using an example.

1) Click \( \text{ } \) on the toolbar (Figure).

2) Click the left mouse button at the starting point for drawing a polygon.

3) Drag and move the cursor to the second vertex.

4) Release the left mouse button to determine the second vertex.

5) Click the left mouse button at the third vertex. The third vertex is determined.
6) Repeat this procedure to increase the number of vertexes to draw a polygon.

7) Double-click at the last vertex to form a polygon.
(3) Editing the drawn figure
The following editing can be made for the drawn figure.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Figures and objects are deleted.</td>
<td>• [Edit] → [Delete]</td>
</tr>
<tr>
<td>Cut</td>
<td>Figures and objects are cut.</td>
<td>• (Cut)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [Edit] → [Cut]</td>
</tr>
<tr>
<td>Copy</td>
<td>Figures and objects are copied.</td>
<td>• (Copy)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [Edit] → [Copy]</td>
</tr>
<tr>
<td>Paste</td>
<td>The cut/copied figures and objects are pasted.</td>
<td>• (Paste)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [Edit] → [Paste]</td>
</tr>
<tr>
<td>Bring to Front on Front Layer/</td>
<td>The front-to-back sequence of objects is changed</td>
<td>• (Bring to Front on Front Layer)</td>
</tr>
<tr>
<td>Send to Back on Back Layer</td>
<td>within the screen.</td>
<td>[Edit] → [Stacking order] → [Bring to Front on Front Layer]</td>
</tr>
<tr>
<td></td>
<td>Example: The selected objects are changed in</td>
<td>[Edit] → [Stacking order] → [Send to Back on Front Layer]</td>
</tr>
<tr>
<td></td>
<td>front-to-back sequence.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bring to Front of Layer/</td>
<td>The front-to-back sequence of figures/objects is</td>
<td>• (Bring to Front of Layer)</td>
</tr>
<tr>
<td>Send to Back of Layer</td>
<td>changed within the same layer.</td>
<td>[Edit] → [Stacking order] → [Bring to Front of Layer]</td>
</tr>
<tr>
<td></td>
<td>Example: The selected figure is moved to the front.</td>
<td>[Edit] → [Stacking order] → [Send to Back of Layer]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flip Vertical/Flip Horizontal</td>
<td>The selected figure is flipped. (Not available for</td>
<td>• (Flip Vertical)</td>
</tr>
<tr>
<td></td>
<td>objects)</td>
<td>[Edit] → [Rotate/Flip] → [Flip Vertical]</td>
</tr>
<tr>
<td></td>
<td>Example: The selected figure is flipped vertically</td>
<td>• (Flip Horizontal)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Edit] → [Rotate/Flip] → [Flip Horizontal]</td>
</tr>
<tr>
<td>Rotate Left/Rotate Right</td>
<td>The selected figure is rotated 90 degrees. (Not</td>
<td>• (Rotate Left)</td>
</tr>
<tr>
<td></td>
<td>available for objects)</td>
<td>[Edit] → [Rotate/Flip] → [Rotate Left]</td>
</tr>
<tr>
<td></td>
<td>Example: The selected figure is rotated 90 degrees</td>
<td>• (Rotate Right)</td>
</tr>
<tr>
<td></td>
<td>to the left.</td>
<td>[Edit] → [Rotate/Flip] → [Rotate Right]</td>
</tr>
</tbody>
</table>
4) Attribute change

Change the attribute of the created figure on the property sheet.
To change attributes other than foreground, use the following items in the property sheet.

- Line Style
  Select a line style of the figure.
- Line Width
  Select a line width.
- Line Color
  Select a line color.
- Pattern
  Select a filling pattern for the figure.
- Pattern Color
  Select a color for filling the figure.
- Text Color (only when text is selected)
  Select a text color.
- Text Style (only when text is selected)
  Select a text style.
- Text Solid Color (only when text is selected)
  Select a text solid color.

Point

The attributes in the figure setting dialog box can also be changed by double-clicking the figure.
5.2 Text Settings

This section describes how to create actual screens.

The following screen will be created on Base Screen No.1.

5.2.1 Text settings (shadow characters, HQ fonts)

1. Click \( \text{A} \) on the toolbar (Figure) and click anywhere on the drawing screen.

2. The Text dialog box appears. Enter the text on the Text dialog box.

<table>
<thead>
<tr>
<th>Text</th>
<th>Line monitor A</th>
<th>Line monitor B</th>
<th>Line monitor C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Texts can be entered with up to 512 characters regardless of using one-byte or two-byte characters.
- A text can be entered on multiple lines.
- To start a new line (line feed), press the Enter key at the end of the current line.
(3) Set the attributes for the entered characters.

In [Text Style], the text display format can be selected.

Standard: 
Bold: 
Solid: 
Raised: 

In [Font], one of the followings can be selected:

- Standard font
  - 6 x 8 dots (Gothic)
- Bold font
  - 10dot Standard(Gothic)
- 12 dot Standard (Gothic)
  - 12 dot Standard (Mincho/Gothic)
- 16 dot Standard (Mincho/Gothic)

- HQ font
  - 12 dot HQ Mincho
  - 12 dot HQ Gothic
  - 16 dot HQ Mincho
  - 16 dot HQ Gothic

- TrueType font
  - TrueType Mincho
  - TrueType Gothic

- Windows font

(4) In this section, make the settings as follows.

(Input examples) (Display examples) Enter

"Mitsubishi GOT 1000 Initial Screen".

1) Select [Text Style] to "Solid".
2) Select [Alignment] to "Center".
3) Set [Font] to "12dot HQ Mincho".
4) Select "2 x 2" for [Size].
5.3 Numerical Input and Number Keys Window Settings

(1) Base screen settings
The following screen will be created on Base Screen No.5.
D10, D12, D13, and D15 are all device memories of the PLC CPU.
(Refer to the training device list in Section 5.25)

5.3.1 Numerical Input Settings

When Numerical input is performed, following two settings are required.

(1) Numerical input function setting
Set the input area based on the touch area of 16 dots.

(2) Key window setting
Set the type of key window (number keys) for numerical input.
Even if no key window has been set, the system number key window can be used for numerical input.
5.3.2 Numerical input: 4 digits setting

Write device: 16 bits (D10)

(1) Click on the toolbar (Object), and then click any place on the drawing screen.

1) Move the cursor on to the screen, determine the position for display, and then click the mouse button.
2) Click the right mouse button to cancel the placement made (+) of the cursor.

Remarks

(1) Placement of object
The cursor changes to the placement mode (+) when the menu/icon for setting an object is selected.
By clicking the mouse on the drawing screen on object is placed. To place the same type of object in a row, repeat clicking the mouse. The placement mode can be cancelled by using the right click, or key.

(2) Object size change
This section describes how to change the size of arranged object.
1) Select the object to be changed in size.
2) Position the cursor on the sizing handle, click and drag it to change the object size.

(3) Changing the placement method of objects
The placement method of objects can be changed through settings as follows.
Refer to the GT Designer2 Version2 Screen Design Manual for the placement method of objects.
1) Cancelling the selected Tool status
   Select whether to place a single object only or multiple objects continuously.
2) Changing objects after finished creating
   Select whether or not to continue to edit an object after placing it.
(2) Making basic settings

1) Select "16-bit" for [Data Size].

2) Click the [Dev...] button.

3) Set "D10" for [device].

4) After setting is completed, click the [OK] button.
(3) Setting the display format (to handle decimal number in a range of 0 - 9999)

1) Set [Format] to "Signed Decimal".
2) Set [Digits] to "4".

(4) Setting extended function.

1) Check [Extended].
2) [Extended] tab is displayed.

3) Select [Alignment].
   "Right": Right-aligned within the display area.
   "Left": Left-aligned within the display area.
   "Center": Center-aligned within the display area.
   Select "Right" here.

4) Check [Fill with Zeros].
   Checking [Fill with Zeros], "0" is displayed before numeric value. (In the case of 0, "0000" is displayed.)

5) Click the OK button.

(5) Settings on the screen

1) Create a frame for the object with figure drawing.

2) On the figure drawing screen, create characters for title.
   This completes the setting for numerical input.
5.3.3 Numerical input: 5 digits including 1 digit of decimal point

Write device: 16 bits (D15) with frame

(1) Click on the toolbar (Object) to place the numerical input the object screen.

1) Move the cursor to the position where the numerical input is placed, and click the mouse button.

2) Click the right mouse button in the area other than the numerical input to complete positioning.

(2) Set the device.

1) Set [Device] to "D15", and check that the [Data Bit] is set to "16 bits".
(3) Setting display style. (to handle in a range of 0.0 up to 999.9.)

1) Set [Format] to "Real" to input with decimal number.

2) Set [Color] to black.

3) Set [Digits] to "5", which includes the decimal point as well.

4) Set [Decimal Point] to "1".

5) Check the [Adjust Decimal Point Range].
(4) Reading/Writing the data with decimal point

(a) Reading/Writing integer data as a data with decimal point

To read/write decimal number data to a PLC CPU which can only process integer data, the conversion between integer and decimal number is required. By checking "Adjust Decimal Point Range" in view Format, an input number is converted automatically between integer and decimal number (real number) in accordance with the decimal place.

GOT device
$W$: Input Value
$$$: MON Val

"123.9" is input to the GOT.

The value "123.9" read out from the PLC CPU is displayed on the GOT.

(b) Reading/Writing decimal number data

To read/write a real number (floating point data) to a PLC CPU, set basic and option tabs as follows.

1) Data Size: "32 bits"
2) Data format: "Real"
   (As the decimal place setting is no longer needed, "Adjust Decimal Point Range" is grayed out.)
(5) Making the setting of figures

1) Click the **Others...** button in [Frame Format].

2) When a dialog box appears, select "1 Frame_1".

3) Click the **OK** button.
4) Set [Frame] to blue.

5) Set [Plate] to gray.

(6) Check [Extended] to set the extended function.

1) [Extended] tab is displayed. Set [Data Type] to "Signed BIN" to accommodate 16-bit data.

2) Set [Alignment] to "Right".

3) Check "Fill with Zeros".

4) After setting is completed, click the OK button.
5.3.4 Numerical input: 6 digits 2 fraction digit setting

Write device: 32 bits (D13 and D12) with frame

(1) Click on the toolbar (Object) to place it on the object screen.

(2) Set the device as follows.
   (the same procedure as Section 5.3.2)
   
   [Device]: D12
   [Data Bit]: 32 bits

(3) Set the display style as follows.
   (the same procedure as Section 5.3.2)

   [Format]: Real
   [Color]: Black
   [Digits]: 6
   [Decimal Point]: 2
   [Adjust Decimal Point Range]: Checked
(4) Set the figure as follows.
(the same procedure as Section 5.3.2)

[Figure]: 1 Frame_1
[Frame]: blue
[Plate]: gray

(5) Set the option as follows.
(the same procedure as Section 5.3.2)

1) Check [Extended] to display [Extended] tab.

2) Make the settings as follows.
   [Alignment]: "Right"
   [Fill with Zeros (Add 0)]: Checked

3) After setting is completed, click the OK button.
5.3.5 Key Window Display Setting

When a key window (number keys window) is used for numerical input, the operation settings are required. The main settings for key windows are as follows.

- Key window/Show cursor
  Display methods settings for the cursor and key window when the screen is switched.
- Key window type
  (a) Display value during input: the currently input value appears in the key window.
  (b) Display input function range: the data input range appears in the key window.

Key window type

For entering decimal numbers

A key window type applied with setting (a)

For entering decimal numbers

A key window type applied with setting (a) and (b) (default setting)

For entering decimal numbers
(1) Key window operation settings

1) Select the [Common] - [System Environment] menu.

2) As the System Environment dialog box is displayed, double-click [Auxiliary Setting].

3) Check that the display method settings for the key window and the cursor are the same as those shown in the left.
   By default, a key window is automatically displayed when the numerical input function is touched.

4) Double-click [Key Window].

5) Set the key window type.
   Set the key window to the type that displays currently input value.
   Make sure that [Display value during input] is checked.

6) Click the OK button.

Remarks
A user-defined key window can be created by registering a user-created window screen as a key window.
To use the ASCII input function, a key window needs to be created from a user-defined key window.
(For creating a user-defined key window, refer to Appendix 3.)
(2) Key window display position setting
Set the position for displaying the key window.
When no setting is made here, the key window will be displayed in the lower right corner of the screen.
The display position for the key window can be set for each screen.

2) Click the upper left point for displaying the key window.
3) The key window appears at the desired position.
5.3.6 Go To Screen Switch settings

The touch switch used for switching the screen from Screen No. 1 to Screen No. 6

(1) Placing Go To Screen Switch.


2) Move the cursor to the position where the Go To Screen Switch is placed, and click the mouse button.

3) The Go To Screen Switch is positioned.

4) Click the right mouse button in the area other than the Go To Screen Switch to complete positioning.

5) Double-click the Go To Screen Switch which have been placed.
(2) Setting operation of Go To Screen Switch.

1) Check that "Base" is selected in [Screen Type].

2) Pressing the switch in [Go To Screen] determines the screen to display.
   "Fixed": switch to the Base Screen whose screen No. is specified.
   "Previous (hierarchy/history)": switch to previously displayed Base screen.
   Up to 10 screens can be switched according to the history.
   "Device": switch to the Base Screen whose screen No. is specified depending on the ON/OFF condition of the specified bit device.
   (this is useful for returning to the screen previously displayed)
Here select "Fixed", and set "2" to switch to Base Screen No. 2.
(3) Setting display (shape and color) of Go To Screen Switch.

1) Select which shape is displayed when Switch is OFF in [Display Style].
   - displays a basic shape.
   - Others... : displays shapes registered in the library.
   Click then select "Square: Square_5".

2) Select [Frame], [Switch], [Background], and [Pattern] when the Switch is OFF.
   Select [Frame]: white, [Switch]: blue, [Background]: black, and [Pattern]: □.

3) Click the ON button to set the display style when the Switch is ON.

4) Select [Frame], [Switch], [Background], and [Pattern] when the Switch is ON.
   The setting for OFF is same as Default setting.

5) Click the [Text/Lamp] tab to set the text appearing in the switch.
(4) Setting display style (text) of Go To Screen Switch.

1) Select \([\text{Text}], \ [\text{Style}], \ [\text{Style}] \ [\text{Size}]\) when the Switch is ON.
   Select settings as follows
   \[\text{[Font]}: 12\text{dot Standard} \]
   \[\text{[Text]}: \text{white}\]
   \[\text{[Style]}: \text{Regular}\]
   \[\text{[Size]}: 1 \times 1\]

2) Select the position to display the text.
   Select \([\text{Select Position to Edit Text}] \): "Center", \[\text{[Horizontal Alignment]}: \quad \quad \]
   \[\text{[Vertical Alignment]}: \quad \]

   Texts used for switches and lamps can be specified from the following display positions:

   \[
   \begin{array}{c}
   \text{Up} \\
   \text{Center} \\
   \text{Down}
   \end{array}
   \]

3) Enter as follows in the text entry area.
   "Back"
4) Click the **All Settings** button of Copy ON → OFF to display the same text when the Switch is OFF.

5) Click the **OFF** button to check the settings of the text to be displayed when the Switch is OFF.

6) Check the text settings. Check that the settings are the same as the settings when the Switch is ON.

7) Click the **OK** button to complete the settings.
(5) Create a new Go To Screen Switch using the copy/paste function for switch created in steps 1 to 4.
Make the settings as follows.

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Switch name</th>
<th>Monitor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic tab</td>
<td>Switching</td>
<td>Base screen</td>
</tr>
<tr>
<td></td>
<td>Screen Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fixed screen</td>
<td>6</td>
</tr>
<tr>
<td>Text/Lamp Tab</td>
<td>Display Method,</td>
<td>Monitor 1</td>
</tr>
<tr>
<td></td>
<td>Text for ON/OFF</td>
<td></td>
</tr>
</tbody>
</table>

(6) When setting is done, click the OK button.
This completes the settings for the Go To Screen Switch.

Remarks
Refer to the following chapters of the GT Designer2 Version2 Screen Design Manual for details on this setting.
- Numerical input : Chapter 7
- Key window : Chapter 4
5.4 Numerical Display and Level Display Settings

The following screen will be created on Base Screen No. 6. M10, M11, D300, and T10 are all device memories of the PLC CPU.

5.4.1 Go To Screen Switch settings

The touch switch used for switching the screen from Screen No. 1 to Screen No. 5.

(1) Create a new Go To Screen Switch using the copy/paste function for switch created in Section 5.3.6. Make sure that the settings are the same as follows.

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Switch name</th>
<th>Back</th>
<th>Data Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic tab</td>
<td>Screen switching type</td>
<td>Base screen</td>
<td>Base screen</td>
</tr>
<tr>
<td></td>
<td>Fixed screen</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>Text/Lamp Tab</td>
<td>Text for ON/OFF</td>
<td>Back</td>
<td>Data Set</td>
</tr>
</tbody>
</table>

(2) When setting is done, click the **OK** button. This completes the settings for the Go To Screen Switch.
Create a touch switch which turns the bit device ON only while it is being touched. (Write device: (M10) = OFF/ON)
When bit device is ON, touch switch shape turns to the ON shape.

(1) Placing a bit switch on the screen using the menu bar.

2) Move the cursor to the position where the Bit switch is placed, and click the mouse button.
3) Click the right mouse button in the area other than the Bit switch to complete positioning.

(2) Make the operation setting as follows.

1) Operation settings
   [Device]: M10
   [Action]: Momentary
(3) Make the display style setting as follows.

1) Setting for OFF
   - [Shape]: Rectangle (1): rect_7
   - [Frame]: dark white
   - [Switch]: white
   - [Background]: black
   - [Pattern]:

2) Setting for ON
   - [Frame]: dark white
   - [Switch]: red
   - [Background]: black
   - [Pattern]:

1)

2)
(4) Make the text setting as follows.

1) Settings for OFF/ON
   - [Font]: 16dot Standard
   - [Text]: black
   - [Style]: Regular
   - [Size]: 1 x 1
   - [Select Position to Edit Text]: Center
   - [Horizontal Alignment]: (Center)
   - [Vertical Alignment]: (Center)
   - [Text]: “ON”

Settings for OFF/ON are same.
Use the All Settings button of Copy OFF → ON or Copy ON → OFF to apply the same settings to the other.

(5) Make the display switching (lamp) function setting for ON and OFF shapes as follows.

1) Lamp function settings
   - [Lamp]: Bit
   - [Dev...]: M12
   (When M12 is ON, display style is ON.)

2) After the settings are completed, click the OK button.
   This completes the settings for momentary switch.
5.4.3 Illuminated momentary switch OFF setting

Create a new switch using the copy/paste function for switch created in Section 5.4.2, and make the settings as follows.

Copy and paste a switch as follows.

Click the switch to copy → click → click → move the cursor to the desired position and click.

Write device: (M11) = OFF/ON

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Switch name</th>
<th>OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic tab</td>
<td>Operation setting</td>
<td>Device: M11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Action: Momentary</td>
</tr>
<tr>
<td>Display style</td>
<td></td>
<td>ON: Switch: green</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF: Switch: white</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shape: Square: Square_3</td>
</tr>
<tr>
<td>Text/Lamp Tab</td>
<td>Text for ON/OFF</td>
<td>Select Position to Edit Text: Center, &quot;OFF&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text: black</td>
</tr>
<tr>
<td></td>
<td>Lamp function</td>
<td>Bit: M13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Display switching setting displays the ON shape (red) when the bit device &quot;M13=ON&quot; is set.)</td>
</tr>
</tbody>
</table>
5.4.4 Numerical display (D300): 4 digit setting

Displaying the value of D300 (16 bits) in the range of "0" to "9999".

1) Click on the toolbar (Object).

2) Click on the screen to place the numerical display.

3) Double-click Numerical Display, and make the settings as follows: (the same procedure as Section 5.3.2 "Numerical input").

   1) Set [Device] to "D300".

   2) Select "4" for [Digits].

   3) Select [Color] to "black".

   4) Set [Shape] to "Frame: Frame_4".

   5) Set [Frame] to "blue" and [Plate] to "gray".

   6) Click the OK button.
5.4.5 Numerical display (T10): 5 digits 1 fraction digit setting

Display the present value of T10 (16 bits) in the range of "0.0" to "999.9".

(1) Create a new numerical display using the copy/paste function for numerical display created in Section 5.4.4, and make the settings as follows. (the same procedure as Section 5.3.3 "Numerical input")

1) Set "TN10" for [Device] to display the present value of Timer 10 (T10).

2) Select [Format] to "Real".

3) Select "5" for [Digits]. The decimal point is also counted as a digit in the displayed digits. (Example: Set the number of digits to 5 for 999.9.)

4) Select [Decimal Point] to "1".

5) Check [Adjust Decimal Point Range]. When integer data is read out from a PLC CPU, it is automatically adjusted to display decimal number data (real number) as specified in (4) and (5) above in the GOT.

6) Click the OK button.
5.4.6 Numerical display (D15): 5 digits 1 fraction digit setting

Displaying the value of D15 (16 bits) in the range of "0.0" to "999.9".
Create a new numerical display using the copy/paste function for numerical display created in Section 5.4.5 and change the [Device] setting of basic tab to "D15".

5.4.7 Level display settings

Read device: 16 bits (D300)

This function is used to fill the specified range (level) equivalent to the device value, corresponding to the percentage of the difference between the upper/lower limit values. With this function, the device value can be shown as a level in any closed figure.

(1) Draw a tank to be used for level display.
Click on the toolbar (Figure) and draw a polygon.
Set the line color to white from green.
(2) Placing the level display on the screen.

1) Click on the toolbar (Object).

2) Click the upper right corner of the shape drawn in (1) to place the level display. After placing it, click the right mouse button to release the placement mode.

3) Adjust the dotted frame of level display to enclose the entire area of the shape. If the internal position mark (+) is overlapped with the shape and then reversed, the level display has been successfully placed.

4) Adjust the dotted frame of the level display to fit it to the outline of the shape. Place the level display so that the frame of the level display and the length of the shape are the same. If the lengths of the level display frame and the shape do not match, the different level from the actual level will be displayed.

Since the filled area for level display is determined based on the frame size, the shape will be filled up even when the actual value is 80% of the limit.
When the internal position mark (†) is not overlapped with the shape.

When internal position marks are not overlapped with the shape, move the internal position mark according to the following procedure.

The level display is not applicable to the shape that is not overlapped with internal position mark.

1. Right click the dotted frame for the level display, and click on [Enable Two Tracker Mode].

   Internal position mark data is changed from † to ‡.

2. Drag the internal position mark to overlap with the shape.

   Shape is reversed and level display becomes valid.
(3) Double-click the placed level display, and set it as follows.

1) Click the `Dev...` button and set the device to "D300".

2) Set [Boundary Color] to the same color as the line color of the shape used for level display. Set [Boundary Color] to "white" as the line color used for the shape drawn in 1 is "white".

3) Select [Level Color] to "Cyan".

4) Set [Pattern] to "○".

5) Select the Direction.

6) Set the upper and lower limits. Set the upper and lower limits based on the range of the read device, D300 (16 bits).

7) Click the `OK` button.

Remarks
Refer to Chapter 5 of the GT Designer2 Version2 Screen Design Manual for details on this setting.
5.5 Operation Check 1

Display the download screen of the project, and download all the data to the GOT. Reset the PLC CPU using the RESET key switch, and then switch to RUN.

(1) Test 1
Run the following test on Screen No. 1.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Data set switch</td>
</tr>
<tr>
<td>1) Touch operation</td>
<td>Touch</td>
</tr>
<tr>
<td>Screen state</td>
<td>Switch to Screen No. 5</td>
</tr>
<tr>
<td>Write device</td>
<td>5 → D0</td>
</tr>
<tr>
<td>Read device</td>
<td>——</td>
</tr>
</tbody>
</table>

(2) Test 2
Run the following tests in Screen No. 5.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LCD Screen Level Setting (numerical input)</td>
</tr>
<tr>
<td>1) Touch operation</td>
<td>Touch the numerical input area</td>
</tr>
<tr>
<td>Screen state</td>
<td>When a key window screen appears, enter the numeric value (7000), and then press Enter of the key window.</td>
</tr>
<tr>
<td>Write device</td>
<td>7000 → D10</td>
</tr>
<tr>
<td>Read device</td>
<td>D10</td>
</tr>
<tr>
<td>Screen display value</td>
<td>7000</td>
</tr>
</tbody>
</table>
### (3) Test 3
Run the following test on Screen No. 5.

<table>
<thead>
<tr>
<th>Test object</th>
<th>Timer 1 time limit setting (numerical input)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item</strong></td>
<td><strong>Touch operation</strong></td>
</tr>
<tr>
<td><strong>1) Touch operation</strong></td>
<td>Touch the numerical input area</td>
</tr>
<tr>
<td><strong>Screen state</strong></td>
<td>When a key window screen appears, enter the numeric value (100), and then press \textbf{Enter} of the key window.</td>
</tr>
<tr>
<td><strong>Write device</strong></td>
<td>1000 → D15</td>
</tr>
<tr>
<td><strong>Read device</strong></td>
<td>D15</td>
</tr>
<tr>
<td><strong>Screen display value</strong></td>
<td>100.0</td>
</tr>
</tbody>
</table>

### Remarks
Close the key window after entering all of the numerical values.
Move the cursor to another numerical input item using the arrow keys on the key window to keep entering numerical data.
(4) Test 4

Perform the following tests in Screen No. 6.
(Touch "Monitor 1 switch" on Screen No. 5 and switch to Screen No. 6.)
Check if the data set in the data set screen (No. 5) is properly displayed on the
monitor screen (No. 6).

<table>
<thead>
<tr>
<th>Test object</th>
<th>Liquid level display (level display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen display</td>
<td>Check if the liquid level (water level) display changed within the range set in Screen No. 5.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test object</th>
<th>Liquid level display (numerical display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen display value</td>
<td>Check if the numerical value set in Test 2 is displayed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test object</th>
<th>Timer 1 time limit display (numerical display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen display value</td>
<td>Check if the time limit of Timer 1 is set.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Timer 1 ON (momentary)</th>
<th>Timer 1 OFF (momentary)</th>
<th>Current value (numerical display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) First touch operation</td>
<td>Touch (2 seconds)</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Object shape</td>
<td>The Switch turns to red</td>
<td>—</td>
<td>The current value (numerical display) increases</td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td>M10: ON</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>2) Second touch operation</td>
<td>—</td>
<td>Touch</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Object shape</td>
<td>The Switch turns to white</td>
<td>The Switch turns to green</td>
<td>The current value (numerical display) of the timer is reset</td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td>—</td>
<td>M11: ON</td>
<td>—</td>
</tr>
</tbody>
</table>

Remarks

Touch the "Data Set switch" to switch to Screen No. 5 when setting the data again.
5.6 Creating Original Library

Objects or figures that are repeatedly used can be registered to My Favorites or a user created library. Objects and figures registered in a library can be read and used. Register the switch that returns to the main menu to a library.

5.6.1 Object Registration

1) Select the [Back] switch on Screen No. 5.

2) Drag the [Back] switch into the workspace.

3) The Template Property dialog box appears. Input the template number and name "Main Menu" and click the OK button.

4) Registration is completed.
5.6.2 Editing registered objects and figures

Editing registered objects and figures in a library.

1) Select the template for editing.

2) Right click the mouse, and select the [Edit] menu. (The template can be edited by double clicking)

Point

Library Image List
The Library Image List allows reading and registering of a library while viewing the images in the library.
5.6.3 Pasting Objects or Figures from Library

Objects or figures registered in the library are pasted on the screen.

(1) Reading user registered library (user created library)
Paste the "Back" switch registered in Section 5.6.1 to the drawing screen.

(2) Reading the pre-registered library (system library)
Read the pre-registered library in GT Designer2.
The system library contains objects including graphical shapes and preset switches.
5.7 Superimposition of Graph using Layers

Superimposing two graphs using layers

The following screen will be created on Base Screen No.7.

- **Bar graph (back layer)**
  - (M1000): The total is displayed for each line when ON.
  - Call devices: D5 D6 D7

- **Trend graph (front layer)**
  - (M1000): The numerical value fluctuation is displayed for each line when ON.
  - Call devices: D2 D3 D4

- **Alternate toggle switch**
  - Switches (M1000) ON.

- **Screen switching switch**
  - Returns to Base Screen No. 1.

---

*(2) Corresponding Sequence program*

---

5 - 48
5.7.1 Layer

A single screen can consist of two types of sheets (layers). Objects can be superimposed by placing them on two layers (front layer and back layer).

- **Front layer**: A kind of transparent sheet. The back layer can be seen through the transparent area other than the objects set on the sheet. The parts of the objects, which are drawn in the color specified as "transparent" *1, are also displayed as transparent.

- **Back layer**: Placed behind the front layer.

*1 A transparent color is set in the front layer. (A transparent color can be set for each screen in the [Screen Properties] dialog box.) For objects set in the front layer, sections that are the same color as the transparent color turn transparent.

**Point**

1. Objects and figures that can be set on layers
   - Objects: can be set on either front layer or back layer.
   - Figure (including text): is set on back layer automatically.

2. Screens on which superimposition of layers is invalid. The layers cannot be superimposed on Overlap Windows 1 and 2.
5.7.2 Trend graph setting

Place the graph that displays the trend of production volumes for each Line 1, 2, and 3 in the front layer.

(1) Click on the toolbar (Object) to place the trend graph on the object screen.

1) Move the cursor to the position where the trend graph is placed, and click the mouse button.

2) Click the right mouse button in the area other than the trend graph to complete positioning.

(2) Make basic settings.

1) Set [Number of Pens] to "3".

2) Set [Points] to "5".

3) Set [Upper Limit] to "100".

4) Set [Lower Limit] to "0".

5) Set [Layer] to "Front".

6) Click the [Device/Scale] tab.
(3) Setting the device and scale

1) Graph for displaying production volume of Line 1
   [Device]: D2
   [Graph]: white
   [Style]: ——
   [Width]: 3 Dot

2) Graph for displaying production volume of Line 2
   [Device]: D3
   [Graph]: red
   [Style]: ——
   [Width]: 3 Dot

3) Graph for displaying production volume of Line 3
   [Device]: D4
   [Graph]: green
   [Style]: ——
   [Width]: 3 Dot

4) Set [Scale Points] as follows.
   Horizontal (X): 6 Vertical (Y): 3

5) Set [Value Number] as follows.
   Horizontal (X): 6 Vertical (Y): 3

6) Check [Extended].
(4) Making the settings of options

1) Set the upper and lower limits for scale points as follows.
   Upper: Horizontal (X) "5" and Vertical (Y) "100"
   Lower: Horizontal (X) "0" and Vertical (Y) "0"

2) Check [Trigger].

(5) Making the settings of display conditions

1) To detect the values in a one-second cycle, set [Trigger Type] to "Sampling" and "10 (x100 ms)".

2) Click the OK button.

(6) Settings on the screen

1) Enlarge the graph to adjust the size.
5.7.3 Bar graph setting

Place the graph that displays the comparisons of production volumes for each Line 1, 2, and 3 in the back layer.

1) Click on the toolbar (Object) to place the bar graph on the object screen.

2) Make basic settings.
   1) Set [Number of Pens] to "3".
   2) Set [Upper Limit] to "100".
   3) Set [Lower Limit] to "0".
   4) Set [Base Value] to "0".
   5) Set [Layer] to "Back". (Default)
   6) Click the [Device/Scale] tab.
(3) Setting the device and scale

1) Graph for displaying production volume of Line 1
   [Device]: D5
   [Graph]: white
   [Pattern]: none

2) Set the graph to show the total production volume of Line 2 as follows.
   [Device]: D6  [Graph]: red
   [Pattern]: none

3) Set the graph to show the total production volume of Line 3 as follows.
   [Device]: D7  [Graph]: green
   [Pattern]: none

4) Check [Extended].

(4) Make the settings of options.

1) Set the upper and lower limits for scale as follows.
   Upper: Vertical (X): 100
   Lower: Vertical (X): 0

2) Click the OK button.

(5) Settings on the screen

1) Enlarge the bar graph to fit to the size of the trend graph.
2) Select the bar graph and trend graph.


4) Select **Center** for both Vertical and Horizontal and then click the **OK** button.

5) The two graphs are superimposed and displayed on the screen.
5.7.4 Layer display switching

Check the placed objects by switching the layers to be displayed on the screen.

(1) Displaying the front layer

1) Click [Layer: Front].

2) Only the trend graph placed on the front layer will be displayed.

(2) Displaying the back layer

1) Click [Layer: Back].

2) Only the bar graph placed on the back layer will be displayed.

Remarks
Refer to Chapter 2 of the GT Designer2 Version2 Screen Design Manual for details on the layer settings.
5.7.5 Alternate (ALT) toggle switch settings

Create the touch switch that turns ON/OFF the bit device each time it is touched.
(Device: starts operating with (M1000) = ON)

(1) Placing a bit switch on the screen using the menu bar


2) Move the cursor to the position where the bit switch is placed, and click the mouse button.

3) Click the right mouse button in the area other than the bit switch to complete positioning.

(2) Make the settings as follows.
(Click the Others... button to open the dialog box, and select "2 toggle_2" under "4 toggle" in [Library] to select the figure.)

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Set data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>M1000</td>
</tr>
<tr>
<td>Action</td>
<td>Alternate</td>
</tr>
<tr>
<td>Shape</td>
<td>Toggle: toggle_2</td>
</tr>
<tr>
<td>Frame</td>
<td>Dark white</td>
</tr>
<tr>
<td>Switch</td>
<td>Red</td>
</tr>
<tr>
<td>Background</td>
<td>Black</td>
</tr>
<tr>
<td>Pattern OFF</td>
<td></td>
</tr>
<tr>
<td>Pattern ON</td>
<td></td>
</tr>
<tr>
<td>Lamp function</td>
<td>Bit, M1000</td>
</tr>
</tbody>
</table>

(3) When have set all, click the OK button.
This completes the settings for the alternate (ALT) switch.
5.7.6 Go To Screen Switch settings

Read out the switch that switches the screen to screen No. 1 (main menu) and which is registered in the library in Section 5.6, and paste the switch on the screen.

(1) Select "Main Menu" from the user library in the library workspace.

(2) Drag it to Screen No. 7 to paste it.

Remarks

Refer to Chapter 10 of the GT Designer2 Version2 Screen Design Manual for details on graphs.
5.8 Operation Check 2

Display the download screen of the project, and download all the data to the GOT. Reset the PLC CPU using the RESET key switch, and then switch to RUN. Check if the graphs created in the front and back layers in Screen No. 7 are displayed properly.

1) Test 1
Perform the following test in Screen No. 7.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Toggle switch (ALT)</th>
<th>Trend graph</th>
<th>Bar graph</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) First touch operation</td>
<td>Touch</td>
<td>The lever is changed to the upper position.</td>
<td>M1000: changes the graph when turned ON</td>
<td>M1000: increases the graph when turned ON</td>
</tr>
<tr>
<td>Object shape</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td>M1000:ON</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td>D2:D3:D4</td>
<td></td>
<td>D5:D6:D7</td>
</tr>
<tr>
<td>2) Second touch operation</td>
<td>Touch</td>
<td>The lever is changed to the lower position.</td>
<td>M1000: resets the values of the graph when turned OFF.</td>
<td>M1000: resets the values of the graph when turned OFF.</td>
</tr>
<tr>
<td>Object shape</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td>M1000:OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.9 Comment Display Settings

The following screen will be created on Base Screen No.8. X7 and D17 are device memories of the PLC CPU.

5.9.1 Comment display

Comments are character strings registered by users using GT Designer2. Comments can be displayed using functions of multiple objects by registering them as a basic comment or a comment group in advance.

(1) Displaying comments registered in the basic comment by the comment display function

The comments registered in the basic comment are displayed. The comment No. corresponding to the monitored device value is displayed.
(2) Displaying comments registered in comment group by the comment display function.

The comments registered in comment group are displayed.

The comment group to be displayed can be changed according to the device value.

The comment display can also be switched to different languages according to the value of language switching device by registering comments in different languages to different comment groups for each column.

Refer to Section 5.22 for the language switching function.

### Remarks

1. The comment to be displayed by comment display needs to be registered in advance.

2. There are the following two types of comment display.
   - Comment display (bit)
     It is the function to display the comment corresponding to the bit device ON/OFF.

   - Comment display (word)
     It is the function to display the comment corresponding to word device value.
5.9.2 Comment registration

(1) Maximum number of registerable comments
   (a) Basic comment
       Up to 32767 comments can be registered.
   (b) Comment group
       Up to 255 comment groups can be registered, and each group can include
       comments of up to 32767 lines x 10 columns.

(2) Maximum number of characters registerable in a comment
   A comment can be created with 1 to 512 characters regardless whether they are
   one- or two-byte characters.
   One line feed equals to two characters.

(3) Creating comments on multiple lines
   (a) To start a new line, press the [Enter] key at the end of the line.

   (b) Comments are displayed in the GOT as follows when comments are created
       on multiple lines.

(4) Specify the character size for the displayed comments in the dialog box provided
    for each object setting.

(5) The bit comment display function is available to display the comment by direct
    inputting on the object even if no comments have been registered for ON and
    OFF.

(6) When a comment corresponding to the value of a word device is displayed with
    the word comment display function (indirect designation), register the comment to
    the corresponding comment No.
(7) Displaying attributes of comments

Some display attributes set to comments are not available depending on the object function.

For the restriction on the comment display for each object function, refer to the relevant section of each object function.

List of attributes set in comment registration and for each object

<table>
<thead>
<tr>
<th>Item</th>
<th>Text Color</th>
<th>Flip</th>
<th>Blink</th>
<th>HQ Font</th>
<th>Text Style</th>
<th>Solid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment Display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data List Display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm List Display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm History</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch Switch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm Display (List/History)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm Display (Popup)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- ︰ Displayed according to the attributes registered with the comment. They can be changed at each object setting.
- ○︰ Displayed according to the attributes registered with the comment. The attributes registered by the comment are not displayed.
- ●︰ Not displayed according to the attributes registered with the comment. They can not be changed at each object setting.
- —︰ Not used.
5.9.3 Comment display settings by bit device

Display: (X7) = ON "Upper Limit" and (X7) = OFF "Lower Limit"

(1) Click on the toolbar (Object) to place it on the object screen.

(2) Comment display settings

1) Double-click the comment display. The Comment display (bit) dialog box is displayed.

2) Click the Dev... button, and set the device to "X7"
3) Click the [Comment] tab, and set the content to display.

4) Select the comment type. Select "Basic Comment".

5) Select the comment type to be displayed when the device is OFF. Select "Direct Comment".

6) Enter comments to be displayed when the device is OFF. Enter "Lower Limit".

7) Select green for [Text].

8) Click the ON button to set the text to be displayed when the device is ON.

9) Select "Direct Comment".

10) Enter comments to be displayed when the device is ON. Enter "Upper Limit".

11) Select red for [Text].

12) Select the type of blink to make the device to blink.

13) Click the OK button.
(3) Settings on object screen

Adjust the size of object frame so that all the comments are displayed.

1) At the position the cursor changes to a re-sizing cursor, click the left mouse button and drag it to the desired size for displaying.

2) When the display area is determined, release the left mouse button. This completes the settings of the comment display by a bit device.

Point

- The display condition for set comments can be displayed switching between ON and OFF by pressing the "ON/OFF of object function" button on the toolbar (Display setting).

- Adjust the size of display area when the comments vary in length depending on its ON/OFF condition as follows:

  (Example) In case of ON, [Alarm: The water level is at upper limit].
  In case of OFF, [Lower limit].

  Adjust the size of display range to be able to display a longer comment by switching comment displays with the "ON/OFF of object function" button of toolbar (Display setting).
5.9.4 Comment display settings by word device

"Malfunction 1" to "Malfunction 4" is displayed according to the value of the word device (D17) "1" to "4".

(1) Registering the comment to be displayed
To display a comment according to the word device value, the comment needs to be registered in advance.

1) Select the [Common] – [Comment] – [Comment...] menu.
2) As the Open Comment Group dialog box is displayed, select and double-click [Basic Comment].

3) The Basic Comment List dialog box is displayed.
4) Click the comment field for the comment No. to register.
5) Enter the comment to be displayed.
Enter "Error 1".
6) Set red for [Text].
7) Click to create comment 2.
8) Create Comments 2 to 4 following the steps in 4) to 6) as follows.
   Comment 2: "Error 2" "Text: blue"
   Comment 3: "Error 3" "Text: light blue"
   Comment 4: "Error 4" "Text: purple"
Point

(1) How to select more than one comment
If there is more than one comment, all the comments can be selected by the operations below.
- Click the top left cell ([Comment No.] area) by the mouse.
- Click [Select All] in the menu displayed by right-clicking the mouse.

(2) Reusing comments between different projects
Comments can be pasted to the different project comment by right-clicking the mouse.

(3) Batch setting for Text, Rev, Blink, HQ, Style or Solid
By selecting a column, the same setting is applied to the comments simultaneously.

1) Select a column.

![Basic Comment List]

2) Change the setting with the column selected.

![Basic Comment List]

3) All comments are set to the same settings in a batch.

![Basic Comment List]
(2) Comment display settings

1) Click on the toolbar (Object).
After determining the position to display the word comment on the screen, set the comment display area. (the same procedure as Section 5.9.3.)

1) Double-click the placed word comment. The word comment dialog box is displayed.

2) Click the Dev... button, and set the device to "D17".

3) Set the frame to "Frame: Frame_1".

4) Select the preview comment No. that checks the display while the screen data. (This will not affect the display on the GOT.) Set to "1" here.

5) Click the [Comment] tab, and set the method to display the comment.

6) Select the comment type. Select [Basic Comment].

7) Select the method to display the comment. Select [Indirect] to set the word device to display the comment.

8) Select white for [Plate].

9) Click the OK button.
5.9.5 Go To Screen Switch settings

Creating a touch switch to return to the Screen No.1
Select "Main Menu" from the user library, and paste it to Screen No. 8.

This completes the settings for the Go To Screen Switch.

Remarks
Refer to the following chapters of the GT Designer2 Version2 Screen Design Manual for details on this setting.
- Comment: Chapter 4
- Comment display function: Chapter 7
5.10 Window Screen Settings

Creating window Screen No.1 to be displayed on the base screen and setting the display method

Window Screen No. 1 is displayed in the following two windows.
• Overlap window 1: A window overlapping the base screen
• Superimpose window 1: A window superimposed with the base screen

(1) Making the settings of screen switch device

1) Select the [Common] - [System Environment] menu.
2) As the System Environment dialog box is displayed, double-click [Screen Switching].
3) Check [Overlap Window].
4) Click the Dev... button to set the device to "D1".
5) Check [Superimpose Window 1].
6) Click the Dev... button, and set the device to "D26".
7) Click the OK button. This completes the settings of the screen switching device.
(2) Creating window screen

1) Select the [Screen] - [New Screen] - [Window Screen] menu.

2) Enter "Sub screen" for [Screen Name].

3) As a dialog box appears, check that the "Window Screen" is selected on [Screen Type].

4) Click the OK button.

Window screen No. 1 is displayed on the screen.

(4) Creating texts and shapes on the window screen

1) Create texts using the text.

2) Draw a dotted square to show the area to display the window screen.
   (Check this when the superimpose window is displayed.)
(5) Setting the switch to display the Overlap window 1

1) Select [Object] - [Switch] - [Go To Screen Switch] menu. Place the Go To Screen Switch on the screen, and double-click it.

2) Select "Overlap Window 1" for [Screen Type].

3) Select "Fixed 1" for [Go To Screen].

4) Set [Display Style] as follows.
   [Shape] Square: Square_5
   [Switch]
   OFF: red
   ON: green

5) Click the [Text/Lamp] tab.

6) Set white for [Text].

7) Enter "Detail Display" on [Text].

8) Click the All Settings button of [Copy OFF → ON] to display the same text when the Switch is OFF.

9) After settings are completed, click the OK button.
Setting the switch to display the superimpose window 1

1) Copy and paste the switching switch created in (4), and place it on the screen.

2) Select "Superimpose Window 1" for [Screen Type].

3) Select "Fixed 1" for [Go To Screen].

4) Set [Display Style] as follows.
   [Shape] Square: Square_5
   [Switch]
   OFF: yellow
   ON: green

5) Click the [Text/Lamp] tab.

6) Enter "Detail Display" on [Text].

7) Click the All Settings button of [Copy OFF → ON] to display the same text when the Switch is OFF

8) After the settings are completed, click the OK button.
5 - 75

(7) Setting the switch to erase superimpose window 1

1) Select [Object] - [Switch] - [Data Set Switch] menu. Place the touch (Data Set) switch on the screen.

2) Double-click the placed touch switch on the screen.

3) Click the Dev... button, and set the device to "D26".

4) Check [Fixed], and set it to "0". ("0" means hiding the window screen.)

5) Set [Display Style] as follows. [Shape] Square: Square_5
   [Switch] OFF: light blue
   ON: green

6) Click the [Text/Lamp] tab and, set the text to be displayed on the touch switch.

7) Set black for [Text].

8) Set the text on the touch switch as follows. [Select Position to Edit Text]: Center [Text]: Erase

9) Click the All Settings button of [Copy OFF → ON] to display the same text when the Switch is OFF.

10) Click the OK button.

Remarks
Refer to the following manuals for details on this settings.
• Screen switching device: GT Designer2 Version2 Screen Design Manual, Chapter 3
• Opening screens: GT Designer2 Version2 Basic Operation/Data Transfer Manual, Chapter 7
5.11 Operation Check 3

Display the download screen of the project, and download all the data to the GOT. Reset the PLC CPU using the RESET key switch, and then switch to RUN. Check if the comment display on the screen No.8 is properly displayed, and that the Window Screen No.1 on the overlap window / the superimpose window 1 appears correctly here.

(1) Test 1
Run the following test on Screen No. 8.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Comment display by the bit device</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) PLC test switch (X7)</td>
<td>Turns ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Screen state</td>
<td>Displayed &quot;Upper Limit&quot;</td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td>———</td>
</tr>
<tr>
<td></td>
<td>Read device</td>
<td>———</td>
</tr>
<tr>
<td>2) PLC test switch (X7)</td>
<td>Turns OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Screen state</td>
<td>Displayed &quot;Lower Limit&quot;</td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td>———</td>
</tr>
<tr>
<td></td>
<td>Read device</td>
<td>———</td>
</tr>
</tbody>
</table>
(2) Test 2

Run the following test on Screen No. 8.

When X2, X3, X4, or X5 is turned ON, the sequence program displays "Malfunction 1 " to "Malfunction 4 ".

<table>
<thead>
<tr>
<th>Item</th>
<th>Comment display, by the word device</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) PLC test switch (X2, X3, X4, X5)</td>
<td>Turn each switch ON/OFF.</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Screen state</td>
</tr>
<tr>
<td>Write device</td>
<td>When only X2 is turned ON: displays &quot;Malfunction 1&quot;</td>
</tr>
<tr>
<td>Read device</td>
<td>When only X3 is turned ON: displays &quot;Malfunction 2&quot;</td>
</tr>
<tr>
<td></td>
<td>When only X4 is turned ON: displays &quot;Malfunction 3&quot;</td>
</tr>
<tr>
<td></td>
<td>When only X5 is turned ON: displays &quot;Malfunction 4&quot;</td>
</tr>
</tbody>
</table>

```
40 | SM401 | X2  | Error 1  |
   |       | X3  | Error 2  |
   |       | X4  | Error 3  |
   |       | X5  | Error 4  |

    MOV P K1
    D17 Error data

    MOV P K2
    D17 Error data

    MOV P K3
    D17 Error data

    MOV P K4
    D17 Error data
```
(3) Test 3
Run the following test on Screen No. 8.

1) Displaying or erasing the [Window] screen display by the touch switch

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Detail display (Overlap window)</th>
<th>Overlap window</th>
<th>Detail display (Superimpose window)</th>
<th>Erase switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Touch operation</td>
<td>Touch</td>
<td>————</td>
<td>————</td>
<td>————</td>
<td>————</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Screen display</td>
<td>Window screen No.1 displayed</td>
<td>————</td>
<td>————</td>
<td>————</td>
</tr>
<tr>
<td>2) Touch operation</td>
<td>————</td>
<td>Touch</td>
<td>————</td>
<td>————</td>
<td>————</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Screen display</td>
<td>Windows screen No.1 erased</td>
<td>————</td>
<td>————</td>
<td>————</td>
</tr>
<tr>
<td>3) Touch operation</td>
<td>————</td>
<td>————</td>
<td>Touch</td>
<td>————</td>
<td>————</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Screen display</td>
<td>————</td>
<td>————</td>
<td>Window screen No.1 displayed</td>
<td>————</td>
</tr>
<tr>
<td>4) Touch operation</td>
<td>————</td>
<td>————</td>
<td>————</td>
<td>Touch</td>
<td>————</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Screen display</td>
<td>————</td>
<td>————</td>
<td>Windows screen No.1 erased</td>
<td>————</td>
</tr>
</tbody>
</table>

2) Controll the display of window screens by PLC.
   1) Set on "01" of the first two digits of the digital switch "X20 to X2F" of PLC CPU.
2) Turn "X1" of PLC test switch of PLC CPU to ON, and then turn to OFF.

3) Window screen No. 1 is displayed in Overlap Window in Screen No. 8.

4) After touching the X button on the upper right of the Window screen, close the screen.

5) Set on "01" of the last two digits of the digital switch "X30 to X37" of PLC CPU.

6) Turn "X9" of PLC test switch of PLC CPU to ON, and then turn to OFF.

7) Window screen No. 1 is displayed in the Superimpose window on Screen No. 8.

8) After setting "X30 to X37" of the digital switch of PLC CPU to "00" and turning the PLC test switch, and then turn to OFF.

9) The superimpose window is closed.
5.12 Controlling the View and Operation of Objects Based on Conditions

5.12.1 Setting the states for objects

The color and shape of the object can be changed depending on the condition of devices by setting states to an object. Changes in the display of the object can be set by the following conditions.

- Bit device ON/OFF or word device value being monitored
- Bit device ON/OFF or word device value being set for state

Example: Changing the object color according to the word device value being monitored.

- Word device D100 being monitored.

![Diagram showing changes in object color based on device values](image)

Display color changes according to the word device value being monitored.

The following screen will be created on Base Screen No.13.
(1) Making the settings of numerical display using states

1) Click on the toolbar (Object) to place the numerical display on the object screen.

2) Set [Basic] tab as follows.
   [Device]: Select Bit, and set it to D1000.
   [Digits]: 3
   [Size]: Select Others, 4 × 3
   [Frame]: Frame: Frame_1

3) Click the [Case] tab, and set the states.

4) Click [New State] to create a new state setting.

5) Set the condition for the state (M1010:OFF).
   Set the device as follows.
   • Select [Bit].
   • Enter "M1010".
   • Select OFF.

6) Set the color of object to be changed when conditions of the state are met.
   • [Plate]: blue.
7) Click [New State] to add a next state setting.

8) Set the condition for the state \(D1000 \geq 100\). Select Word for [Device].

9) Set the range of word device value to be used as the condition for the state using the following formula.
   - Constant: 100
   - Comparison operator: \(\leq\)
   (Refer to the figure below for details.)

10) Set the display methods of the object when the state conditions are met.
   - Plate: [red]
   - Blink: [Middle]

11) Click to display a list of all the states set. Selecting the desired state from the list allows for modification of the editing state.

After the settings are completed, click the OK button.
(1) **State No. and priority**

Up to 64 (0 to 63) states can be set to one object. When the state conditions overlap, the state of the smaller No. will be displayed with the priority.

**[Display priority]**

<table>
<thead>
<tr>
<th>State No.</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Higher</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Lower</td>
</tr>
</tbody>
</table>

0 (normal case)

The display attribute that must be set to an object. If conditions for other states (1 to 63) have not been satisfied, the attribute of state No. 0 is displayed.

**Example:** When the conditions for displaying states 1 and 2 are met at the same time

- Display by state 1.
- Display attribute
  - State 1
  - State 2
- Display condition
  - 50 \(\geq\) D100
  - 0 \(\leq\) D100

(2) **Method of changing priority**

Click the [Up] and [Down] buttons to change the state No. of state being edited and the priority for states can be changed.

**Example:** Clicking the [Up] and [Down] buttons at the state 2,"B"

- **Upward**
  - State 0
  - State 1
  - State 2
  - State 3
  - Normal Case
  - B
  - A
  - C

- **Downward**
  - State 0
  - State 1
  - State 2
  - State 3
  - Normal Case
  - A
  - C
  - B

- **Raises the priority.**

- **Lowers the priority.**
(2) Making the settings of the touch switch

1) Select the [Object] - [Switch] - [Bit switch] menu.

2) Move the cursor to place the bit switch, and click the mouse button.

3) Set [Basic] tab as follows.
   - [Device]: Enter M1010
   - [Shape]: Square: Square_11
   - [Switch] (OFF): dark red
   - [Switch] (ON): red

   After the settings are completed, click the OK button.

4) Create another switch by copying and pasting the switch created before.

5) Double-click the switch created by copying/pasting, and reset it as follows.
   [Action]: Reset
   [Switch] (OFF): dark aqua
   [Switch] (ON): Cyan

   After the settings are completed, click the OK button.
(3) Making the setting of texts

1) Place the following texts on the screen.
   [Cooling water temperature]
   [°C]
   [Start]
   [Stop]

(4) Making the settings of Go To Screen Switch

1) Drag the main menu registered in Section 5.6.1 from the user library to the position where the Go To Screen Switch is placed.
5.12.2 Setting the display/operation conditions for objects

The display condition, operation condition, and script execution condition can be set for the monitoring and writing operations for each object function. The object is stopped monitoring, operating, or cleared when the display condition is not satisfied.

Example: When the display condition is set in the numerical display function.

The following screen will be created on Base Screen No.14 to set the display and operation conditions.

- **Text setting**
  - **Numerical display (display condition)**
    - Monitor device: D1300
    - Display condition M1301: ON
    - (When the display condition is not satisfied (M1300: OFF), the display is erased.)

- **Touch switch (operating condition)**
  - Write device: M1310: ON
  - Operating condition XA: ON
  - (When the display condition is not satisfied (M1300: OFF), the touch switch does not respond when touched.)

- **Touch switch (operating condition)**
  - Write device: M1310: OFF
  - Operating condition XA: ON
  - (When the display condition is not satisfied (M1300: OFF), the touch switch does not respond when touched.)

- **Ready lamp (operating condition)**
  - Operating condition XA: ON
1) Click on the toolbar (Object) to place the numerical display on the object screen.

2) Set [Basic] tab as follows.
   - [Device]: D1300
   - [Digits]: 6
   - [Frame]: Frame: Frame_1

3) Click the [Trigger] tab, and set the display condition.

4) Set the display condition which is satisfied when M1301 is ON.
   - [Trigger Type]: ON
   - [Trigger Device]: M1301

5) After the settings are completed, click the OK button.
(2) Making the settings of the touch switch

1) Select the [Object] - [Switch] - [Bit switch] menu.

2) Move the cursor to place the bit switch, and click the mouse button.

3) Set [Basic] tab as follows.
   - [Device]: M1301
   - [Shape]: Square: Square_10
   - [Frame]: dark aqua
   - [Switch]: blue

(Next page)
4) Select the [Text/Lamp] tab.

5) Enter "Run" on [Text].

6) Click the **ON** button and make the settings for object state ON.

7) Enter "Running" on [Text].

8) Click the [Trigger] tab, and set the operation condition.

9) Set the operation condition which is satisfied when XA is ON.
   - [Trigger] Type: ON
   - [Trigger Device]: XA

10) After the settings are completed, click the **OK** button.

11) Create another switch by copying and pasting the switch created before.

12) Double-click the switch created by copying/pasting and reset it as follows.
   - [Basic] tab
     - [Action]: Reset
     - [Switch]: yellow
   - [Text/Lamp] tab
     - [Text]: Stop

(3) Making the setting of texts

1) Place the following texts on the screen.
   - [Production Volume]
   - [Line 1]
   - [Ready]
(4) Making the settings of ready lamp

1) Click the [Library] tab in the workspace.

2) From the tree structure, click + of [Crystal] to open the folder, and double-click the [4 Crystal lamp (4)].

3) As the Library Image List dialog box appears, click "12 CNF006_G". (Clicking the button displays the image name.)

4) Click the position to place the lamp.

5) Double-click the lamp and set the [Basic] tab as follows.
   [Device]: XA

(5) Making the settings of Go To Screen Switch

1) Drag the main menu registered in Section 5.6.1 from the user library to the position where the Go To Screen Switch is placed.
Point

(1) Objects with frames
When a frame has been specified for the object for which the display condition is set, the object is not displayed but the frame has been displayed when the display condition is not satisfied.

(2) Display when the display/operation conditions are not met
The display when the display/operation conditions are not met can be changed depending on each object by the following settings.

- Display only when the screen is switched (initial display)
  Only the first time the screen is switched, the device can be monitored and displayed even if the display condition is not met.
  [Rise] or [Fall] can be selected in [Trigger Type].

- Holding the display
  The display of object has been hold even if the display condition is turned to be not met.
  [ON] or [OFF] can be selected in [Trigger Type].
5.13 Operation Check 4

Download all the data to the GOT from the download screen of monitor data. Reset the PLC CPU using the RESET key switch, and then switch to RUN.

(1) Test 1
Run the following tests in screen No.13.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Start switch</th>
<th>Stop switch</th>
<th>Cooling water temperature (numerical display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch operation (Start)</td>
<td>Touch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td>The Switch is pressed.</td>
<td></td>
<td></td>
<td>Counts up.</td>
</tr>
<tr>
<td>Write device</td>
<td>M1010 : ON</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td>D1000</td>
</tr>
<tr>
<td>Screen display</td>
<td></td>
<td></td>
<td></td>
<td>The plate starts blinking red when the numeric value reaches 100.</td>
</tr>
<tr>
<td>Touch operation (Stop)</td>
<td></td>
<td>Touch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td></td>
<td>The Switch is pressed.</td>
<td></td>
<td>The operation is stopped (the plate color turns blue) and the numerical value is lowered.</td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td>M1010 : OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td>D1000</td>
</tr>
</tbody>
</table>
Perform the following tests in screen No. 14.

<table>
<thead>
<tr>
<th>Item</th>
<th>Tested object</th>
<th>Training machine</th>
<th>Ready lamp</th>
<th>Operation switch</th>
<th>Stop switch</th>
<th>Production volume (numerical display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch operation (Run 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>No response because the ready signal is OFF.</td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLC test switch (XA)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch operation (Run 2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The Switch is pressed. The production volume is displayed.</td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch operation (Stop)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The Switch is pressed. The display is not displayed.</td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.14 Offset Function

The device No. to be monitored/written using the object function can be changed by batch processing using the offset function.

- Example of offset function
  Change the device No. set as the monitor device for an object by adding offset device value that is set using the offset function.

<table>
<thead>
<tr>
<th>Device set in each object function</th>
<th>Offset device value</th>
<th>Device to be monitored</th>
</tr>
</thead>
<tbody>
<tr>
<td>D100</td>
<td>0</td>
<td>D100</td>
</tr>
<tr>
<td>D100</td>
<td>1</td>
<td>D101</td>
</tr>
<tr>
<td>D100</td>
<td>2</td>
<td>D102</td>
</tr>
<tr>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td>D100</td>
<td>10</td>
<td>D110</td>
</tr>
</tbody>
</table>

The following screen will be created.

- Bar graph
  - The total is displayed for each line.
  - Monitor device:
    - Line 1: D1511
    - Line 2: D1512
    - Line 3: D1513

- Numeric value input (line)
  - Changes the monitor device for numerical display.
  - Write device: D1500 (offset device)

- Numerical display (production volume)
  - The monitor device varies depending on the numeric value input (line).
  - Monitor device: D1510
  - Offset device: D1500

- Text setting
(1) Making the settings of the numerical display using the offset function

1) Click on the toolbar (Object), and place the numerical display on the screen.

2) Set [Basic] tab as follows.
   - [Device]: Enter "D1510"
   - [Digits]: 4
   - [Font]: 16dot Standard
   - [Size]: 2 × 2
   - [Frame]: Frame: Frame_1

3) [Extended] tab settings
   Set the offset device.
   - [Offset]: D1500

4) After the settings are completed, click the OK button.
(2) Making the settings of the numerical input

1) Click on the toolbar (Object), and place the numerical input on the screen.

2) Set [Basic] tab as follows.
   - [Device]: Enter "D1500"
   - [Digits]: 4
   - [Font]: 16dot Standard
   - [Size]: 2 x 2
   - [Frame]: Frame: Frame_1

3) After the settings are completed, click the OK button.

(3) Making the settings of the bar graph.

1) Click on the toolbar (Object), and place the bar graph on the screen.

2) Set [Basic] tab as follows.
   - [Number of Pens]: 3
   - [Direction]: Vertical
   - [Upper Limit]: 1000
   - [Lower Limit]: 0
3) Set [Device/Scale] tab as follows.
  [Device]: D1511
  [Graph]: white
  [Pattern]: fill solid (lower-left)
  [BG]: red, yellow, or blue
  [Scale Points]: 2 (Y)
  [Value Number]: 3 (Y)

4) Set [Extended] tab as follows.
  [Upper]: 1000 (Y)
  [Lower]: 0 (Y)
  Graph width: 60
  Distance frame Graph Frame (off set): 50
  Width + Space: 120

5) After the settings are completed, click the OK button.

(3) Making the setting of texts

1) Place the following texts on the screen.
  [Line 1, Line 2, Line 3]
  [Line ]
  [Production volume]
  [Offset function]
(4) Making the settings of Go To Screen Switch

1) Drag the main menu registered in Section 5.6.1 from the user library to the position where the Go To Screen Switch is placed.
Download all the data to the GOT from the download screen of monitor data. Reset the PLC CPU using the RESET key switch, and then switch to RUN.

(2) Test 1

Run the following test on Screen No. 15.

<table>
<thead>
<tr>
<th>Tested object</th>
<th>Line (numerical input)</th>
<th>Production volume (numerical display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch operation 1)</td>
<td>Touch the numerical input area.</td>
<td>———</td>
</tr>
<tr>
<td>Screen state</td>
<td>When a key window screen appears, enter the numeric value ”1”, and then press [Enter] of the key window.</td>
<td>The value for the selected line is displayed.</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Write device</td>
<td>1 → D1500</td>
</tr>
<tr>
<td></td>
<td>Read device</td>
<td>———</td>
</tr>
<tr>
<td></td>
<td>Screen display value</td>
<td>1</td>
</tr>
<tr>
<td>Touch operation 2)</td>
<td>Touch the numerical input area.</td>
<td>———</td>
</tr>
<tr>
<td>Screen state</td>
<td>When a key window screen appears, enter the numeric value ”2”, and then press [Enter] of the key window.</td>
<td>The value for the selected line is displayed.</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Write device</td>
<td>2 → D1500</td>
</tr>
<tr>
<td></td>
<td>Read device</td>
<td>———</td>
</tr>
<tr>
<td></td>
<td>Screen display value</td>
<td>2</td>
</tr>
<tr>
<td>Touch operation 3)</td>
<td>Touch the numerical input area.</td>
<td>———</td>
</tr>
<tr>
<td>Screen state</td>
<td>When a key window screen appears, enter the numeric value ”3”, and then press [Enter] of the key window.</td>
<td>The value for the selected line is displayed.</td>
</tr>
<tr>
<td>Result of operation</td>
<td>Write device</td>
<td>3 → D1500</td>
</tr>
<tr>
<td></td>
<td>Read device</td>
<td>———</td>
</tr>
<tr>
<td></td>
<td>Screen display value</td>
<td>3</td>
</tr>
</tbody>
</table>
5.16 Parts Movement Function

It is possible to call the figure as an object if user-created figures are registered as parts.

5.16.1 Parts

(1) Parts
The objects that can be registered as parts are figures, texts, or BMP/JPEG files imported into GT Designer2.
Example) Shapes that can be registered as parts.

![Figures](image1.png) ![Text](image2.png) ![BMP/JPEG file](image3.png)

(2) Objects that can display parts
Registered parts can be displayed on the following objects.

1) Parts Display
The registered parts can be displayed based on the device value.

![Diagrams showing display of parts](image4.png)

2) Parts Movement
The display position of the registered parts can be changed based on the device value.

![Diagrams showing movement of parts](image5.png)
The following screen will be created on Base Screen No.16 to set the parts movement function.

- **Parts Movement**
  - Device for component switching: M1200
  - Position device: D1200

- **Touch switch (start)**
  - Starts parts movement.
  - Write device: M1210 : ON

- **Touch switch (stop)**
  - Stops parts movement.
  - Write device: M1210 : OFF

- **Numerical display (number of units)**
  - Counts the number of times the cart has moved to the right.
  - Monitor device: D1210
5.16.2 Parts registration

Registering the parts displayed by the parts movement.

(1) Loading BMP files
Load BMP file into GT Designer2 to register it as a part.

1) Select [Figure] → [Import Image...] menu.

2) As the Open a File screen is displayed, select "Cart.bmp" and click the Open button.

3) Clicking it on the screen displays the image of a cart.
(2) Registering parts

The BMP/JPEG file part is displayed.

1) Select the figure to be registered.

When the setting for displaying the BMP/JPEG file parts in the memory card has been made.

2) Drag the figure to be registered to the [Parts] in project workspace.

3) Parts Property dialog box is displayed. Input "1" as the No. of the part to be registered and "Cart" as the name of the part to be registered, and click OK button.

4) Registration is completed.
5.16.3 Parts movement display settings

(1) Making the settings of parts movement display


2) Set the parts to be displayed.
   - Parts switching device: The device is used to set which parts to be displayed. The parts to be displayed can be changed by changing the device value.
   - ON/OFF attribute: Select the parts to be displayed when the parts switching device is ON/OFF.
     Make the settings as follows.
     [Parts switching device]: M1200
     [ON/OFF attribute]:
     ON: Parts No.: select "1".
     OFF: Parts No.: select "1".
     (Note: No parts are displayed when "0" is selected.)

3) Set the movement type of the parts.
   - Device: The device is used to control the display position of parts. The parts can be moved and displayed by changing the device value.
   - Move Way: Select the method for moving the parts from "Position", "Line", and "Point".
     Make the settings as follows.
     [Device]: "D1200"
     [Move way]: "Line", "Maximum:5"

4) Click the OK button.

5) Set the line that is different from movement range of parts.
   (Available only when [Line] is selected as [Move Way].)

6) Click on the start position in drawing screen.

7) Move the cursor to the end position, and click.
The move way of parts can be selected from the following three types.

1) Coordinate
Parts are displayed at the coordinate (by dot unit).
The display position can be changed by dot unit by changing the value of the position device.

\[ \begin{align*}
1) & (30, 90) \\
2) & (200, 16) \\
3) & (130, 170)
\end{align*} \]

Position device (X coordinate): D100
Position device (Y coordinate): D101

2) Line
Parts are moved along lines between starting point and destination point that have been set.
Set the start point as minimum value, and the maximum value for the destination point, in order to display the parts using this method.

3) Point
Parts are displayed at preset display position (point).
Point setting is made by registering a line connecting multiple points (parts move route).
Parts are displayed at the place indicated by the point No. that is the same as the value of position device.

* When "Point" is specified for [Move way], set the Parts Move Route for positions where parts are to be displayed.
(Set the [Object] → [Parts Movement] → [Parts Movement Route] on the menu.)
(2) Making the settings of the touch switch

1) Select the [Object] - [Switch] - [Bit switch] menu.

2) Move the cursor to place the bit switch, and click the mouse button.

3) Set [Basic] tab as follows.
   - [Device]: M1210
   - [Shape]: Square: Square_1
   - [Switch] (OFF): blue
   - [Switch] (ON): cyan

4) Click the [Text/Lamp] tab.

5) Set the [Text/Lamp] tab as follows.
   Enter "start" on [Text]. (the same for OFF/ON)

   After the settings are completed, click the OK button.

6) Create another touch switch by copying and pasting the created touch switch and reset it as follows.
   - [Basic] tab
     - [Action]: Reset
     - [Switch] (OFF): red
     - [Switch] (ON): purple
   - [Text/Lamp] tab
     - [Text]: Stop
(3) Setting the counter (numerical display)

1) Click \( \text{F3} \) on the toolbar (Object) and place the numerical display on the screen.

2) Set [Basic] tab as follows.
   - [Device]: D1210
   - [Digits]: 6
   - [Size]: 2 x 2
   - [Shape]: Frame: Frame_1

After the settings are completed, click the OK button.

(4) Making the settings of text and image.

1) Place the following text on the screen.
   "Number units"

2) Load "Conveyor.bmp" into GT Designer2 using the same procedures as in section 5.16.2 (1), and place the conveyor image.
5.17 Operation Check 6

Download all the data to the GOT from the download screen of monitor data. Reset the PLC CPU using the RESET key switch, and then switch to RUN.

(1) Test 1
Run the following test on Screen No. 16.

<table>
<thead>
<tr>
<th>Item</th>
<th>Tested object</th>
<th>Start switch</th>
<th>Stop switch</th>
<th>Cart (part movement)</th>
<th>Number of units (numerical display)</th>
</tr>
</thead>
<tbody>
<tr>
<td>First touch operation</td>
<td>Touch</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td>The switch is pressed.</td>
<td></td>
<td></td>
<td>Moves from left to right.</td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td>M1210 : ON</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td>D1200</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>M1210 : ON</td>
<td></td>
</tr>
<tr>
<td>Screen display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>When the cart reaches the right end, the next cart will appear.</td>
<td>Counter is counted up.</td>
</tr>
<tr>
<td>Second touch operation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
<td>M1210 : OFF</td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td></td>
<td>M1210 : ON</td>
<td></td>
</tr>
</tbody>
</table>
5.18 Recipe Settings

5.18.1 Recipes

The recipe function writes and reads the values of devices specified by the device ON/OFF.

(1) Recipes

(a) When not using recipe file

Save the value set by GT Designer2 in the internal memory (user area) of the GOT in advance. The value is written to the PLC CPU by turning the device ON/OFF.

This setting is used for the following cases.

• Only when writing the device value to the PLC CPU
• When there is no need to display or edit the value to be written on the PC

(b) When using the recipe file

Use the recipe file when reading/writing the device values.

The device values using the recipe file are read/written to control the project or production on a personal computer.

The device values read from the PLC CPU are stored in a recipe file. The data of recipe file can be written to the device.
(2) Recipe types

There are two types of recipes: recipe function and advanced recipe function. The advanced recipe function, an extended function of the recipe function, is used only on the GT15.

Example: The differences between advanced recipe function and recipe function settings

A recipe setting sets for the destination to which the data is written (target device name), written value, and writing timing for the PLC CPU. The advanced recipe function and recipe function are different in the ways of making the settings.

Recipe function setting

Depending on the combination of devices for recipes, multiple recipe function registration is necessary.

Advanced recipe function setting

Any combinations of devices can be set by one recipe setting.

Advanced recipe setting 1: Line A Initial value

<table>
<thead>
<tr>
<th>Device</th>
<th>Record 1</th>
<th>Record 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>D10</td>
<td>10</td>
<td>500</td>
</tr>
<tr>
<td>D11</td>
<td>20</td>
<td>600</td>
</tr>
<tr>
<td>R10</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>D1000</td>
<td>888</td>
<td></td>
</tr>
<tr>
<td>D1001</td>
<td>999</td>
<td></td>
</tr>
</tbody>
</table>
The differences between the recipe function and the advanced recipe function are shown below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Recipe function</th>
<th>Advanced recipe function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicable GOT</td>
<td>• GT15</td>
<td>• GT15</td>
</tr>
<tr>
<td>Required option function board, option OS</td>
<td>• Option function board</td>
<td>• Option function board</td>
</tr>
<tr>
<td></td>
<td>• Option OS (Recipe)</td>
<td>• Option OS (Advanced recipe)</td>
</tr>
<tr>
<td>Settable number of recipes</td>
<td>Max. 256 recipes</td>
<td>Max. 2048 recipes</td>
</tr>
<tr>
<td>Max. No. of settable device points</td>
<td>Maximum 8192 devices *1</td>
<td>Maximum 32767 devices for each setting *1</td>
</tr>
<tr>
<td></td>
<td>(When device type is 32 bit, calculate as 2 points for 1 device.)</td>
<td>(When device type is 32 bit, calculate as 2 points for 1 device.)</td>
</tr>
<tr>
<td>Max. No. of settable values in one device (For each setting)</td>
<td>One (1 record only)</td>
<td>Multiple (Max. 240 records)</td>
</tr>
<tr>
<td>Settable device type</td>
<td>• Signed BIN16 • Signed BIN32</td>
<td>• Signed BIN16 • Signed BIN32</td>
</tr>
<tr>
<td></td>
<td>• Unsigned BIN16 • Unsigned BIN32</td>
<td>• Unsigned BIN16 • Unsigned BIN32</td>
</tr>
<tr>
<td></td>
<td>Only one device type for each setting</td>
<td>Allowed to set multiple device types for each setting.</td>
</tr>
<tr>
<td>Device name for each setting</td>
<td>Only one device name for each setting</td>
<td>Allowed to set multiple device names for each setting.</td>
</tr>
<tr>
<td>Trigger device for reading/writing device value</td>
<td>• Setting trigger device for each setting</td>
<td>• Setting trigger device for each setting</td>
</tr>
<tr>
<td></td>
<td>• Allowed to read/write all advanced recipes in common trigger device</td>
<td>• Allowed to read/write all advanced recipes in common trigger device</td>
</tr>
<tr>
<td>Notifying the process status to the device of PLC CPU</td>
<td>• Reading/writing being executed</td>
<td>• Reading/writing being executed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reading/Writing completed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recipe process error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Displaying the advanced recipe information in utility</td>
</tr>
<tr>
<td>Stored file type</td>
<td>CSV file (For GT15) Binary format file (For GT11)</td>
<td>Binary format file *2</td>
</tr>
</tbody>
</table>

*1 In the case of GT15, the number of devices settable for a recipe setting.
In the case of GT11, the total number of devices in a project.
*2 Can be converted to CSV file or Unicode text file in GT Designer2. It can be displayed or edited on a personal computer.

### Point

**How to check whether the recipe function is being executed**

While a recipe is being processed, no monitoring and key inputs for other objects as well as other operations defined in the recipe are processed. In such a case, whether the recipe function is being executed can be checked using the system information.

1. **System information**
   - The system information can be used to control the GOT operations such as clearing the screen or disabling key inputs from the controller connected to the GOT or to notify the status of the GOT to the controller depending on the status of the devices being used.
   - Refer to the GT Designer2 Version2 Screen Design Manual for details on the system information.

2. **Checking whether the recipe is being executed**
   - By placing a lamp that monitors the recipe in-processing signal on the GOT screen, the recipe function can be checked if it is being executed.

![Recipe in-processing signal](image)

The lamp is lit while the recipe function is executed.

![Recipe in-processing signal](image)

The lamp goes off at the completion of the recipe function.
### 5.18.2 Units and option OS required for the recipe function

(1) Units required for recipe function
To use the recipe function, the following two units are required to install in the GOT in advance.

<table>
<thead>
<tr>
<th>Units required</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option function board</td>
<td>Stores the option OS for the recipe function.</td>
</tr>
<tr>
<td>(GT15-FNB/QGT15-QFN□□□□M)</td>
<td>Stores device values as &quot;CSV files&quot;.</td>
</tr>
<tr>
<td>CF card</td>
<td></td>
</tr>
<tr>
<td>(required only for reading device values)</td>
<td></td>
</tr>
</tbody>
</table>

(2) Option OS required for recipe
The following optional OS is required to be installed.

1) Recipe function
Check and select the optional function [Recipe] when installing the OS.

2) Advanced recipe function
Check and select the optional function [Advanced Recipe] when installing the OS.
5.18.3 Screen setting examples

The following screen will be created on Base Screen No.8 to check the recipe function. This text explains the recipe function.

Numerical input for recipe operation test
Write device: D20 to 24 (16 bits)
5 words worth

Alternate switch setting Recipe 1
Write device: M21
Recipe 1 setting setup contents:
Writes "10" to all D20 to D24

Alternate switch setting Recipe 2
Write device: M22
Recipe 1 setting setup contents: Writes "20" to D20
Writes "20" to D20
Writes "21" to D21
Writes "22" to D22
Writes "23" to D23
Writes "24" to D24

5.18.4 Numerical input settings for recipe operation test

Write device: D20 to D24 (16 bits) for 5 words

(1) Click \(\text{Object}\) on the toolbar (Object).

(2) Move the object to the display position on the screen, and click it to complete positioning.
(3) Making the settings as follows.

1) [Device]: D20
2) [Size]: 2×2

(4) Click the OK button.

(5) Perform the copying operations described in the Point below to make settings on D21 through D24. This completes the setting for numerical input.

**Point**

When placing two or more objects, the devices with increment of the device number can be copied as the follows.

1 Select the object to copy.

![Diagram of object selection]

2 Select the [Edit] - [Consecutive Copy] menu. Make the settings as follows.

![Consecutive Copy dialog box]

Number

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
</tr>
</tbody>
</table>

Interval (Dot)

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Address Increment

Increment (DEC):

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

OK  Cancel
5.18.5 Recipe settings

(1) Select the [Common] - [Recipe] menu.
The Recipe dialog box is displayed.

(2) Set the operation for recipe operation 1.

1) Click and select the No. of recipe operation to register.

2) Click to display the dialog box.

3) Set the Recipe Name.
Enter "Recipe Action".

4) Set Device Points to "5".

5) Set the device to which a value is written.
Click the Dev button, and set the device to "D20".

6) Set the value to be written to the device.
Click each device value, and set it to "10".

7) Set the condition to run the recipe operation.
Click the Dev... button to set the device to "M21" and "ON".

8) Click the OK button.
(3) Setting the operation for recipe operation 2.

1) Click and select the No. of recipe operation to register.

2) Click to display the dialog box.

3) Set the Recipe Name.
Enter "Recipe Operation 2".

4) Set Device Points to "5".

5) Click the button, and set the device to "D20".

6) Click each device value, and set the value to be written to the device.

7) Click the button to set the device to "M22" and "ON".

8) Click the button.

9) Click the Close button.

This completes the setting of the recipe function.
5.18.6 Recipe 1 set switch settings

Write device: Setting Recipe 1 with (M21) = ON.

(1) Select the [Object] - [Switch] - [Bit switch] menu and click on the screen to place the touch switch.
   (Click the right mouse button to complete positioning.)

(2) Make the settings of the touch switch as follows.

   Set the [Basic] tab as follows.
   1) Set the operations.
      [Device]: M21
      [Action]: Alternate
   2) Set the display style.
      [Switch]: ON: red, OFF: green

   Set the [Text/Lamp] tab as follows.
   3) Set the texts to be displayed on the touch switch.
      Enter "Recipe 1 set" on [Text]. After entering it, click the All Settings button of Copy OFF → ON.
   4) Set the method for switching ON and OFF displays of the touch switch.
      When bit device M21 is on, the ON shape of the touch switch is displayed.
      Select Bit, and set the device to M21 by clicking the Dev... button.
   5) Click the OK.
      This completes the settings for the recipe 1 set switch.
5.18.7 Recipe 2 set switch settings

Write device: Setting Recipe 2 with (M22) = ON.

(1) Create a new switch by copying/pasting the created switch in Section 5.18.6.

(2) Change the setting of the copied switch as follows.

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Set data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic tab</td>
<td>Operation setting</td>
</tr>
<tr>
<td></td>
<td>Device: M22</td>
</tr>
<tr>
<td>Text/Lamp tab</td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>&quot;Recipe 2 set&quot;</td>
</tr>
<tr>
<td></td>
<td>Lamp function</td>
</tr>
<tr>
<td></td>
<td>Device: M22</td>
</tr>
</tbody>
</table>

(3) When setting is done, click the OK button.

This completes the settings for the recipe 2 set switch.

Remarks

Refer to Chapter 11 of the GT Designer2 Version2 Screen Design Manual for details on the recipe function.
5.19 Operation Check 7

Open the download screen for monitor data, and download all the data to the GOT. Then, reset the PLC CPU using the RESET key switch, and run it again. Check if recipe function of Screen No. 17 works properly here.

Perform the recipe function tests in screen No.17.

<table>
<thead>
<tr>
<th>Tested object</th>
<th>Numerical input (D20 to D24)</th>
<th>Touch switch (Recipe 1 set)</th>
<th>Touch switch (Recipe 2 set)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) First touch operation</td>
<td>Touch</td>
<td>D20:10, D21:10 D22:10, D23:10 D24:10</td>
<td></td>
</tr>
<tr>
<td>Display/Action</td>
<td>&quot;10&quot; is displayed for all of them.</td>
<td>Recipe operation 1 is activated.</td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td>Touch</td>
<td>D20:10, D21:10 D22:10, D23:10 D24:10</td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td>D20:10, D21:10 D22:10, D23:10 D24:10</td>
<td>Touch</td>
<td>Touch</td>
</tr>
</tbody>
</table>

2) Second touch operation

<table>
<thead>
<tr>
<th>Display/Action</th>
<th>Recipe operation 2 is activated.</th>
</tr>
</thead>
</table>
5.20 Alarm history display function

5.20.1 About the alarm

This is the function to display the user-created comment, and an error of GOT, PLC, and network as an alarm message.

This chapter explains the functions that display following alarms.

(1) Alarm types
The GOT can detect the alarms as shown below.

(a) Displaying the user-created comment as an alarm message
The function that displays the user-created comments as alarm messages when an alarm occurs.
(user alarm, advanced user alarm, alarm history display)
Suitable for the case in which the alarm, which is created by the user, needs to be displayed.

(b) Displaying an error of GOT, PLC, or network as an alarm
It is possible to display the error code and error message when an error occurs on the GOT, PLC or, network. (system alarm, advanced system alarm)
This is used to display an error of GOT, PLC, or network.
(1) Alarm function types

There are two types of alarm: alarm function and advanced alarm function. The advanced alarm function, an extended function of alarm, is only used with the GT15.

<table>
<thead>
<tr>
<th>Alarm Function</th>
<th>Function Name</th>
<th>Alarm Types</th>
<th>Display Method</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>System Alarm</td>
<td>User-Created Alarm</td>
</tr>
<tr>
<td>Alarm List Display</td>
<td>Displays alarms that are currently occurring.</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Alarm History</td>
<td>Displays a history list of alarms that occurred in the table.</td>
<td>x</td>
<td>○</td>
</tr>
<tr>
<td>Advanced User Alarm</td>
<td>Detects the alarms created by the user, and saves the alarm history. An alarm that occurred can be displayed either by the screen unit or in the popup display.</td>
<td>x</td>
<td>○</td>
</tr>
<tr>
<td>Advanced System Alarm</td>
<td>Detects an error of GOT, PLC, or network, and saves the error history. An alarm that occurred can be displayed either by the screen unit or in the popup display.</td>
<td>○</td>
<td>x</td>
</tr>
</tbody>
</table>

*1: An alarm pops up whenever an alarm occurs regardless of the display screen.

Remarks

This text describes the alarm history display function.

Refer to GT Designer2 Version2 Screen Design Manual chapter 8 for the other functions.
5.20.2 About the alarm history display function

(1) The alarm history display function
The alarm occurrence time and comments are stored and displayed in a history list when conditions of the device specified for alarm detection are met (Bit OFF to ON/word device range).

The occurred date, time and message of the alarm are displayed when X0 turns ON.

Alarm details, error measures and so on are displayed.

The window for detail display is any of the comment window, base screen, or window screen.

To create the touch switch for alarm history display, set a key code to the touch switch.

The restoration time is displayed.
(2) Alarm collection mode
Select either of the two collection modes, historical mode or cumulative mode.

- Historical mode
In this mode, alarm contents are added to the memory built-in on GOT each time alarms occur. (Each alarm occurrence is added to the history.)
Up to the following number of alarms can be stored depending on the units:
  - For GT15: 3072 alarms
  - For GT11: 2048 alarms

- Cumulative mode
Latest alarm status, alarm occurrence frequencies and times, are counted and collected.

When an alarm occurs, the following information can be collected and displayed.

<table>
<thead>
<tr>
<th>Occurred</th>
<th>Message</th>
<th>Restore</th>
<th>Check</th>
<th>Cumulate</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/06/01 20:00</td>
<td>Pwr. module error</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>1</td>
</tr>
<tr>
<td>04/06/01 18:30</td>
<td>Oil pressure error</td>
<td>-18:30</td>
<td></td>
<td>-</td>
<td>2</td>
</tr>
<tr>
<td>04/06/01 16:10</td>
<td>Drive module error</td>
<td>16:30</td>
<td>16:20</td>
<td>00:20</td>
<td>2</td>
</tr>
</tbody>
</table>

1) Occurrence date and time
The date/time of alarm occurrence is displayed.

2) Comment
The comment assigned to an alarm is displayed when an alarm occurs.

3) Restoration date and time
The date/time of alarm restoration is displayed.

4) Check
The date/time when an alarm occurred was checked is displayed.

5) Cumulative Time (cumulative mode only)
Total of alarm occurrence time including alarms which occurred in the past is displayed.

6) Frequency of occurrences (cumulative mode only)
The alarm occurrence frequency is displayed.

(3) Maximum number of device points and types of monitor devices being monitored

(a) Types of monitor devices
- Bit device
- Bit device (bit of word)
- Word device (alarm is occurred when the device value falls in the specified range)

(b) Maximum number of monitored points
GT15
- Bit device : 3072 points
- Word device (16-bit) : 1024 points
- Word device (32-bit) : 512 points

GT11
- Up to 256 points regardless of the types of device being monitored

<table>
<thead>
<tr>
<th>Point</th>
</tr>
</thead>
</table>
| Specifying monitor devices randomly to monitor bit devices
A bit device and a bit device (bit of word) cannot be mixed when specifying monitor devices randomly. |
(4) Restrictions and setting positions when using this function
Only one set device and its device name can be monitored for each project.
Although an alarm history display function can be set for each object in each base
screen, the device being monitored is all the same.

![Diagram showing monitor device and alarm history]

- Different settings for the number of row and frame color are available for each alarm history.

(5) Collecting and holding alarm history data

(a) Collecting alarm history data
The GOT collects alarm history data at any time and saves the data in the
GOT.
Alarm history data is constantly collected and updated even while the monitor
screen not including alarm history display is being displayed.

![Data collection diagram]

(b) Deleting alarm history data
All alarm history data are deleted by power-off or reset of the GOT.
Alarm history data can be cleared either on a one-by-one basis or in a bundle
using the key (touch switch) for alarm history switch.

(c) Holding alarm history data under power failure
Alarm history data can be held even if the GOT is powered off by saving the data
to the memory card.
The last state just before the GOT power is turned OFF can be displayed when
the GOT is started again.
d) When the number of alarms occurred has exceeded the upper limit (when the collection mode is "Historical")
   In the case where "When number of alarm occurrences exceeds set value, delete oldest alarm occurrences" was check-marked on the Option (common) tab, if the number of alarms occurred has exceeded the upper limit, the older alarms are deleted from the oldest one.

[Upper limit in total number of alarms occurred]
- For GT15: 3072 alarms
- For GT11: 2048 alarms

Remarks
Alarm history data can be read and edited in the spreadsheet software in the PC by saving it in the CSV format in the memory card.

(6) Display method of details
Details of the device which encountered an error can be displayed in either one of the following three formats (Comment Window, Window Screen, or Base Screen):

1) Display the detail display screen by one touch operation

<table>
<thead>
<tr>
<th>Occurrence</th>
<th>Message</th>
<th>Restore</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/02/01 10:25</td>
<td>Line 1 error</td>
<td>11:25</td>
<td>10:45</td>
</tr>
<tr>
<td>02/02/01 12:05</td>
<td>Line 2 error</td>
<td>12:28</td>
<td></td>
</tr>
<tr>
<td>02/02/01 12:35</td>
<td>Line 3 error</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The specified comment is displayed.

2) Display the detail display screen by key input from the touch switch

<table>
<thead>
<tr>
<th>Occurrence</th>
<th>Message</th>
<th>Restore</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/02/01 10:25</td>
<td>Line 1 error</td>
<td>11:25</td>
<td>10:45</td>
</tr>
<tr>
<td>02/02/01 12:05</td>
<td>Line 2 error</td>
<td>12:28</td>
<td></td>
</tr>
<tr>
<td>02/02/01 12:35</td>
<td>Line 3 error</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The specified comment is displayed.

Remark
Refer to chapter 8 of the GT Designer2 Version2 Screen Design Manual for details on the other functions.
5.20.3 Settings screen example

This section describes screen setting examples that display detailed information using window screens by touching the error messages for bit device ON state (error state), such as "Comment No.1 to No.4", "Occurred Date", "Time", or "Restored Time", or the occurrence comments on the alarm history screen when the bit devices "X2 to X5" are turned ON.

Screen example to create

Screen creation example of window for detail display

**Malfunction 1**  **Action**  
Check limit switch 1.
5.20.4 Alarm history display function settings

(1) Select the [Object] - [Alarm History] menu.

(2) Placement of alarm history display

1) Move the cursor to the desired position where the alarm history to be placed, and click the mouse button.

2) Double-click the alarm history display which has been placed. The [Alarm History] dialog box is displayed.

(3) Common settings for alarm history ([Device (Common)]/[Option (Common)] tab)

Common settings for alarm history are set for each project. Settings for individual base screen are not necessary.

1) Set a device to be monitored. In this case, set [Number of alarms to monitor] to "4" since alarms are set at four bit signals, "X2 to X5".

2) Select "Window screen" for [Detailed alarm display type].

3) Select the top of list, click the Dev button to set the monitor device to "X2". Devices X3 to X5 are consecutively assigned.

4) Set "2" for in [Detail]. The window screen No. to display the detail appears.

Point

(1) The settings whose tab names are marked with (Common) in the dialog box are common settings in project.

(2) Common settings for alarm history display can also be set by the following operations.

- Select the [Common Settings] → [Alarm History] menu.
- Select the [Project] → [Common Settings] → [Alarm History] of the project workspace.
(3) Settings for alarm history display ([Basic]/[Frame]/[Option] tab)
Set the display format (number of rows/frame for alarm) for alarm history display
specified for each base screen.

1) Set "16 x 0" for [Space].

2) Set "Oldest" for [sort setting].

3) Check [Display Alarm Details by One Touch] when window screen is used for
detail display.

4) Check [Draw Ruled Line] to set it to white.

5) Click the OK button.

(4) Settings of comments No.1 to No.4
Set the comments No.1 to No.4 as follows:
Make the settings as indicated.
5.20.5 Alarm history display function switch settings

Set the touch switches used for displaying/moving the cursor for alarm history display and detail display of alarm contents.

1) Place a touch switch for alarm history display on the screen.
   Set the touch switch for alarm history display by reading it out from the GT Designer2 library since it is registered there.


2) When the Library Image list window appears, select "ADALM01_B".

3) Move the cursor to the position where the touch switch for alarm history display is placed, and click the mouse button.
(2) Settings and functions of touch switch for alarm history display

The type of touch switch for alarm history display can be changed with the value of [Key Code] of touch switch.

The following describes the procedures for changing the functions of the touch switch for alarm history pasted in the previous page.

1) Click the right mouse button, and select [Ungroup].

2) Change the value of key code using the property sheet.
The types and the key codes for touch switches for alarm history display are listed in the following table.

<table>
<thead>
<tr>
<th>Switch name</th>
<th>Functions</th>
<th>Key code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show cursor</td>
<td>Show cursor</td>
<td>FFB0H</td>
</tr>
<tr>
<td>Hide cursor</td>
<td>Hide cursor</td>
<td>FFB1H</td>
</tr>
<tr>
<td>Move upward</td>
<td>Move cursor upward (add page break when cursor is hidden)</td>
<td>FFB2H</td>
</tr>
<tr>
<td>Move downward</td>
<td>Move cursor downward (add page break when cursor is hidden)</td>
<td>FFB3H</td>
</tr>
<tr>
<td>Check *1</td>
<td>Display date/time of selected data (check)</td>
<td>FFB4H</td>
</tr>
<tr>
<td>Check all</td>
<td>Display date/time of all data (check all)</td>
<td>FFB5H</td>
</tr>
<tr>
<td>Delete *1</td>
<td>Clear the selected alarm data which has been restored (delete)</td>
<td>FFB6H</td>
</tr>
<tr>
<td>Delete All</td>
<td>Clear all alarm data which has been restored (delete all)</td>
<td>FFB7H</td>
</tr>
<tr>
<td>Detail</td>
<td>Display detail</td>
<td>FFB8H</td>
</tr>
<tr>
<td>Reset *1</td>
<td>Reset the specified device</td>
<td>FFB9H</td>
</tr>
<tr>
<td>Save</td>
<td>Save alarm contents to Memory Card</td>
<td>FFBBH</td>
</tr>
<tr>
<td>Ladder</td>
<td>Start the ladder monitor function to search an alarm device</td>
<td>FFBCH</td>
</tr>
<tr>
<td>Upper hierarchy</td>
<td>Switch for advanced alarm display. This cannot be used in the alarm history display function.</td>
<td>FFC2H</td>
</tr>
<tr>
<td>Lower hierarchy</td>
<td>Switch for advanced alarm display. This cannot be used in the alarm history display function.</td>
<td>FFB8H</td>
</tr>
</tbody>
</table>

*1 This should be used with a switch for show/hide cursor.
5.20.6 Detail display window screen creation

Creating window screens No. 2 to No.5 for detail display.

1) Select the [Screen] - [New Screen] - [Window Screen] menu.

2) The Screen Property dialog box is displayed. Set [Screen Number] to “2”.

3) Click the OK button.

4) Window screen No.2 is displayed on the screen.

5) Set the text as indicated in the left on the window screen.

6) Select the [Screen] - [Close] menu.

(Next page)
7) Repeat steps 1) to 6) to create Window Screen No.3 to Window Screen No.5 as shown in the left.

8) This completes the setting of switch for alarm history display.
5.21 Operation check

Download all the data to the GOT from the download screen of monitor data. Reset the PLC CPU using the RESET key switch, and then switch to RUN. Check if the alarm history display function of Screen No.4 works properly here.

(1) Test 1
Perform the following tests in screen No.18.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Alarm History</th>
<th>Touch switch</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Show cursor</td>
</tr>
<tr>
<td>1)</td>
<td>PLC test switches (X2, X3, X4, X5)</td>
<td>Turns each switch ON.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Screen state</td>
<td>X2 ON: Displays &quot;Malfunction 1&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>X3 ON: Displays &quot;Malfunction 2&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>X4 ON: Displays &quot;Malfunction 3&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>X5 ON: Displays &quot;Malfunction 4&quot;</td>
<td></td>
</tr>
<tr>
<td>2)</td>
<td>First touch operation</td>
<td>Touch each error occurrence line.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display/Action</td>
<td>Display detail display window screens No.2 to 5.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td>D1:2 ~ 5</td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td>Second touch operation</td>
<td>Touch</td>
<td>Touch</td>
</tr>
<tr>
<td></td>
<td>Display/Action</td>
<td>The cursor is displayed.</td>
<td></td>
</tr>
<tr>
<td>4)</td>
<td>Third touch operation</td>
<td>Touch</td>
<td>Touch</td>
</tr>
<tr>
<td></td>
<td>Display/Action</td>
<td>Move the cursor to &quot;Malfunction 1&quot;.</td>
<td></td>
</tr>
<tr>
<td>5)</td>
<td>Forth touch operation</td>
<td>Touch</td>
<td>Touch</td>
</tr>
<tr>
<td></td>
<td>Display/Action</td>
<td>Displays the time when the confirmation switch is touched in &quot;check&quot;.</td>
<td></td>
</tr>
<tr>
<td>6)</td>
<td>PLC test switch (X2)</td>
<td>Turns X2 OFF.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Screen state</td>
<td>Time when X2 is turned OFF is displayed in [Restore] of &quot;Malfunction 1&quot;</td>
<td></td>
</tr>
<tr>
<td>7)</td>
<td>Fifth touch operation</td>
<td>Touch</td>
<td>Touch</td>
</tr>
<tr>
<td></td>
<td>Display/Action</td>
<td>Display in &quot;Malfunction 1&quot; is deleted.</td>
<td></td>
</tr>
</tbody>
</table>
5.22 Language Switching Function Settings

This function is used to switch all the comments shown on the screen to the ones written in another language (English or Chinese) at once.

The language switching function changes the displayed language by changing the value of language switching device. Comments written in Japanese, English, and Chinese must be registered in comment groups in advance.

Example: The language in the comment display can be switched from Japanese to English to Chinese.

![Diagram showing language switching function]

[Contents of registered comments]

<table>
<thead>
<tr>
<th>No.</th>
<th>Comment Group 1 Comment List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column No.</td>
<td>Comment No.</td>
</tr>
<tr>
<td>1</td>
<td>Aライン供給コンペア停止</td>
</tr>
<tr>
<td>2</td>
<td>非常停止リミット作動</td>
</tr>
<tr>
<td>3</td>
<td>加工品冷却油压低下</td>
</tr>
<tr>
<td>4</td>
<td>加工机-10油压低下</td>
</tr>
</tbody>
</table>

The following screen will be created in Base Screen No.19.
5.22.1 Language switching device setting

Make settings on the language switching device to use the language switching function.
The language switching device is common setting for the project.

1) Double-click [Common Settings] → [System Environment] menu in the workspace.

2) As the System Environment dialog box appears, double-click [Language Switching].

3) Check [Use Language Switching].

4) Set the language switching device to "D1100".

5) After the setting is completed, click the OK button.
5.22.2 Comment group registration

(1) Creating a new comment group (title)

1) Select the [Common] - [Comment] - [New Comment Group] menu.

2) Make the settings as follows as the Comment Group Property dialog box appears.
   - [Group No.]: 3
   - [Title]: Comment Group 3
   - [Check columns]: 1 and 2.
   - [KANJI Region]: Japan and China[GB]-Mincho

   After the settings are completed, click the OK button.

3) The No.1 Comment Group 1 Comment List dialog box is displayed.
   Enter comments as follows.
   - [Column 1]: "ラインA生産状況"
   - [Column 2]: "Line A Production Condition"

   After the settings are completed, click the X button to close the window.

(2) Creating a new comment group (operating condition)

1) Select the [Common] - [Comment] - [New Comment Group] menu.

2) Make the settings as follows as the Comment Group Property dialog box appears.
   - [Group No.]: 3
   - [Title]: Comment Group 3
   - [Check columns]: 1 and 2.
   - [KANJI Region]: Japan and China[GB]-Mincho

   After the settings are completed, click the OK button.

(Next page)
3) The No.2 Comment List dialog box is displayed. Enter comments as follows.

[Column No. 1]: "稼働中"
[Column No. 2]: "Operating"

4) Click the (New Comment) button.

5) Enter the following comments next.

(Comment No. 2)
[Column 1]: "コンペア停止中"
[Column 2]: "Conveyor stopped"

(Comment No. 3)
[Column 1]: "点検中"
[Column 2]: "Inspecting"

(Comment No. 4)
[Column 1]: "異常停止中"
[Column 2]: "Emergency stopped"

(Comment No. 5)
[Column 1]: "完了"
[Column 2]: "Complete"

After the settings are completed, click the button to close the window.

**Point**

1) **Kanji region setting**
   - Set when using kanji for each comment column.
   - The default setting (Japan) is applicable to input the language without using kanji such as English.

2) **When Kanji other than the ones for Japanese is used**
   - In this case, the option function board is required to be installed in the GOT to install the system font for the language.
   - If the option function board is not installed in GOT or the system font is not installed, characters are displayed in Japanese kanji.
Remarks

Pasting Excel text to comments

Multi-line text such as Excel can be pasted to the comment list using the following procedure.

1) Copy multiple rows in Excel.
2) Select a comment row/column to which the row/column of the Excel is pasted and right-click on the row/column on the comment list.
3) Select [Paste From Excel] from the displayed menu to paste the comments.

![Excel comment list diagram]
5.22.3 Comment display setting

(1) Setting the comment display (Word)

1) Select the [Object] - [Comment Display] - [Word Comment] menu.

2) Move the cursor to place where the word comment is placed, and click the mouse button.

3) Set [Basic] tab as follows.
   [Device]: D1110
   [Size]: 2 x 2
   [Alignment]: Center
   [Preview No.]: 1

4) Select the [Comment] tab.

5) Select [Comment Group].
   Fixed: 01
   High Quality Font: Gothic

After the settings are completed, click the OK button.

6) Repeat steps 1) through 5) to create the "Operating condition" word comment.
   Change the following items.

   [Basic] tab
   [Device]: D1120
   [Preview No.]: 2

   [Comment] tab
   Fixed: 2

After the settings are completed, click the OK button.
5.22.4 Touch switch setting

(1) Setting the Data Set switch

1) Select [Object] - [Switch] - [Data Set Switch] menu.

2) Move the cursor to the position where the Data Set Switch is placed, and click the mouse button.

3) Set [Basic] tab as follows.
   • Operation setting
     [Device]: D1100
     [Set Value]: Check Select [Fixed]
     Set "1".
   • Display Style
     [Shape]: Rectangle: Rect_10
     [Switch] (OFF): dark blue
     [Switch] (ON): yellow

4) Select the [Text/Lamp] tab.

5) Enter "Japanese" on [Text].

After the settings are completed, click the OK button.

6) Create another switch by copying and pasting the switch created in 1) through 5) above.

7) Double-click the switch created by copying/pasting, and reset it as follows.
   [Basic] tab
   [Set Value]: Check [Fixed] and set "2"
   [Text/Lamp] tab
   Enter "English" on [Text].

After the settings are completed, click the OK button.
5.23 Operation Check 9

Open the download screen for monitor data and download all the data to the GOT. Reset the PLC CPU using the RESET key switch, and then switch to RUN.

(1) Test 1
Run the following test on Screen No. 19.

<table>
<thead>
<tr>
<th>Tested object</th>
<th>The Data Set switch (English)</th>
<th>The Data Set switch (Japanese)</th>
<th>Comment display (operating condition)</th>
<th>Comment display (Line A production status)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch operation (English)</td>
<td>Touch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen state</td>
<td>The Switch is pressed.</td>
<td></td>
<td>Changed to English display.</td>
<td>Changed to English display.</td>
</tr>
<tr>
<td>Write device</td>
<td>D1100 : 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td></td>
<td></td>
<td>D1120</td>
<td>D1110</td>
</tr>
</tbody>
</table>

| Touch operation (Japanese) | Touch | | | |
| Screen state | | The Switch is pressed. | Changed to Japanese display. | Changed to Japanese display. |
| Write device | | D1100 : 1 | | |
| Read device | | | D1120 | D1110 |
5.24 Drawing Tips

Note the following items when creating screen data.

5.24.1 Superimposition of figures and objects

The object is always superimposed on the shape when an object and a shape are overlaid.

5.24.2 Superimposition of objects

The following combinations are available to superimpose an object over another.

(1) When using layers
   Objects can be superimposed regardless of object types by assigning different objects to different layers (front layer or back layer).

(2) When not using layers
   The following combinations are available possible to superimpose an object over another within the same layer.
   • Touch switch and other objects (except numerical input and ASCII input)
   • Level display and numerical display
   • Level display and comment display
   • Parts display and parts display
   • Touch switch and numerical input and ASCII input *1

*1 Objects set in separate screens are shown overlaid through the superimpose windows or screen callouts.

Remarks

Refer to Chapter 2 of the GT Designer2 Version2 Screen Design Manual for details on superimposing objects.
5.24.3 Number of objects that can be set on one screen

Refer to Appendix 7 for the number of settable objects and the capacity of available data on one screen.

5.24.4 Color scheme

The color scheme differs depending on the GOT type as follows.

(a) 256 Colors
Click [More Colors...] to select desired color from 256 colors.
The selected color is displayed in area (a).

5.24.5 Method for checking the memory capacity of drawing screen

The memory capacity of drawing screen can be checked by the following procedure.

1) Select the [Communication] - [To/From GOT...] menu.
2) Communicate with GOT dialog box is displayed.
The number displayed on [Transfer Size] is the current data size of the screen.
5.25 Training device list and sequence program

(1) Training device list

<table>
<thead>
<tr>
<th>Device</th>
<th>Signal name</th>
<th>GOT operation</th>
<th>Device</th>
<th>Signal name</th>
<th>GOT operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>X0</td>
<td>Base screen No. set</td>
<td>Y40 to Y4F</td>
<td>Y40 to Y4F</td>
<td>32-Bit data lower display</td>
<td>R</td>
</tr>
<tr>
<td>X1</td>
<td>Window screen No. set</td>
<td>Y50 to Y5F</td>
<td>Y50 to Y5F</td>
<td>32-Bit data upper display</td>
<td>R</td>
</tr>
<tr>
<td>X2</td>
<td>Malfunction 1</td>
<td>Y60 to Y6F</td>
<td>Y60 to Y6F</td>
<td>Not used.</td>
<td>R</td>
</tr>
<tr>
<td>X3</td>
<td>Malfunction 2</td>
<td>Y70 to Y7F</td>
<td>Y70 to Y7F</td>
<td>Not used.</td>
<td>R</td>
</tr>
<tr>
<td>X4</td>
<td>Malfunction 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X5</td>
<td>Malfunction 4</td>
<td>D0</td>
<td>D0</td>
<td>Base screen switching</td>
<td>W</td>
</tr>
<tr>
<td>X6</td>
<td>Not used.</td>
<td>D1</td>
<td>D1</td>
<td>Window screen switching</td>
<td>W</td>
</tr>
<tr>
<td>X7</td>
<td>LCD screen level upper limit</td>
<td>D2</td>
<td>D2</td>
<td>Trend graph 1</td>
<td>R</td>
</tr>
<tr>
<td>X20 to X23</td>
<td>BASE SCREENS (0-99)</td>
<td>D3</td>
<td>D3</td>
<td>Trend graph 2</td>
<td>R</td>
</tr>
<tr>
<td>X24 to X2F</td>
<td>Window screens (0-99)</td>
<td>D4</td>
<td>D4</td>
<td>Trend graph 3</td>
<td>R</td>
</tr>
<tr>
<td>X30 to X3F</td>
<td>Not used.</td>
<td>D5</td>
<td>D5</td>
<td>Bar graph 1</td>
<td>R</td>
</tr>
<tr>
<td>M1000</td>
<td>Line operation</td>
<td>D6</td>
<td>D6</td>
<td>Bar graph 2</td>
<td>R</td>
</tr>
<tr>
<td>M1010</td>
<td>Start/Stop</td>
<td>D7</td>
<td>D7</td>
<td>Bar graph 3</td>
<td>R</td>
</tr>
<tr>
<td>M1210</td>
<td>Convey start/stop</td>
<td>D9</td>
<td>D9</td>
<td>Level device</td>
<td>R/W</td>
</tr>
<tr>
<td>M5</td>
<td>Line stop</td>
<td>D12</td>
<td>D12</td>
<td>32-Bit lower data</td>
<td>R/W</td>
</tr>
<tr>
<td>M10</td>
<td>GOT timer 1 ON</td>
<td>D13</td>
<td>D13</td>
<td>32-Bit upper data</td>
<td>R/W</td>
</tr>
<tr>
<td>M11</td>
<td>GOT timer 1 OFF</td>
<td>D15</td>
<td>D15</td>
<td>Timer 1 time limit</td>
<td>R/W</td>
</tr>
<tr>
<td>M12</td>
<td>Timer 1 ON</td>
<td>D17</td>
<td>D17</td>
<td>Comment display</td>
<td></td>
</tr>
<tr>
<td>M13</td>
<td>Timer OFF</td>
<td>D20 to D24</td>
<td>D20 to D24</td>
<td>Recipe data</td>
<td>R/W</td>
</tr>
<tr>
<td>M21</td>
<td>&quot;Recipe 1 set&quot;.</td>
<td>D26</td>
<td>D26</td>
<td>Superimpose screen switching</td>
<td>W</td>
</tr>
<tr>
<td>M22</td>
<td>Recipe 2 set</td>
<td>D30</td>
<td>D30</td>
<td>1 sec *1</td>
<td>R</td>
</tr>
<tr>
<td>M30</td>
<td>Preparation *1</td>
<td>D31</td>
<td>D31</td>
<td>10 sec *1</td>
<td>R</td>
</tr>
<tr>
<td>M31</td>
<td>Operation/Stop *1</td>
<td>D32</td>
<td>D32</td>
<td>1 min *1</td>
<td>R</td>
</tr>
<tr>
<td>M32</td>
<td>Operating *1</td>
<td>D33</td>
<td>D33</td>
<td>10 min *1</td>
<td>R</td>
</tr>
<tr>
<td>M33</td>
<td>1 minute elapsed *1</td>
<td>D34</td>
<td>D34</td>
<td>1 hour *1</td>
<td>R</td>
</tr>
<tr>
<td>M34</td>
<td>8 hours have elapsed *1</td>
<td>D1000</td>
<td>D1000</td>
<td>Cooling water temperature</td>
<td>R</td>
</tr>
<tr>
<td>T10</td>
<td>Timer 1</td>
<td>D1100</td>
<td>D1100</td>
<td>Language switching device</td>
<td>W</td>
</tr>
<tr>
<td>T30</td>
<td>Timer 2 *1</td>
<td>D1120</td>
<td>D1120</td>
<td>Line A production status</td>
<td>R</td>
</tr>
<tr>
<td>T1001</td>
<td>Timer 3</td>
<td>D1200</td>
<td>D1200</td>
<td>Parts movement switching device</td>
<td>R</td>
</tr>
<tr>
<td>T1002</td>
<td>Timer 4</td>
<td>D1210</td>
<td>D1210</td>
<td>Number of units</td>
<td>R</td>
</tr>
<tr>
<td>T1120</td>
<td>Timer 5</td>
<td>D1511</td>
<td>D1511</td>
<td>Line 1 production volume</td>
<td>R</td>
</tr>
<tr>
<td>T1200</td>
<td>Timer 6</td>
<td>D1512</td>
<td>D1512</td>
<td>Line 2 production volume</td>
<td>R</td>
</tr>
<tr>
<td>T1511</td>
<td>Timer 7</td>
<td>D1513</td>
<td>D1513</td>
<td>Line 3 production volume</td>
<td>R</td>
</tr>
<tr>
<td>T1512</td>
<td>Timer 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T1513</td>
<td>Timer 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Used for the appendix training. R: Reading W: Writing

Point

To identify the device used for the project data being edited, the Device List function of GT Designer2 will be useful.

Refer to section 5.26 of this text for details.
(3) Training sequence program

* Timer ON/OFF, Time limit D15 is set by GOT.

* Write 32-bit data

* Base/window screen switching

(Next page)
* Comment/Alarm history in malfunction

- Error 1
  - MOV PK1 D17 Error data

- Error 2
  - MOV PK2 D17 Error data

- Error 3
  - MOV PK3 D17 Error data

- Error 4
  - MOV PK4 D17 Error data

* Operation graph display ladder for lines 1 to 3

- Line operation Line storage p
  - MOV PK0 Z0
  - PLS M6 Graph input

- RST T0
  - FCR K3
5.26 Method for checking devices using the created screen data

To identify the device used for the created screen data, the Device List function of GT Designer2 will be useful. Display a list of devices used for the screen data created during this training here.

A device list can be displayed in either one of the following two ways:
- a list grouped by the project data
- a list grouped by one screen

Select a list from the project data in order to display a list of devices for the set of created data here.

Click the [Tools] - [Device List] - [Project] menu.

The Device List dialog box is displayed. As a list of bit devices is shown right after the Device List dialog box appears, check what bit devices are included in the list.

Click the [Word] tab to see a list of word devices.

A list of word devices is displayed.

Point

When the desired device is not shown in the list, click the Find button to specify the appropriate device.

Refer to chapter 12 of the GT Designer2 Version Basic Operation/Data Transfer Manual for details on this setting.
Chapter 6 Batch Setting for Objects

The GT Designer2 has various functions to improve the drawing efficiency. This chapter describes efficient ways for changing the settings for objects on the copied screen.

6.1 Screen Copy (Workspace)

Create Screen No. 2 by copying Screen No. 1 created in Chapter 4

1) Open the read-out data in Chapter 4 (SCHOOL.GTE), and right-click Screen No. 1 in the property sheet.

2) Select the [Copy] menu, and then the [Paste] menu.

3) The Screen Property dialog box is displayed.

4) Set [Screen Number] to “2”.

5) Click the [OK] button.

6) Screen No.2 is created.
6.2 Selecting Specified Objects in a Batch (Data View)

Select multiple specified objects using the Data View.

(1) Data View

The Data View displays all shapes and objects placed on the screen in a list. The listed shapes and objects can be double-clicked and edited directly.

Check the item to be displayed.
Figure, object name, position and object ID (object only) are displayed.
When the desired figure/object is selected, an object on the screen is selected.
“G” is displayed in front of the name of the grouped figures.

(2) Selecting multiple touch switches

Select the touch switches on Screen No. 4.

1) Click on the toolbar (Standard).
The Data View is displayed.

2) Select [Data Set Switch] in the Data View.

3) The data set switches on the screen are selected.
6.3 Setting Objects in a Batch (Property sheet)

The settings for bit switches are changed all at once using the property sheet.

(1) Property sheet
The property sheet displays all setting items and details of object/shape/screen currently selected in a list.
Since the Property sheet allows setting of the selected object/shape/screen, the setting details can be checked and set (changed) without opening the dialog box.
(2) Changing the touch switch setting
The settings for the touch switches selected in Section 6.2 (2) are changed all at once.

(a) Changing shapes in a batch

1) Select [Shape] in the Property sheet with the switches selected as described in Section 6.2 (2).

2) Set [Shape] to "Circle: Circle_7".

3) The shapes for the selected data set switches are changed all at once.
(b) Changing device setting in a batch

1) Select [Device] in the property sheet.

2) Set [Device] to "D100".

3) The device setting for the selected touch switches is changed to "D100".

4) The creation of Screen No. 2 using Screen No. 1 is finished.
Remarks

Changing specific items (device, color, shape, or CH No.) in a batch.

The Device Batch Edit dialog box allows to change specific items (device, color, shape, or CH No.) for the selected range of objects in a batch.

The Device Batch Edit dialog box is opened with the procedure shown below.
• [Tools] - [Batch Edit] - [Replace Devices...]/[Replace Colors...]/[Replace Shapes...]/[Replace CH No...] menu

Example: Replacing specific devices used throughout a project
(D0 → D100, X0010 → M50)
Appendix 1  Security Function

Appendix 1.1  Security Function

This function determines which screen is displayed depending on the security level. The security level can be changed by inputting the password corresponding to each level.

The security level (0 to 15) can be set for each screen and object. (The security level can be set for each object function, window screen and base screen.)

<table>
<thead>
<tr>
<th>Security level</th>
<th>Security level: 2</th>
<th>Security level: 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>not displayed/not executed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>displayed/executed</td>
<td>not displayed/not executed</td>
</tr>
<tr>
<td>2</td>
<td>displayed/executed</td>
<td>not displayed/not executed</td>
</tr>
<tr>
<td>3</td>
<td>displayed/executed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Caution
A password to register can consist of up to eight single-byte alphanumeric characters (0 to 9, A to F).

Important
If the password set for each security level is forgotten, the security will not be released.
Be sure to make a note of the password, since there is no way to check it later, once registered.
(2) Security level change

This section describes the procedures of changing the security level by password.

<table>
<thead>
<tr>
<th>Security level status</th>
<th>Screen</th>
<th>Operation contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 0</td>
<td><img src="image" alt="Base screen 1" /></td>
<td>The object function on the screen cannot be used, because the security level is low.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Base screen 1" /></td>
<td>• Base screen 1 (security level 0)</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Base screen 1" /></td>
<td>• Each object function (security level 4)</td>
</tr>
<tr>
<td>Level 0</td>
<td><img src="image" alt="Base screen 1" /></td>
<td>When changing the security level, touch the touch switch to display the password screen.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Base screen 1" /></td>
<td>Enter the password for security level 4</td>
</tr>
<tr>
<td>Level 0</td>
<td><img src="image" alt="Base screen 1" /></td>
<td>Enter the password, and change the security level into 4.</td>
</tr>
<tr>
<td>Level 0</td>
<td><img src="image" alt="Base screen 1" /></td>
<td><img src="image" alt="Base screen 1" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Base screen 1" /></td>
<td>Displays numeric value display</td>
</tr>
<tr>
<td>Level 4</td>
<td><img src="image" alt="Base screen 1" /></td>
<td>The object function corresponding to security level 4 is displayed.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Base screen 1" /></td>
<td>Displays touch switch</td>
</tr>
</tbody>
</table>

Remarks

Refer to the following chapters of the GT Designer2 Version2 Screen Design Manual for details on the security function.

• Security function: Chapter 5
• Setting the password for security level change: Chapter 3
Appendix 1.2 Settings Screen Example

This section describes the specific example of creating a screen with the following security functions set. With the screen just created, make the following settings:

**Screen No.10**
1) Screen switching to a particular screen (Screen No.11) will not be allowed unless the security level of Screen No.10 is changed to "1" with the password (level 1).

**Screen No.11**
1) The touch switch will not operate unless the security level is higher than "2".
2) The security level will be set back to "0" after Screen No.11 is switched to a different screen (Screen No.10).

**Base Screen No.10**

No. 10 Security Test (1/2)
An operation test is run to see whether or not Screen No. 11 can be opened when the password for that security level is used.

Level Status (D9)

Security Display: Level 0

Security Input (operation): Level 1

Switch operation enabled at Level 1 and higher

Password: Password 111 (Level 1)
Password: Password 222 (Level 2)

**Base Screen No.11**

No. 11 Security Test (2/2)

Level Status (D9)

Security Display: Level 0

Security Input (operation): Level 0

Switch operation enabled at Level 2 and higher

When you touch the switch, the level is set to "0"
Appendix 1.3 Password setting for Security Level

1) Click on the [Common] - [System Environment] menu.

2) As the System Environment dialog box appears, double-click [Password].

3) Check [Level Device].

4) Set the device where the current value of security level for the GOT is stored. The security level can also be changed by changing the level device value using the PLC CPU.

Click the Dev… button to set the level device to "D20".

5) Click Level 1 to select it.

6) Click the Edit button.

7) As the password dialog box appears, enter "123" for the level password of the security level 1. A password consisting up to eight single-byte alphanumeric characters (0 to 9, A to F) can be registered.

8) Click the OK button.

9) Repeat the above procedures to set "222" for the level password of the security level 2.

10) Click the OK button.
Important

Be sure to make a note of the password because it is required to enter the registered password when changing or deleting it.

Remarks

The security level is stored in the device (level device) which contains states of security levels. The current security level can be changed by changing the level device value directly from the PLC CPU.

The display is changed according to the changed security level.
Appendix 1.4 Object Setting (security setting) of Base Screen No.10

(1) Create a touch switch going to Base Screen No.11 using the following settings:

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Switch name</th>
<th>No.11</th>
<th>Open</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic tab</td>
<td>Screen Switch Type</td>
<td>Base screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Switching Screen</td>
<td>Fixed value: 11</td>
<td></td>
</tr>
<tr>
<td>Text/Lamp tab</td>
<td>Text (ON/OFF)</td>
<td>No.11</td>
<td>Open</td>
</tr>
</tbody>
</table>

(2) Set the security level to the touch switch created in step 1.

1) Click [Extended] of [Extended Function].

(Next page)
2) The [Extended] tab is displayed.

3) Set the "display" and "input" of the security level as follows:
   Security Display: 0
   Security Input: 1

4) Click the OK button.

Remarks

Two types of security levels (for input and display) can be set in the numerical input, the ASCII input and the touch switch functions.

Example: When the security level is set in the numerical input function.

Production volume
Security level
   For display: 5
   For input: 10

[Security level 5]
Production volume
600
Numeric value cannot be displayed only.
Numeric value cannot be input.

[Security level 10]
Production volume
600
The input cursor is displayed so that numeric value can be input.
(3) Create a touch switch to display the password screen.

1) Click the [Object] - [Switch] - [Special Function Switch] menu to place the touch switch.

2) Make the settings as follows:
   (Do not set a security level.)

<table>
<thead>
<tr>
<th>Switch name</th>
<th>Password input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation setting</td>
<td>Password</td>
</tr>
<tr>
<td>Display style</td>
<td>Shape: Rectangle (1): rest_12</td>
</tr>
</tbody>
</table>

   | Text/Lamp tab | Text (ON/OFF) | Password input |

(4) Create a numerical display to show the security level of the GOT using the following settings:
   (Do not set a security level.)

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Object name</th>
<th>Numerical display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic tab</td>
<td>Device</td>
<td>Device: D9</td>
</tr>
</tbody>
</table>

   | Display style | Data type: Signed decimal
   | | Digits: 6 digits |
Appendix 1.5  Object Setting (security setting) of Base Screen No.11

Create a new touch switch for testing the security level 2 by copying and pasting the switch created in step (3) of Appendix 1.4.

(1)  Change the settings of the copied switch as follows:

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Security test switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic tab</td>
<td>Operation setting</td>
</tr>
<tr>
<td></td>
<td>Utility</td>
</tr>
<tr>
<td>Text/Lamp tab</td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>When it is lit: ON</td>
</tr>
<tr>
<td></td>
<td>When it is not lit: OFF</td>
</tr>
<tr>
<td>Extended tab</td>
<td>Security</td>
</tr>
<tr>
<td></td>
<td>Display: 0</td>
</tr>
<tr>
<td></td>
<td>Input: 2</td>
</tr>
</tbody>
</table>

(2)  Create a numerical display to show the security level of the GOT by copying and pasting the numerical display created in Base Screen No.10.

(3)  Create a touch switch (multi action switch) going to Base Screen No.10.
When this touch switch is touched, the security level will be set to "0" on Base Screen No.10 after screen switching since the value of the level device (D9) is set to "0".
This setting will not allow Screen No.10 to open Screen No.11 unless the security level is changed to "1" by re-entering the password.

(a)  Click the [Object] - [Switch] - [Multi Action Switch] menu to place the touch switch.
(b)  Make the settings of operation as follows:

![Multi Action Switch](image)

In the [Basic] tab, make the settings as follows.

1)  Click the [Word] button to allow writing "0" to the level device (D9).
   [Device]: D9
   [Fixed]: 0

2)  Click the [Base] button to allow screen switching to Base Screen No.10.
   [Fixed]: 10
(c) Make the settings of display style as follows:
(Do not set a security level.)

<table>
<thead>
<tr>
<th>Setting items</th>
<th>Set data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text/Lamp tab</td>
<td>Text (ON/OFF)</td>
</tr>
<tr>
<td>Go back to No.10.</td>
<td></td>
</tr>
</tbody>
</table>
Appendix 1.6 Operation Check

Download all the data to the GOT from the download screen of monitor data. Reset the PLC CPU using the RESET key switch, and then switch to RUN. Check if the security functions of Screen Nos. 10 and 11 work properly here.

(1) Test 1
Perform the security function tests in screen No. 10.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Numerical display</th>
<th>Touch switch (password input)</th>
<th>Touch switch (No. 11 Open)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) First touch operation</td>
<td></td>
<td></td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td></td>
<td></td>
<td>No operation</td>
<td></td>
</tr>
<tr>
<td>2) Second touch operation</td>
<td></td>
<td></td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td>Display/Action</td>
<td>Displayed “1”</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td></td>
<td>D9: 1</td>
<td></td>
</tr>
<tr>
<td>Read device</td>
<td>D9: 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3) Third touch operation</td>
<td></td>
<td></td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td>Display/Action</td>
<td></td>
<td></td>
<td>The screen switches to Screen No. 11.</td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write device</td>
<td></td>
<td></td>
<td>D0: 11</td>
<td></td>
</tr>
</tbody>
</table>
(2) Test 2  
Perform the security function tests in screen No.11.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Numerical display</th>
<th>Touch switch (ON/OFF)</th>
<th>Touch switch (go back to No.10)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) First touch operation</td>
<td>Display/Action</td>
<td>Displayed “2”</td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Read device</td>
<td></td>
<td>D9: 2</td>
<td></td>
</tr>
<tr>
<td>2) Second touch operation</td>
<td>Display/behavior</td>
<td></td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3) Third touch operation</td>
<td>Display/Action</td>
<td></td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Write device</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) The screen switches to Screen No.10.  
2) Return the security level to 0.

1) D0: 10  
1) D9: 0
Appendix 2  Script Function

Appendix 2.1  Script Function

This is the function capable of controlling the GOT display with its own program. Controlling the GOT display with the GOT side script drastically reduces the load on the system side (e.g. PLC CPU, microcomputer) display.

(1) Various screen controls by GOT alone
Using the script functions enables the following operations that could not be achieved by GOT alone.
(a) Combinations with various object functions
   • A single lamp represents multiple bit device statuses.
   • A specific part is displayed if any of multiple bit devices is ON, and is erased if they are all OFF.
   • At the same time as a numeric value is input, a part indicating "Already input" is pasted to the place adjacent to the input value display frame.
   • A single touch switch can make multiple operations corresponding to multiple statuses.
   • The troubleshooting screen is displayed automatically at the same time that the alarm list (system alarm) detects an error.
(b) Processing of complicated arithmetic
   • A polynomial operation can be more simply represented on a single line as compared with ladder program.

\[
[w:D5] = ([w:D1] - [w:D2])/100 + [w:D3] - [w:D4] - 100;
\]

- Not only four fundamental operations but also various application arithmetic functions, such as trigonometric and exponential functions, can be used optionally.
(c) Expanded applicable fields
   • The date is calculated by entering the start date (month, day and year) and the days elapsed from that date.
   What is the date 345 days after May 20, 2000? → April 30, 2001
   • The day of the week is calculated by entering the corresponding date (month, day and year).
   Which day of the week falls on February 21, 1961? → Tuesday

(2) Easy system maintenance
As the necessary programs can be created and assigned to GOT with the script functions in advance, the system side handles only machine control programs, facilitating system maintenance.

(3) Easy language programming
Script can be created with entry-level programming knowledge, as it is C language-like program.

Appendix 13
(4) Compatibility with commercially-available programming editors
Commercially-available text editors (e.g. Microsoft® Windows® -standard memo pad, Wordpad) are applicable for programming to improve program productivity.

(5) Execution condition selectable for each script
Any of various conditions (ordinary, periodic, bit Rise/Fall, during bit ON/OFF, periodic during bit ON/OFF) can be selected as a trigger to execute each script, which enables script execution scheduling.
In addition to the above conditions, an object script can be executed in synchronization with object input/display and touching of a touch switch.

(6) Fully useful debugging functions
Since a script is C language-like program, the general C language compiler or debugger (e.g. Microsoft® Visual C++) can be used for its simulation by making slight corrections.
This is effective for debugging a complicated script that includes many control statements.
The system monitor function is useful for hardware debugging using GOT.
The test and device monitor functions are available to check conditional branching in a script.
By monitoring the GOT special registers (GS), error information and a script in execution can be easily confirmed.

(7) Enables checking of the syntax for the created scripts
The syntax for the created scripts can be checked using GT Designer2 before it is executed on GOT, which increases the programming efficiency.

(8) Enables conversion of the script language created by Digital Electronics Corporation’s application.
The script language (D script/global D script) created by Digital electronics Corporation’s application can be converted to that for GOT and executed on GOT.

<table>
<thead>
<tr>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Execution condition setting and syntax validity check</td>
</tr>
<tr>
<td>Make &quot;execution condition setting&quot; and &quot;syntax validity check&quot; on GT Designer2 at the time of monitor screen creation.</td>
</tr>
<tr>
<td>Refer to the following section for details.</td>
</tr>
<tr>
<td>→ GT Designer2 Version2 Screen Design Manual</td>
</tr>
</tbody>
</table>

| (2) Converting script language created by Digital Electronics Corporation |
| Convert the script language created by Digital Electronics Corporation using GT Converter2. |
| Refer to the following for details on convertible data and conversion method. |
| → GT Converter2 Version2 □ Operating Manual |
(9) Script functions types

There are three types of script functions as below.

1) Project script
   (a) Target of setting/action
       Project script means the script function that is set/operated for the project as a whole.
   
   (b) GOT status that enables execution of a project script
       A project script can be executed any time while the GOT is online.
   
   (c) Script execution condition
       A script is executed when the condition set for each script is established.
   
   (d) Allowable number of scripts
       Up to 256 scripts can be set for a project.

<table>
<thead>
<tr>
<th>Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Application of project scripts</td>
</tr>
<tr>
<td>Since a project script operates for a project as a whole, it can be conveniently used in such as the case shown below.</td>
</tr>
<tr>
<td>Example: The troubleshooting screen is displayed automatically at the same time that the alarm list (system alarm) detects an error.</td>
</tr>
</tbody>
</table>

| (2) Precautions for setting a project script |
| Devices monitored by project scripts are always operating. |
| Therefore, if the number of monitor target devices increases, display on the monitor screen will be delayed. |
2) Screen script
   (a) Target of setting/action
   Screen script means the script function that is set/operated for the screens indicated below.
   • Base Screen * 1, * 2
   • Window Screen * 1, * 2
   (Superimpose window 1, Superimpose window 2, Overlap window 1, Overlap window 2)
   * 1 The called screen by the set overlay screen function is also the target of a screen script.
   * 2 The screen displayed by the parts display function is not the target of a screen script.

   (b) GOT status that enables execution of a screen script
   An object script function can be executed when four conditions below are all satisfied.
   • GOT is online.
   • The target screen is displayed.

   (c) Script execution condition
   A script is executed when the condition is established.

   (d) Allowable number of scripts
   Up to 256 scripts can be set in a screen (including the called screens by the set overlay screen function)

<table>
<thead>
<tr>
<th>Setting/Operation Target of Object Script Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamp display, Touch switch (multi-action switch only),</td>
</tr>
<tr>
<td>Numerical display, Numerical input, ASCII display,</td>
</tr>
<tr>
<td>ASCII input, Clock display (date display, time display), Comment display,</td>
</tr>
<tr>
<td>Parts display, Parts movement, Panelmeter display,</td>
</tr>
<tr>
<td>Level display, Trend graph, Line graph,</td>
</tr>
<tr>
<td>Bar graph, Statistics graph, Scatter graph</td>
</tr>
</tbody>
</table>

Point
Precautions for setting a screen script
If the number of monitor devices of screen scripts increases, display on the monitor screen will be delayed.

3) Object script (GT15 only)
   (a) Target of setting/action
   Object script means the script function that is set/operated for the objects indicated below.

   (b) GOT status that enables execution of a script function
   An object script function can be executed when four conditions below are all satisfied.
   • GOT is online.
   • The screen where the placed target object is displayed.
   • The target object is displayed/operating.
   • Target object operating is not restricted by the security function.
(c) Script function execution condition
   The script is executed in synchronization with object input/display and touching of a touch switch in addition to when the condition is established.

(d) Allowable number of script functions
   For the numerical input and the ASCII input, the input object script and the display object script can be set to an object.
   For an object other than the numerical input and the ASCII input, either of the input object script or the display object script can be set to an object.

<table>
<thead>
<tr>
<th>Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precautions for setting an object script</td>
</tr>
<tr>
<td>If the number of monitor devices of object scripts increases, display on the monitor screen will be delayed.</td>
</tr>
</tbody>
</table>
Appendix 2.2 Effective Example of Using Script Function

This section provides effective examples of using the script functions. Refer to chapter 16 of the GT Designer2 Version2 Screen Design Manual for details on specifications, settings, and restrictions of the script functions.

(1) Lamp showing various displays depending on multiple conditions

(a) Desired function
The current GOT is not supported the function which displays the control status for three lines with only one lamp, as well as controls each line with touch switch.

(b) Specific example of using script function
Comments and lamp colors change according to the combination of line control switches pressed.

Point
Values must be stored in the device for all the possible combinations of switch operations.
(c) Setting example

1) Devices to be used

<table>
<thead>
<tr>
<th>Device type</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>D10</td>
<td>Lamp display control device</td>
</tr>
<tr>
<td>X1</td>
<td>Control device for line 1</td>
</tr>
<tr>
<td>X2</td>
<td>Control device for line 2</td>
</tr>
<tr>
<td>X3</td>
<td>Control device for line 3</td>
</tr>
<tr>
<td>X0</td>
<td>Device for all lines stop</td>
</tr>
</tbody>
</table>

2) Settings of related objects

<table>
<thead>
<tr>
<th>Object type</th>
<th>Application</th>
<th>Settings</th>
</tr>
</thead>
</table>
| Lamp display function | Comment display, lamp function | <Action setup tab> 
[Word] ······Device: D10
  Display range: $V==0$, Lamp color: 182, Character: All lines stop
  Display range: $V==1$, Lamp color: 3, Character: Line 1 running
  Display range: $V==2$, Lamp color: 224, Character: Line 2 running
  Display range: $V==3$, Lamp color: 227, Character: Line 3 running
  Display range: $V==4$, Lamp color: 28, Character: Line 2 running
  Display range: $V==5$, Lamp color: 31, Character: Lines 1, 3 running
  Display range: $V==6$, Lamp color: 252, Character: Lines 2, 3 running
  Display range: $V==7$, Lamp color: 162, Character: Lines 1, 2, 3 running |
| Touch switch (bit) | For Line 1 control   | <Action setup tab> 
[Bit] ······Device: X1, Action setup: Alternate |
| Touch switch (bit) | For Line 2 control   | <Action setup tab> 
[Bit] ······Device: X2, Action setup: Alternate |
| Touch switch (bit) | For Line 3 control   | <Action setup tab> 
[Bit] ······Device: X3, Action setup: Alternate |
| Touch switch (bit) | For all lines stop   | <Action setup tab> 
[Bit] ······Device: X0, Action setup: Set |
### 3) Script settings (approximately 9k bytes)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger</td>
<td>Ordinary</td>
</tr>
<tr>
<td>Data format</td>
<td>16-bit signed BiN</td>
</tr>
</tbody>
</table>

```plaintext
if((b:X1)==OFF)&&(b:X2)==OFF)&&(b:X3]==OFF)) { // if lines 1, 2 and 3 are all OFF
    [w:D10]=0;  // stores 0 into D10
}

if((b:X1]==ON)&&(b:X2]==OFF)&&(b:X3]==OFF)){ // if line 1 is ON and lines 2 and 3 are OFF,
    [w:D10]=1; // stores 1 into D10
}

if((b:X1]==OFF)&&(b:X2]==ON)&&(b:X3]==OFF)){ // if line 2 is ON and lines 2 and 3 are OFF,
    [w:D10]=2; // stores 2 into D10
}

if((b:X1]==OFF)&&(b:X2]==OFF)&&(b:X3]==ON)){ // if line 3 is ON and lines 2 and 3 are OFF,
    [w:D10]=3; // stores 3 into D10
}

if((b:X1]==ON)&&(b:X2]==ON)&&(b:X3]==OFF)){ // if lines 1 and 2 are ON and lines 2 and 3 are OFF,
    [w:D10]=4; // stores 4 into D10
}

if((b:X1]==ON)&&(b:X2]==OFF)&&(b:X3]==ON)){ // if lines 1 and 3 are ON and lines 2 and 3 are OFF,
    [w:D10]=5; // stores 5 into D10
}

if((b:X1]==OFF)&&(b:X2]==ON)&&(b:X3]==ON)){ // if lines 2 and 3 are ON and line 1 is OFF,
    [w:D10]=6; // stores 6 into D10
}

if((b:X1]==ON)&&(b:X2]==ON)&&(b:X3]==ON)){ // if lines 1, 2 and 3 are ON,
    [w:D10]=7; // stores 7 into D10
}

if ([b:X0]==ON){ // if all lines stop turns ON,
    rst([b:X1]); // turns OFF line 1.
    rst([b:X2]); // turns OFF line 2.
    rst([b:X3]); // turns OFF line 3.
    rst([b:X0]); // turns OFF all lines stop.
}
```
(2) Automatic switching to restore action screen

(a) Required desired function

Touching the switch is required to save by displaying the detail display automatically when occurs any alarm.

In the current alarm list function, the detail display can not be shown unless touch input is performed with the one-touch operation or a touch switch.

(b) Specific example of using script function

An automatic switching to the suitable recovery instruments screen is performed when the devices GB70 to GB72 turn ON (when an error occurs) specified in the Alarm List (User Alarm) of Base Screen 1.

- When GB70 turns ON, the display screen is switched to Base Screen 112.
- When GB71 turns ON, the display screen is switched to Base Screen 223.
- When GB72 turns ON, the display screen is switched to Base Screen 347.

Point

- The Alarm display (User Alarm) specified in Base Screen 1 can not be confirmed since the screen switching is performed at the same time the alarm occurs.
- The bit device in question is automatically reset after the screen switching.
(c) Setting example

1) Devices to be used

<table>
<thead>
<tr>
<th>Device type</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>GD100</td>
<td>Device for base screen switching</td>
</tr>
<tr>
<td>GB70 ~ GB72</td>
<td>User alarm device</td>
</tr>
</tbody>
</table>

2) Settings of related objects

<table>
<thead>
<tr>
<th>Object type</th>
<th>Application</th>
<th>Settings</th>
</tr>
</thead>
</table>
| Alarm list function | For alarm display | <Basic setting tab>  
Alarm type: User alarm  
<Display setting tab>  
Device points: 3, Device: GB70 Continuous (from GB70 to GB73) |

3) Script settings (approximately 1k bytes)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Screen script (Base Screen 1)</td>
</tr>
<tr>
<td>Trigger</td>
<td>Ordinary</td>
</tr>
<tr>
<td>Data format</td>
<td>16-bit unsigned BIN</td>
</tr>
</tbody>
</table>
| Script description | if ( [b:GB70] == ON ) {  
|                  | [w:GD100] = 112;  
|                  | [b:GB70] = OFF;  
|                  | }  
|                  | if ( [b:GB71] == ON ) {  
|                  | [w:GD100] = 223;  
|                  | [b:GB71] = OFF;  
|                  | }  
|                  | if ( [b:GB72] == ON ) {  
|                  | [w:GD100] = 347;  
|                  | [b:GB72] = OFF;  
|                  | } // when alarm 1 occurs  
|                  | // Switches to Recovery instruments screen (Base Screen 112)  
|                  | // Alarm clear  
|                  | // when alarm 2 occurs  
|                  | // Switches to Recovery instruments screen (Base Screen 223)  
|                  | // Alarm clear  
|                  | // when alarm 3 occurs  
|                  | // Switches to Recovery instruments screen (Base Screen 347)  
|                  | // Alarm clear |
Appendix 3  Data transfer to GOT by memory card

It is possible to download the OS installation data and the screen data from a memory card to the GOT by writing the OS and project data to the memory card. Use of memory card to transfer data to GOT conveniently eliminates the necessity to carry the personal computer and cable when the project to multiple GOTs.

Appendix 3.1 Overall procedure

This section describes an overall procedures for data transfer to the GOT using a memory card.

1) PC → Memory card
   Various data (Boot OS, OS, project data, special data) installed in the personal computer is written into the memory card using GT Designer2.
   Refer to the GT Designer2 Version2 Basic Operation/Data Transfer Manual for details on writing data to the memory card.
2) Memory card → GOT

The data can be installed/downloaded into the GOT in either of the following two methods.

- How to install while the GOT is powered ON
  Refer to the GT Designer2 Version2 Basic Operation/Data Transfer Manual for the installation method.
- Installation by the utility (program/data control) function of the GOT

<table>
<thead>
<tr>
<th>Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precautions for data transfer</td>
</tr>
<tr>
<td>(1) Memory card</td>
</tr>
<tr>
<td>When downloading/installing the various types of data (Boot OS, OS, project data, special data) into a memory card, do not store any other data into that memory card. The other data is all erased at the time of download/installation. Storing the Boot OS data and the other data (OS, project data, and special data) in the same memory card should also be avoided.</td>
</tr>
<tr>
<td>(2) Data stored in GOT</td>
</tr>
<tr>
<td>When the Boot OS and OS are installed, the project data stored in the project folder in the GOT is deleted. When it is necessary to back up the project data, upload the data to the personal computer or memory card (CF Card) before installing the OS.</td>
</tr>
<tr>
<td>(3) Precautions for installing Boot OS and OS</td>
</tr>
<tr>
<td>Boot OS/OS installation cannot be interrupted. Note that the GOT may become non-functional if one of the following is performed during installation:</td>
</tr>
<tr>
<td>- Removing the CF card</td>
</tr>
<tr>
<td>- Powering off the GOT</td>
</tr>
<tr>
<td>- Pressing the reset button of the GOT</td>
</tr>
</tbody>
</table>
Appendix 4  Debug (GT Simulator2)

Appendix 4.1 GT Simulator2

GT Simulator2 is capable of debugging project data without using the GOT by simulating GOT operations on a personal computer. The following simulations are possible with GT Simulator2.

(1) Simulation with personal computer and PLC

Debugging the project data as if in the GOT main unit environment would be possible by simulating operations of the GOT on the personal computer.

(2) Simulation on personal computer alone

Simulation on a single personal computer would be possible by installing GX Simulator and GT Simulator2 on the same personal computer. Any creation or correction made to a screen on GT Designer2 is immediately available to debug on GT Simulator2, which leads to a great improvement in the designing efficiency.

Point

GT simulator2 have some unavailable functions and some restrictions by the PLC to be connected. Refer to the GT Simulator2 Version2 Operating Manual for details on restrictions and precautions in using GT Simulator2.
Appendix 4.2 Startup

This section describes the simulating procedures using a single personal computer by installing GX Simulator and GT Simulator.

1) Select [Start] - [All Programs] - [MELSOFT Application] - [GT Stimulator2].

2) GT Stimulator2 is started to display the GT Simulator2 Main Menu screen.

3) Select [GOT1000 Series GT15 simulator].

4) Click the Start button.

5) Select the [Simulate] - [Option] menu of GT Simulator2.
6) Click the [Action setup] tab.

7) Select "Fixed" in GX Developer Project to specify the project data (GPPW.GPJ) for GX Developer using [Browse...].

   PLC operations can be simulated by importing the project data of GX Developer into GT Simulator2.

8) Click the [Apply] button.

9) Click the [OK] button.

10) Select the [Project] - [Open] menu to specify the project data for GOT.
    Select the "JISSEN.GTE" file created in chapter 5 here.

11) Click the [Yes] button.

12) Simulation of the imported project data starts.
Appendix 4.3  Simulation Procedures

1) In the GT Simulator2, a touch operation is performed is through a click action. Click the **State** button here.

2) The base screen No.13 appears.

3) Click the **Start** button.
4) The temperature of cooling water increases.

5) To exit from GT Simulator2, click .

**Point**

**Changing device statuses**

In GT Simulator2, the device statuses (ON/OFF status of bit device, values of word devices) set for each object can be changed through the device monitor screen.

The following is an example of device monitor operation.

1) Click (device monitor) of GT Simulator2.
2) The device monitor screen appears.
   The status of an object on the screen being monitored at the moment is displayed.
   The status of a device can be changed by changing the selection of [Value].
Appendix 5  About Debug

This chapter describes the debug function used for troubleshooting and maintenance of the PLC system.

Appendix 5.1  Extended Function and Option OS

The Extended function or the Option OS is the function enabled by installing the option function board or the extended function OS/option OS in the GOT.

(1) Difference between Extended function and Option OS

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended function OS</td>
<td>Functions available by installing an Extended function OS (An option function board is not required.)</td>
</tr>
<tr>
<td>Option OS</td>
<td>Functions available by mounting an option function board or installing an option OS (Some option functions do not require an option OS.)</td>
</tr>
</tbody>
</table>

(2) List of extended/option functions

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System monitor</td>
<td>Functions to monitor or change the PLC CPU devices</td>
</tr>
<tr>
<td>Bar code</td>
<td>Functions to store the data read with a bar code reader connected to the GOT into the PLC in the ASCII data</td>
</tr>
<tr>
<td>Multi-color display</td>
<td>Functions capable of displaying 65536 colors</td>
</tr>
<tr>
<td>Recipe</td>
<td>Functions to store device values in the GOT and to use the data from the GOT to read or write to devices such as a PLC</td>
</tr>
<tr>
<td>Advanced recipe</td>
<td>Functions to display Chinese fonts in the GOT</td>
</tr>
<tr>
<td>Maintenance time notification</td>
<td>Functions to notify the maintenance time in two stages by automatically counting the energized time in the backlight</td>
</tr>
<tr>
<td>MELSEC-Q/QnA ladder monitor</td>
<td>Functions capable of monitoring sequence programs and searching devices and defects</td>
</tr>
<tr>
<td>MELSEC-A ladder monitor</td>
<td>Functions capable of monitoring sequence programs and searching devices and defects</td>
</tr>
<tr>
<td>MELSEC-FX ladder monitor</td>
<td>Functions capable of monitoring sequence programs and searching devices and defects</td>
</tr>
<tr>
<td>Gateway (Server, Client)</td>
<td>Functions that a single personal computer or GOT collects and monitors the data of PLC which is monitored by multiple GOTs</td>
</tr>
<tr>
<td>Gateway (Mail)</td>
<td>Functions that a single personal computer or GOT collects and monitors the data of PLC which is monitored by multiple GOTs</td>
</tr>
<tr>
<td>Gateway (FTP server)</td>
<td>Functions to monitor the network status of MELSECNET/H, MELSECNET/10, etc.</td>
</tr>
</tbody>
</table>
### Appendix 31

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intelligent module monitor function</td>
<td>Function to monitor and change the data of intelligent function module buffer memory using a dedicated screen</td>
</tr>
<tr>
<td>List editor for MELSEC-A</td>
<td>Function for displaying/editing sequence program read out from ACPU in the list mode</td>
</tr>
<tr>
<td>List editor for MELSEC-FX</td>
<td>Function to display/edit the sequence program read out from the FXCPU in the list mode</td>
</tr>
<tr>
<td>Servo Amplifier Monitor Function</td>
<td>Function to monitor the servo amplifier and also to change parameters, execute test run, etc.</td>
</tr>
<tr>
<td>Q Motion Monitor Function</td>
<td>Function to execute servo monitor and parameter setting for motion controller CPU (Q series)</td>
</tr>
<tr>
<td>CNC Monitor Function</td>
<td>Function to monitor position display, alarm diagnosis and program and to check tool offset data at the same level as with the dedicated MELDAS display unit</td>
</tr>
<tr>
<td>Multi-channel function *</td>
<td>Function to monitor multiple controllers with a single unit of GOT</td>
</tr>
</tbody>
</table>

* Installation of an option OS is not required.

(3) **Installation of Extended function/Option OS**

This section explains how to install an Extended function OS/Option OS. In this section, a ladder monitor and a system monitor, which are required to do exercises provided in sections 6.3 and 6.4, will be installed.

1. Click on the [Communication] - [To/From GOT…] menu.

2. When the dialog box appears, click the [OS Install -> GOT] tab.

3. Check [Extended function OS] - [System monitor].


5. Click the [Install] button.
Add the following Base Screen No. 21 to the screen created in chapter 5.

**Base Screen No. 21**

- **Bit lamp**
  - Turns on during line operation (M33)

- **Numerical display**
  - Displays the operation time of line in seconds.
  - (D30,D31,D32,D33,D34)

- **Bit lamp**
  - Lit if the operating display exceeds 8 hours (M34).

- **Touch switch**
  - Operation/stop switch (M31) to activate the line

- **Screen switching switch**
  - Return to Base screen No. 1

**[Operation of Base Screen No. 21]**

1) When the **Ready** switch and the **Operation/Stop** switch turn ON, the operation will start, and the lamp will be lit.

2) As the operation gets started, the operating time starts counting. When the operation time is over 8 hours, the lamp turns ON.

(1) Screen creation training

(a) Creating and setting Base Screen No. 3

1) Create a base screen as follows:

   - **Screen number:** 3
   - **Title:** Operating time display

   ![Screen Property](image)

   (Next page)
2) Place the numerical display, and make the settings as follows:
   [Basic tab]
   Device: D30
   Number of display digits: 1
   Size: 2×2

3) Copy and paste the numerical display created in 2), and make the settings as follows:
   (1) Device setting "D31"
   (2) Device setting "D32"
   (3) Device setting "D33"
   (4) Device setting "D34"

4) Create characters with text.

5) Create a display lamp with the following settings using the same procedure for creating a lamp display in section 5.4.
   [Basic tab]
   Device: M33
   Figure: Circle: Circle_3
   Lamp color (when it is ON): red
   [Text/Lamp tab]
   Display position: Bottom
   Text: Operating
   Copy OFF → ON (All Settings)

6) Copy and paste the lamp created in 5), and make the settings as follows:
   [Basic tab]
   Device: M34
   [Text/Lamp tab]
   Text: 8 hours have elapsed.
   Copy OFF → ON (All Settings)
7) Copy and paste the touch switch created in section 5.22.4, change the width size, and make the settings as follows:
- **[Basic tab]**
  - Device: M31
  - Operation: Alternate
  - Switch color (when it is ON): red
- **[Text/Lamp tab]**
  - Text: Preparation
  - Copy OFF → ON
  - Lamp function: Bit, M30

8) Copy and paste the switch created in 7), and change the settings as follows:
- **[Basic tab]**
  - Device: M35
- **[Text/Lamp tab]**
  - Text: Operation/Stop
  - Copy OFF → ON
  - Lamp function: Bit, M35

9) Copy and paste the Go To Screen Switch (control screen) of Base Screen No. 2.

(b) Setting Base Screen No.1

1) Copy the Go To Screen Switch (alarm) of Base Screen No. 1, and change the settings as follows:
- **[Basic tab]**
  - Switching Screen: Fixed screen 3
- **[Text/Lamp tab]**
  - Text: 8Hr RUN
  - Copy OFF → ON

(2) Project download
Display the download screen of the project, and download all the data to the GOT. Reset the PLC CPU using the RESET key switch, and then switch to RUN.
Appendix 5.3 Ladder monitor function

(1) About the ladder monitor function
(a) Features
This is the function to monitor PLC CPU programs in the ladder diagram format.
Switching the display format (decimal number/hexadecimal number) or displaying the device comment (comment written to the PLC CPU) is possible.
It is also possible to search for a contact causing a malfunction, which may lead to a reduction of factor analysis time.

Display screen for ladder monitor function

(b) Functions available with QCPU ladder monitor

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dev. Sea.</td>
<td>Displays a ladder block containing the specified device.</td>
</tr>
<tr>
<td>Cont. Sea.</td>
<td>Displays a ladder block containing the specified contact.</td>
</tr>
<tr>
<td>Coil. Sea.</td>
<td>Displays a ladder block containing the specified coil.</td>
</tr>
<tr>
<td>Step. Sea.</td>
<td>Displays a ladder block with the specified step number.</td>
</tr>
<tr>
<td>End. Sea.</td>
<td>Displays the last ladder block of sequence program.</td>
</tr>
<tr>
<td>Defect search</td>
<td>Searches the ladder for conductive/non-conductive status of the contact point that turned on or off the coil on the ladder.</td>
</tr>
<tr>
<td>Touch search</td>
<td>Searches for coils of the same device when the contact shown on the screen of ladder monitor function is touched, and for contacts of the same device when the coil is touched.</td>
</tr>
<tr>
<td>Display switching</td>
<td>Changes displays of decimal number, and hexadecimal number for word device, and displays of device comment.</td>
</tr>
<tr>
<td>Test operation</td>
<td>Changes device values, etc.</td>
</tr>
<tr>
<td>Hard copy</td>
<td>Saves screens of ladders in the BMP or JPEG format.</td>
</tr>
</tbody>
</table>
(c) Hardware and OS required for ladder monitor

The following hardware and OS are required to use the ladder monitor.

<table>
<thead>
<tr>
<th>Required option function board</th>
<th>Extended function /Option OS</th>
<th>Capacity for user area (calculated value for data capacity)</th>
</tr>
</thead>
<tbody>
<tr>
<td>One of the followings:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GT15- QFNB</td>
<td>MELSEC-Q/QnA</td>
<td>1082k bytes</td>
</tr>
<tr>
<td>GT15- QFNB16M</td>
<td>Ladder monitor for MELSEC-Q/QnA (Option OS)</td>
<td></td>
</tr>
<tr>
<td>GT15- QFNB32M</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GT15- QFNB48M</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix 5.4  Operation check (1)

Perform the following operation checks for screen No.3 created in section 6.2.

(1) Test
Perform the following tests in screen No. 3.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch operation</td>
<td>Touch Ready, and then touch Operation/Stop.</td>
<td>(Under normal conditions) The Operating lamp turns ON, and the operating time starts counting. ↓ (Current operations) The Operating lamp does not turn ON, and the operating time does not start counting.</td>
</tr>
</tbody>
</table>

Screen No. 3 is not working properly.
A cause of the error will be determined using the ladder monitor.
(1) Method for starting the ladder monitor function

Utility call keys
Simultaneous 2-point touch

1) Touch the upper left and upper right corners on the GOT monitor screen at the same time.

2) When the utility is displayed, touch [Main Menu] → [Debug & self check].

3) Touch [Debug].

(Next page)
4) Touch [Ladder monitor].

5) Touch NO when the screen as shown left appears.

Otherwise, go to step 7).

6) Touch YES when the screen as shown left appears.

(Next page)
7) The channel setting window appears.
   (1) Displays the names of communication drivers installed in the GOT.
   (2) The channel No. is fixed to "1".

8) Touch [ ] to move the cursor to network No. [   ].

9) Set the network No. to [0].

10) Set the station No. to [FF], and touch the Enter key.

11) Set the CPU No. to [0], and touch the Enter key.

   DEL key : Used to delete a character of the entered information.

   AC key : Used to delete all characters indicated by the cursor.

12) Touch the Drive key when the screen as shown left appears.
13) When the drive selection window appears, enter [0] in the drive (applicable memory) and touch the Enter key.

14) As a list of files in the program memory appears, select the ladder to be read using the down/up arrow keys (↑, ↓).

15) Touch the SEL key.

16) Touch the READ key.

17) The reading of the sequence program is completed.

18) Touch the Ladder key.

(Next page)
19) The sequence program is displayed, and the ladder monitor function becomes available.

(2) Method for factor search operation

The factor search function searches the ladder for the conductive/non-conductive status of the contact point that turned on or off the coil when monitoring the ladder is monitored.

This section explains the operation procedures.

1) Touch the Mon key.

2) Touch the Menu key.
3) When the Menu window appears, touch the Xref key.

4) Touch the M key for the device name to select it, and touch ▶ to move the cursor.

5) Set the device number to "33".

6) Touch the Enter key.

7) A search for the device begins, and the research result is displayed.

To cancel a factor search, touch the Esc key. During a factor search, all key operations except Esc and Exit keys are invalid.

<Factor search Result>
The reason why M33 does not turn ON is that M32 is not ON.
(3) raining screen modification
Check the settings of touch switch (Operation/Stop) that turns on M31.

1) Check the settings of touch switch (Operation/Stop) for Base Screen No.3. M35 was mistakenly assigned, instead of M32, for the device to be turned ON.

2) Change the settings of the Operation/Stop switch as follows:

   [Basic tab]
   Device: M35 → M32
   [Text/Lamp tab]
   Lamp: Bit, M35 → M32
   Copy OFF → ON

Appendix 5.5 Operation check (2)

Display the download screen of the project, and download all the data to the GOT. Reset the PLC CPU using the RESET key switch, and then switch to RUN.

(a) Test
   Perform the following tests in screen No. 3.

<table>
<thead>
<tr>
<th>Item</th>
<th>Test object</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Touch operation</td>
<td>Touch Ready, and then touch Operation/Stop.</td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td>Screen state</td>
<td>The Operating lamp turns ON, and the operating time starts counting.</td>
</tr>
<tr>
<td>2) Touch operation</td>
<td>Touch Operation/Stop.</td>
<td></td>
</tr>
<tr>
<td>Result of operation</td>
<td>Screen state</td>
<td>The Operating lamp turns OFF, and the operating time stops.</td>
</tr>
</tbody>
</table>

Check the Operating lamp turns ON, and that the operating time counts up. The correction of drawing data is completed.

↓
↓

Set the Ready switch OFF to perform the operation check in section 6.4.1.
Appendix 5.6 System monitor function

(1) About the system monitor function

(a) Features

This function is able to monitor and test the devices of the PLC CPU, and the buffer memory of intelligent function modules.

(b) Monitoring method available with system monitor function

<table>
<thead>
<tr>
<th>Monitoring method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device monitor</td>
<td>The device monitor is a function to register devices to be monitored in advance and monitor only register devices.</td>
</tr>
<tr>
<td>Batch monitor</td>
<td>The batch monitor function monitors up to 16 PLC CPUs from the device number specified by the user in a single window.</td>
</tr>
<tr>
<td>T/C monitor</td>
<td>The TC monitor function monitors the present value, set value, contact point, and coil of up to 8 PLC CPU timers (T)/counters (C) from the device number specified by the user in a single window.</td>
</tr>
<tr>
<td>Buffer memory monitor</td>
<td>The BM monitor function monitors up to 16 devices from the initial device number in the buffer memory of the intelligent function module specified by the user in a single window.</td>
</tr>
</tbody>
</table>

(c) Test operations

With the system monitor function, the following data changes are possible by performing test operations.

- Testing a bit device
  A device specified by the user is turned ON and OFF.

- Testing a word device
  A specified value is written to a device specified by the user. (Real number data is not allowed.)

- Testing a timer/counter
  Specified values are written as the present and set values of a device specified by the user.

- Testing buffer memory
  A specified value is written to buffer memory specified by the user.

Test menu screen
(d) Hardware and OS required for system monitor function

The following hardware and OS are required to use the system monitor.

<table>
<thead>
<tr>
<th>Required option function board</th>
<th>Extended function / option OS</th>
<th>Capacity for user area (calculated value for data capacity)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>System monitor (extended function)</td>
<td>746k bytes</td>
</tr>
</tbody>
</table>

(2) Method for starting the system monitor

1) Touch the upper left and upper right corners on monitor screen of the GOT main unit at the same time.

2) When the utility is displayed, touch [Main Menu] - [Debug & self check].

3) Touch [Debug].

(Next page)
4) Touch [System monitor].

5) When the channel setting window appears, touch the "1" key.

6) The functional change menu of system monitor is displayed.
Appendix 5.7  Operation check (device monitor operation)

In this section, the following operation checks are performed regarding the training screen created in section 6.2 using the device monitor of the system monitor function.

Numerical display
Displays the operation time of line in seconds.

Bit lamp
Lit if the operating display exceeds 8 hours. (M34)

(1) Device registration procedure for device monitor

1) Display the functional change menu using the procedure described in section 6.4.2.

2) Touch the DEV MON key.

3) Touch the SET key when the screen as shown left appears.

The registered devices are displayed when there are devices already registered.
4) Touch the ENTRY key.

5) When the device registration screen appears, touch the ▶ key, move the cursor to the device name, and touch "D".

6) Touch the ▶ key, and move the cursor to the device number.

7) Set the device number to "30".

8) Touch the Enter key.

9) Register the device.
10) When registration is complete, return to the device registration screen.

11) Touch the AC key to clear the device value.

12) Set the device number to "30" and touch the Enter key to register the device.

13) Repeat the procedures for devices "D32", "D33", and "D34".

14) When registration is complete, touch x to exit the device registration screen.

15) Go back to the device monitor screen, and the monitor just registered is being monitored.
(2) Operation procedure for test operation

1) Touch the SET key on the device monitor screen.

2) Touch the TEST key.

3) When the Test menu screen appears, touch the VALUE 16 key.

4) When the setting key window appears, make the settings as follows and touch the Enter key.

Device name: "D"
Device number: "30"
Value: "0"
5) Touch the \(<\) key and move the cursor to the device number.

6) Make the settings as follows and touch the \(\text{Enter}\) key.

Device name: "D"
Device number: "31"
Value: "5"

7) Repeat the procedures, and, set the value of "D32" to "9", set the value of "D33" to "5", and set the value of "D34" to "7".

8) When setting is complete, touch \(\times\) to exit the setting key window.

9) When the Test menu screen appears, touch the \(\text{CANCEL}\) key.

10) Go back to the device monitor screen, check that the value just entered is properly displayed, and touch the \(\text{MENU}\) key.
11) Touch the **END** key.

12) When the Main menu screen appears, touch ✕
Appendix 54

(3) Operation check

1) Display Base screen No. 3.

2) Check that the operating time indicates 7:59:50.

3) Touch the Preparation switch, and then touch the Operation/Stop switch to start counting the operating time.

4) When the operating time exceeds 8 hours, check if the lamp turns ON.
Appendix 5.8  Training sequence program

Operating time display

- M30: Preparation
- M31: Run/Stop
- M32: Operating

- K10
- D30: 1 s
- D31: 10 s
- D32: 1 min
- D33: 10 min
- D34: 1 hour

- X8: 1 hour
Appendix 6  Installation of USB Driver

A USB driver must be installed to support the USB communications between the personal computer and the GOT. The following describes the procedures to install the USB driver when using the Windows® XP. (The Administrator authority is required for installation using the Windows® XP or Windows® 2000.)

1) The screen shown on the left appears when the PC and the GOT are connected through a USB cable for the first time. Select "Install the software automatically (Recommended)", and click the Next button.

2) As the warning screen shown on the left appears, click the Continue Anyway button to go on with the installation. (Operation check was performed at Mitsubishi to see there is no problem related to this warning.)

3) When the screen shown on the left appears, the installation is completed. Click the Finish button to complete the installation.
## Appendix 7 Specifications of Available Object Functions

This section provides a list of specifications for object functions. The following table lists the specifications of each object. Refer to the corresponding section of the relevant object for details on specifications and precautions. Note that max. number of setting objects and memory capacity in the table are based on default value settings. When the memory capacity is increased by data operation, display methods and other settings, the number of objects may be reduced.

<table>
<thead>
<tr>
<th>Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Max number of available objects. Up to 1024 objects can be set in one screen. While up to 1024 input objects can be displayed, the settings for objects with greater number than 1001 will be ineffective. (The object will not operate.)</td>
</tr>
<tr>
<td>(2) Max number of objects in which [Trigger] has been set to [Sampling]. Up to 100 objects can be set in one screen. Objects with greater number than 101 will be ineffective. (The object will not operate.)</td>
</tr>
<tr>
<td>(3) Object functions applied only to GT15 (not listed in the table) Settings for station number switching, comment group, advanced alarm, and hard copy are only supported for GT15.</td>
</tr>
</tbody>
</table>
(1) Specifications for each object type
(a) Numeric value, character display

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen</th>
<th>Memory capacity applicable for one object (byte)</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Numerical display</strong></td>
<td>1000 points</td>
<td>24 bytes</td>
<td>Shape</td>
<td>Frame</td>
<td>Plate Color</td>
<td>Color</td>
<td>Blink Reverse Font Layer</td>
</tr>
<tr>
<td><strong>Numerical Input</strong></td>
<td>1000 points</td>
<td>32 bytes</td>
<td>Shape</td>
<td>Frame</td>
<td>Plate Color</td>
<td>Color</td>
<td>Blink Reverse Font Layer</td>
</tr>
<tr>
<td><strong>Data List Display</strong></td>
<td>1 point</td>
<td></td>
<td>Shape</td>
<td>Frame</td>
<td>Plate Color</td>
<td>Color</td>
<td>Text Color Reverse Font Layer</td>
</tr>
<tr>
<td><strong>ASCII Display</strong></td>
<td>1000 points</td>
<td>8 + Number of characters</td>
<td>Shape</td>
<td>Frame</td>
<td>Plate Color</td>
<td>Text Color</td>
<td>Blink Reverse Font Layer</td>
</tr>
<tr>
<td><strong>ASCII Input</strong></td>
<td>1000 points</td>
<td>8 + Number of characters</td>
<td>Shape</td>
<td>Frame</td>
<td>Plate Color</td>
<td>Text Color</td>
<td>Blink Reverse Font Layer</td>
</tr>
<tr>
<td><strong>Clock Display</strong></td>
<td>2 points</td>
<td>8 bytes</td>
<td>Shape</td>
<td>Frame</td>
<td>Plate Color</td>
<td>Display Color</td>
<td>Font Layer</td>
</tr>
<tr>
<td><strong>Comment display</strong></td>
<td>100 points</td>
<td>32 bytes</td>
<td>Shape</td>
<td>Frame</td>
<td>Display Size</td>
<td>Blink Reverse Font Layer</td>
<td></td>
</tr>
<tr>
<td><strong>Comment Group</strong></td>
<td></td>
<td></td>
<td>Text Style</td>
<td>Text Color</td>
<td></td>
<td></td>
<td>Blink Blink HQ Font KANJI Region</td>
</tr>
<tr>
<td><strong>Basic Comment</strong></td>
<td></td>
<td></td>
<td>Text Style</td>
<td>Text Color</td>
<td>Solid Reverse</td>
<td></td>
<td>Blink Blink HQ Font</td>
</tr>
</tbody>
</table>
1) Memory capacity for data list display function
   \[ 110 + (4 \times (D_N+R_N)) + (2 \times L_N) + (12 \times C_N) + T_N \]
   \(D_N\): Number of devices
   \(R_N\): Number of labels (with labels)
   \(L_N\): Number of lines (with comments)
   \(C_N\): Number of column items
   \(T_N\): Number of title strings

2) Memory capacity for comment group
   \[ 46 + (2 \times N_T) + (4 \times N_C) + (8 \times N_R) + \{N_C \times N_R \times (6 + 2 \times N_S) \} \]
   \(N_T\): Number of characters, \(N_C\): Number of rows, \(N_R\): Number of columns, \(N_S\): Average number of characters of a comment

3) Memory capacity for basic comment
   \[ 24 + (14 \times R_C) + (2 \times A_T) \]
   (The value within ( ) will be converted into multiple of 4)
   \(R_C\): Number of registered comments, \(A_T\): Number of whole characters
### (b) Alarm

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen</th>
<th>Memory capacity applicable for one object (byte)</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm List (System Alarm)</td>
<td>1 point</td>
<td>52 bytes</td>
<td>Shape</td>
<td>Frame</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Plate Color</td>
<td>Display Size</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Layer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm List (User Alarm)</td>
<td>24 points *1</td>
<td></td>
<td>Shape</td>
<td>Frame</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Plate Color</td>
<td>Display Size</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Layer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm History Display</td>
<td>1 point</td>
<td></td>
<td>Shape</td>
<td>Frame</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Plate Color</td>
<td>Color</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Layer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm (System Alarm)</td>
<td>1 point</td>
<td></td>
<td>Shape</td>
<td>Frame</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Plate Color</td>
<td>Color</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Font</td>
<td>Cursor</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Layer</td>
<td>KANJI Region</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Text Color</td>
<td>Text Style</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Display Size</td>
<td>Solid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm (User Alarm)</td>
<td>1 point</td>
<td></td>
<td>Shape</td>
<td>Frame</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Plate Color</td>
<td>Color</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Font</td>
<td>Cursor</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Layer</td>
<td>KANJI Region</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Text Color</td>
<td>Text Style</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Display Size</td>
<td>Solid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm Popup Display (System Alarm)</td>
<td>1 point</td>
<td></td>
<td>Display Size</td>
<td>Display Background</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Font</td>
<td>Text Style</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm Popup Display (User Alarm)</td>
<td>1 point</td>
<td></td>
<td>Display Size</td>
<td>Display Background</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Font</td>
<td>Text Style</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 Up to 16 objects with [Store Memory] settings can be set.

*2 Objects with [Store Memory] settings is unusable.
1) Memory capacity for alarm list display (user alarm display)
   \[196 + (24 \times DN)\]
   DN: Number of alarm device points

2) Memory capacity for alarm history display
   \[62 + N_1 + N_2 + N_3 + N_4\]
   \(N_1\): (Number of the following title characters) \(\times 2\) \(^{*1}\)
   - OCCURRED
   - MESSAGE
   - REST
   - CHECK
   - CUMULATE
   - COUNT
   \(N_2\): (Number of the following characters) \(\times 2\) \(^{*1}\)
   - Occurred Date/Time
   - Restored Date/Time
   - Checks Date/Time
   \(N_3\): "4" should be added for each of the following setting items
   - Text Sprite
   - Draw Ruled Line
   - Restored Time
   - Confirm Time
   - One Touch
   \(N_4\): "16" should be added for each of the following setting items
   - Shape

3) Memory capacity of advanced alarms (system alarms/user alarms)
   It depends on the setting of text color.

   (a) In the case of displaying in fixed color
   \[200 + (16 \times ON)\]
   (b) In the case of using different display colors for levels and groups
   \[1200 + (16 \times ON)\]
   ON: Number of objects

4) Memory capacity of advanced alarm popup display (system alarms/user alarms)
   It depends on the setting of text color.

   (a) In the case of using fixed color or text color of comment group
   \[100\]
   (b) In the case of using different display colors for levels and groups
   \[1180\]

\(^{*1}\): Notes for calculation of \(N_1\) and \(N_2\)

(1) Calculated value
   Round the calculated value to a multiple of "4".
   Example: If the calculated value is "10", use "12" for calculation.

(2) Calculation procedure
   Calculate each item.
   Example: Occurrence time field: four characters
   Message field: five characters
   \[\text{[Occurred]} \ 4 \times 2 = 8\]
   \[\text{[Message]} \ 5 \times 2 = 10 \rightarrow 12 \text{ (round to a multiple of)}\]
   Therefore, \(N_1 = 8 + 12 = 20\)
### Animation

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parts Display</td>
<td>1000 points</td>
<td>Display Mode</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Positioning Point</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Point</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blink</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Layer</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td>Parts movement display</td>
<td>1000 points</td>
<td>Movement Type</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display Mode</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Positioning Point</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Point</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blink</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Layer</td>
<td>○○○○○○○○○○</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td>Lamp display</td>
<td>1000 points</td>
<td>Shape</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lamp</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fill Pattern</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Font</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display Size</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>KANJI Region</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Layer</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td>Panelmeter display</td>
<td>1000 points</td>
<td>Shape</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plate Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Needle Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Meter Panel Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display Size</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Font</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Scale Points</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td>Level display</td>
<td>1000 points</td>
<td>Boundary Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Level Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fill Pattern</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Background</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Layer</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td>Trend Graph display</td>
<td>24 points *1</td>
<td>Shape</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plate Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Scale Points</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Graph Color</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Line Style</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Line Width</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Font</td>
<td>○××××××××</td>
<td></td>
<td>○○○○○○○○○○</td>
<td>—</td>
</tr>
</tbody>
</table>

*1 Refer to (1) below

Appendix 62
<table>
<thead>
<tr>
<th>Function</th>
<th>Display attribute</th>
<th>Memory capacity applicable for one object (byte)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Graph display</td>
<td>Shape Frame Plate Color Scale Points Scale Points Graph Color Line Style Line Width Font Layer</td>
<td>32*2</td>
</tr>
<tr>
<td>Bar Graph display</td>
<td>Shape Frame Plate Color Graph Color Scale Points Scale Color Fill Pattern Background Font Layer</td>
<td>1000 points</td>
</tr>
<tr>
<td>Statistical Graph display</td>
<td>Shape Frame Plate Color Division Number Direction Scale Points Scale Points Graph Color Fill Pattern Background Font Layer</td>
<td>32 points</td>
</tr>
<tr>
<td>Scatter Graph display</td>
<td>Shape Frame Plate Color Display Mode Graph frame display Graph display format Fill Pattern Background</td>
<td>24 points</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordinary</td>
<td>Scrolling</td>
<td>Monitor</td>
<td>Bit trigger</td>
</tr>
</tbody>
</table>

1) Memory capacity for trend graph and statistics graph
\[ 100 + \{4 \times (\text{LN} + \text{MN})\} \]

2) Memory capacity for line graph
\[ 116 + (4 \times \text{LN}) + (8 \times \text{MN}) \]

3) Memory capacity for bar graph
\[ 132 + \{4 \times (\text{LN} + \text{MN})\} \]

4) Memory capacity for scatter graph
\[ 128 + \{4 \times \text{SN} \times (\text{PN} + 1)\} \]

LN: Number of graphs  MN: Number of monitored points  SN: Number of saved graphs  PN: Number of points

*1 Up to 16 objects with [Store Memory] settings can be set.
*2 Only one object with [Locus mode] settings can be set to one project.
*3 Objects with [Store Memory] settings is unusable.
*4 Objects with [Locus] settings is unusable.
(d) Touch Switch

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch Switch</td>
<td>1000 points *1,2</td>
<td>Shape, Switch, Background, Text Color, Text</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>48 bytes</td>
<td>Frame, Fill Pattern, Text Style, Solid</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display Size, Layer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 Up to 10 touch switches with its max. number of times for operation set can be set in one screen.
*2 Up to 100 touch switches with [ON/OFF delay] settings can be set.

(e) Trigger—Action

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Observation</td>
<td>512 points *1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Refer to (1) below</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 The maximum number of setting objects in one project is 512 points.

1) Memory capacity for status observation function

\[ 64 + (36 \times TS) + (16 \times (AI + AW)) + (20 \times WT) \]

TS: Number of condition settings
AI: Number of indirect devices and alternate devices for all conditions
AW: Total number of write devices for all conditions
WT: Number of conditions within a range of words

Appendix 64
### (f) Recipe

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Memory capacity applicable for one object (byte)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Recipe</strong></td>
<td>256 points</td>
<td>—</td>
<td>××××××</td>
<td>×</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Refer to (1) below</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Advanced recipe</strong></td>
<td>2048 points</td>
<td>—</td>
<td>××××××</td>
<td>×</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Refer to (2) below</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) Memory capacity for recipe function
   When stored in built-in memory: \(8 + (8 \times RD) + (44 \times RF)\)
   RD: Total number of devices in each recipe file
   RF: Number of recipe files
   When stored on a memory card: Refer to (2) of this section.

2) Memory capacity for advanced recipe function
   Capacity for advanced recipe setting stored in built-in flash memory:
   \(76 + N1 + N2 + N3 + N4\)
   \(N1: 84 + 2 \times Nrnm\)
   \(N2: 12 \times (Nir + Niw)\)
   \(N3: (8 + 2 \times Ndcmt) + 2 \times Nrecv \times Ndev\)
   \(N4: 28 \times Ndlk + 76 \times Nrec\)
   For N1 to N4, calculate for each advanced recipe setting.
   Nrnm: Number of characters*1 of [Recipe Name]
   Nir: Points of [Read Trigger]
   Niw: Points of [Write Trigger]
   Ndcmt: Number of characters*1 of [Device Comment]
   Nrecv: Number of record (only for the record whose attribute has recipe device value)
   Ndev: Number of devices
   Nblk: Number of blocks
   Nrec: Number of records

*1 Single/double byte characters are not distinguished.
When stored on a memory card: Refer to (2) of this section.
### Auxiliary

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen (objects in one project)</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Overlay Screen</td>
<td>GT15: 2047 points GT11: 5 points 80 + depending on objects (bytes)</td>
<td>—</td>
<td>x x x x x x x x x x</td>
<td>x x o o x</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>—</td>
<td>—</td>
<td>x x x x x x x x</td>
<td>x x x</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Ladder Monitor</td>
<td>—</td>
<td>—</td>
<td>x x x x x x x x</td>
<td>x x x x x x x</td>
<td>Option function board</td>
<td></td>
</tr>
<tr>
<td>System Monitor</td>
<td>—</td>
<td>—</td>
<td>x x x x x x x x</td>
<td>x x x x x x x</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>A List Editor</td>
<td>—</td>
<td>—</td>
<td>x x x x x x x x</td>
<td>x x x x x x x</td>
<td>Option function board</td>
<td></td>
</tr>
<tr>
<td>Gateway</td>
<td>Server/client function: 1 Mail send function: 1</td>
<td>—</td>
<td>x x x x x x x x x x</td>
<td>x x x x</td>
<td>Option function board</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td>256 points *2 Refer to (1) below</td>
<td>—</td>
<td>o o o o o o o o o</td>
<td>o o o o o</td>
<td>—</td>
<td></td>
</tr>
</tbody>
</table>

*1 The maximum number of setting objects in one project is 256 points.

Appendix 66
1) Memory capacity for script function (the capacity for script function set in each window will be 0 if the window screen is not displayed).

\[
\{36 \times (1 + BC + WC1 + WC2 + SC1 + SC2)\} + \{40 \times (PS + BS + WS1 + WS2 + SS1 + SS2)\}
\]

BC: Specified number of on-screen base screens
WC1: Specified number of on-screen window 1 screens
WC2: Specified number of on-screen window 2 screens
SC1: Specified number of on-screen superimpose window 1 screens
SC2: Specified number of on-screen superimpose window 2 screens
PS: Specified number of project scripts
BS: Specified number of on-screen base screen scripts
WS1: Specified number of on-screen window 1 screen scripts
WS2: Specified number of on-screen window 2 screen scripts
SS1: Specified number of on-screen superimpose window 1 screen scripts
SS2: Specified number of on-screen superimpose window 2 screen scripts

(h) External I/O

<table>
<thead>
<tr>
<th>Function</th>
<th>Max. No. of setting objects in one screen</th>
<th>Display attribute</th>
<th>Display/Operating Condition</th>
<th>Device</th>
<th>Others</th>
<th>Hardware restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Copy</td>
<td>1 point</td>
<td>Ord/Dis</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>204 bytes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bar Code</td>
<td>1 point</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Appendix 67
(2) Data capacity available for storage on memory card.
(a) Data capacity available for storage on memory card
Some objects have a function that allows storing data into a memory card.
The data capacity available for a memory card is shown as follows.

<table>
<thead>
<tr>
<th>Object name</th>
<th>Data capacity</th>
</tr>
</thead>
</table>
| Alarm history function | When saving 3072 alarm historical data
  Cumulative mode (when saved in CSV format): Approx. 97 K bytes (Approx. 400 K bytes)
  History mode (when saved in CSV format): Approx. 72 K bytes (Approx. 360 K bytes) |

<table>
<thead>
<tr>
<th>Hard copy function</th>
<th>Data capacity per screen (The following are reference values.) × Number of screens to be stored</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>![Data capacity per screen table]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recipe function (byte)</th>
<th>(149 × RF) + (9 × R16) + (14 × R32)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RF: Number of recipe files</td>
</tr>
<tr>
<td></td>
<td>R16: Total number of 16-bit devices in each recipe file</td>
</tr>
<tr>
<td></td>
<td>R32: Total number of 32-bit devices in each recipe file</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Advanced recipe function (byte)</th>
<th>G1P file size: 128 + N1 + N2 + N3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>N1: (8 + 2 × Ndcmt) × Ndev</td>
</tr>
<tr>
<td></td>
<td>N2: Nblk × 12</td>
</tr>
<tr>
<td></td>
<td>N3: (80 + Ndev × 2) × Nrec</td>
</tr>
<tr>
<td></td>
<td>CSV file size: 164 + N1 + N2 + N3</td>
</tr>
<tr>
<td></td>
<td>N1: Nrmm</td>
</tr>
<tr>
<td></td>
<td>N2: (Nbit + Nwrd + Ndwr) × (18 + Ndcmt)</td>
</tr>
<tr>
<td></td>
<td>N3: Nrec × (25 + Nbit × 2 + Nwrd × 7 + Ndwr × 2)</td>
</tr>
<tr>
<td></td>
<td>Unicode text file size: CSV file size above × 2</td>
</tr>
<tr>
<td></td>
<td>Nrmm: Number of characters*1 of [Recipe Name]</td>
</tr>
<tr>
<td></td>
<td>Ndcmt: Number of characters*1 of [Device Comment]</td>
</tr>
<tr>
<td></td>
<td>Ndev: Number of devices</td>
</tr>
<tr>
<td></td>
<td>Nblk: Number of blocks</td>
</tr>
<tr>
<td></td>
<td>Nrec: Number of records</td>
</tr>
<tr>
<td></td>
<td>Nbit: Number of 16-bit device points</td>
</tr>
<tr>
<td></td>
<td>Nwrd: Number of 16-bit device points</td>
</tr>
<tr>
<td></td>
<td>Ndwr: Number of 32-bit device points</td>
</tr>
</tbody>
</table>

*1 Single/double byte characters are not distinguished.
Appendix 8  Glossary

This glossary explains the terms used in this document.
All entries are in alphabetical order

A  Access key
   A key used instead of selecting menu items for GT Designer2 or other applications
   The underlined letter in a menu item shows its access key.

Address
   A position in memory
   The PLC has various devices, including data registers (D) and internal memory (M). The
   positions in these memories are called addresses.
   Addresses are expressed in decimal or hexadecimal format.
   Hexadecimal format: X, Y, B, W
   Decimal format: All addresses other than the above

ALT (alternate)
   Operation name for GT Designer2 touch switches
   When a touch switch on the screen is touched, the current status of the bit device is toggled
   between ON and OFF.

Arrange
   The figures and objects in the selected area are aligned with the specified method.
   Besides up/down/left/right and center, there is also top justified or left justified alignment.
   With top justified alignment, all the figures including the most upper left and the most right
   bottom figures in the alignment area are justified. This is useful for uniform-interval layout of
   numbers in tables and other objects is.

ASCII display
   ASCII code is a standard American code system. Many computer systems use ASCII codes
   to express information.
   With a GOT, character string data (for example, ABC) is input and displayed.
   Character string data can be written to buffer memory in special function module and word
   devices.

Attribute (change)
   The polyline/fill pattern/text status are called attributes. Changing the status of an attribute is
   called attribute change.
   • Polyline: Line style/line width/color
   • Pattern: Line style/color
   • Text: Font, vertical magnification ratio/horizontal magnification ratio/direction/style/
     background color/color
Backlight
This is a fluorescent lamp that shines light from the rear of an LCD in order to display with the LCD.

Base screen
The screen displayed over the ontive GOT display area
The base screen comprises figure and object settings.

Basic monitor
The general name for the basic GOT functions
This means the basic functions of an electronic operation panel, such as switch and lamp functions and number data and message display.

Bit device
Located in the PLC device, and transmits information with one bit.
In a GOT, each bit of a word device can be used as a bit device.

Bit map (BMP)
This is a file format for storing pixel images and is indicated with the extension (.BMP).
In a GOT, bit maps can be used as figure or part data.
BMP files can be output with image scanners or commercially available graphics software.

Blink
Makes the display go on and off repeatedly and cyclically

Buffer memory (BM)
Memory unique to PLC special function module It can be read and written directly from a GOT.

Bus connection
Connection of the GOT to the PLC base with an extension cable
This connection is through the I/O bus. The GOT can be used with about the same responsiveness as a conventional pushbutton.

Cascade (menu)
When a GT Designer2 menu, the menu is selected is displayed lined up from top to bottom.
When an item in this vertical menu is selected, a horizontal menu is displayed on the left. This state is called cascade display.

Click
Moving the cursor to the desired position on the screen, then to pressing the mouse button once is called clicking.
Pressing the mouse button twice in a row quickly is called double clicking.
Moving the mouse cursor to the desired position holding down the mouse button, Then releasing the mouse button is called dragging.

Communication driver
This is one type of software (OS) for communicating with the PLC.
There is a dedicated communication driver for each communication format (bus connection,
direct CPU connection, etc.), so always install it on the GOT with the OS installation function.

Counter (C)
This is a device that counts how many times the input came ON and switches the contact ON when the set value is reached.
To clear a counter value, it is necessary to reset the counter with a reset command.

Cyclic communication
This is a function for data communication between stations on the same network with MELSEC.
This function uses the link relay (B), link register (W), link input (X), and link output (Y) devices.
A GOT directly connected to MELSECNET can use B and W as its own station devices.

Data register (D)
This is a PLC register for storing numbers. It is also called a D register.
A data register can handle 16-bit or 32-bit data.
With some PLC types, the data registers can handle not only integers, but real numbers as well.
The GOT has dedicated GD registers.

Default value
This is the initial value.

Device
This is the general name for memory in the PLC CPU.
There are various devices, such as input (X), output (Y), and data register (D), for various applications.

Display conditions (write conditions)
Operating (displaying or writing) only when the set conditions are met.
There are the following eight types of conditions.
• Ordinary: Always display.
• Rising: Only display when the specified device comes ON.
• Falling: Only display when the specified device comes ON.
• While ON: Always display while the specified device is ON.
• While OFF: Always display while the specified device is OFF.
• Sampling: Display with the specified cycle unit (1-3600 seconds).
• Cycle during ON: For each specified cycle (1-3600 seconds), always display if the specified device is ON.
• Cycle during OFF: For each specified cycle (1-3600 seconds), always display if the specified device is OFF.

Display Method
The display color, operations, etc. can be changed for each specified range.
The display area corresponding to monitor device value is specified by a comparison expression.
Download
To transfer screen data from the GT Designer2 PC to a GOT. Since data can be transferred divided by screen unit, comment, and part, you can download just the screen data you need for the circumstances. The reverse operation, of picking up screen data, is called uploading.

---

**E**

**Edge trigger**
A trigger that updates the data display when the rising or falling edge of the specified bit is detected.
Even if the trigger is not generated, the data can be forcibly displayed ON at the first time after the screen is switched.

**Edit Vertex**
This is an editing function for changing the position of vertices of polygons or consecutive straight lines after drawing.

**EL**
Electro Luminescence; an orange/black monochrome display device
One type of display element
The same as LCDs, ELs have low brightness and are eye friendly.

**EN Standard**
Indicates a product that conforms with EC directives.
The EN Standard is one standard in EC directives (laws).
There are three main relevant EC directives: EMC directives, low-voltage directives, and mechanical directives. The EN Standard is the standard used for products meeting these directives. (for example, safety)

**Extension cable**
This cable connects the PLC extension base (basic base) and the GOT when the PLC and GOT are connected with a bus connection.

**Extension file register (R)**
These are file register extension registers in the PLC memory cassette.
The extension file register capacity is set with parameters.
The capacity that can be set depends on the CPU used and the memory cassette capacity.
Indicated with R with MELSEC-Ai.
Indicated with R and ZR with MELSEC-QnAi.

---

**F**

**Falling (trigger)**
This is the status when the devices goes from ON to OFF.
With a GOT, the condition established just once at the fall is called a falling trigger.
Be aware that after the device falls, if the time until it comes ON is short, sometimes the fall cannot be detected and display is not possible.
By setting "initial display", the falling can be forcibly established once even if no trigger is generated when the screen is switched.
File register (R)
These are extension registers for when data registers (D) are insufficient.
The file register capacity is set with parameters.
The capacity that can be set depends on the CPU used and the memory cassette capacity.

Free location touch switch
Free location touch switches are so called because they are touch switches with a minimum of 16-by-16 dots (one double-byte character worth) and they can be located freely per dot.
The enabled/disabled area can be specified and the switch can also be protected conditionally.

G

Graphic operation terminal
The name of the Mitsubishi Electric display unit.
The name GOT is an acronym for Graphic Operation Terminal.

H

Handle
This is the small filled square displayed on the rectangle surrounding a figure when a figure is selected. Moving the mouse cursor here changes the shape of the cursor.
If the mouse is moved with the left mouse button held down, the figure size can be changed.
By holding down Shift key while the above operation, the figure size can be changed while maintaining the aspect ratio.

I

Icon
In Windows, a picture selected (by double-clicking it with the mouse) in order to execute an application such as GT Designer2

Install
To register application software on a PC or GOT
The GOT OS is installed on the GOT from GT Designer2.
This function is called the OS installation and is executed by selecting [Communications] - [Communicate with GOT] from the menu.
In an OS installation, it is possible to install only the necessary elements of each of the following functions.
Standard monitor OS
Communication driver
Option OS (standard fonts (Chinese, simplified characters), recipes)

<Note>
At least one connection type driver for connecting with the PLC must be installed.

Instantaneous power failure
A power failure of extremely short duration.
The PLC/GOT do not treat a power failure lasting less than 20 ms as a power failure.
A power failure lasting longer than this results in initial processing the same as when the power is first switched ON.
Interlock
This is a block that prevents the system from shifting to the next operation until the operation being executed is completed. Interlocks are used to prevent devices from going out of control or being destroyed.
Normally, interlocks are put in place using bit devices.
Such signals are called interlock conditions.
With a GOT, two types of interlocks can be set: display conditions and write conditions.
Display condition: An operation condition check based on an edge trigger or level trigger
Display method: A check based on the display range or write range

IP65F
IP is the abbreviation for International Protection; this indicates a product that conforms with IEC standard 529.

<table>
<thead>
<tr>
<th>Code</th>
<th>Protection</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP 6</td>
<td>No dust penetrates.</td>
</tr>
<tr>
<td>5</td>
<td>Is not harmed by direct spraying of water, for example at locations cleaned periodically.</td>
</tr>
<tr>
<td>F</td>
<td>Is not harmed by oil drops or application of oil, for example at locations cleaned periodically.</td>
</tr>
</tbody>
</table>

ISO9001
ISO9000 covers a series of standards from the International Standard Organization. These are international standards prescribing quality system requirements with the objective of assuring quality to customers.
The GOT1000 has received ISO9001 certification.

Key window
This is a window for which the number input keys are set.
There are decimal and hexadecimal system number key windows, so there is no need to set (create) the number keys on the screen.

Layer
This is a function that divides a single screen into two structures, the front screen and the back screen, making it possible to set objects for each layer separately.
Objects set for the front screen layer and back screen layer respectively can also be displayed overlaid.
Layer processing
   Name of operation processing for screen switching
   Since the screen switching is layered, it can be executed automatically without setting the
   layer structure.

Level trigger
   A trigger that always updates the data display timing only when the specified bit is ON or
   when it is OFF.

Library
   A library comprises figures and objects and is a group of information having one meaning.
   The individual group information becomes a template.
   A screen can be created by pasting the templates on the screen in the appropriate
   combination.

Maximize button
   The maximize button is at the right of the window title bar. Clicking this button expands the GT
   Designer2 or other application to be displayed over the entire screen (maximized display).

Maximize display
   This is the act of displaying GT Designer2 or some other application over the entire screen or
   the state in which the application is so displayed.

Memory card (CF card)
   Since screen data can be stored on a memory card, a memory card is used for high-speed
   copying of screen data to other GOTs.
   If an alarm log is stored to a memory card, this alarm log can be displayed even after the
   power is switched OFF, then ON again.

Menu bar
   The menu bar is positioned one row beneath the application window title bar.

Message display
   Displays explanations of operations, functions, etc. for the processing (function) selected by
   the user.

Momentary
   This is a function that switches ON the specified bit device only during touch switch input.
   This function can also switch ON specified bits of buffer memory or word devices.

Multi-language type
   A GOT supports about 26,000 different characters for the writing systems of various nations
   as standard, so it can be used in the nations of the world.
   Japanese, Korean, Chinese, or the like characters can be input with the Front-End Processor
   (FEP) for that language.

Multi-task real-time OS
   A multi-task OS executes multiple tasks on a computer simultaneously.
   Through the use of such an OS, a GOT can control communications, display, input, etc., all in
   real time.

Appendix 75
Number keys
These are the keys for inputting numbers 0-9.
A GOT has system number key windows, so there is no need to set (create) the number keys on the screen.

Object
With the GOT1000, the desired functions will be available by pasting switch figures, lamp figures, numeric display frame figures, etc, with GT Designer2 to set the compatibility between PLC device memory (bit, word) and operation functions.
The setting targets are called objects.

Operating ambient temperature
This is the operating ambient temperature range after the device power is switched ON.
Since the PLC is normally installed in a control panel, the temperature mentioned above means in the control panel.
Pay attention to the fact that part of the GOT is in the control panel and part is outside the control panel and those parts have different operating ambient temperatures. (See below.)
Display section: 0 to 50°C
Other than display section: 0 to 55°C

Operating System (OS)
Generally, this means the basic software for computers, etc. This is the software for running programs created by the user.
In the PLC, the OS is for running the sequence programs and in the GOT, the OS is the program for operating the screen or touch switches as set and is supplied by Mitsubishi Electric.

Ordinary trigger
A trigger that constantly updates the data display.

Ordinary write
To update the contents displayed when there is any change in the data, rather than using a trigger in the display or input state as the trigger for data display or input.
See "Trigger write".

Output (Y)
This signal outputs the results of PLC calculations to the outside with ON/OFF.
The device name is expressed with Y.
The PLC output unit has relays, triacs, and transistors.

Overlap window
A pop-up screen that appears over the base screen.
Up to two overlap window screens can be displayed on one base screen.

Parts movement (locus display)
This operation erases the parts (figures) displayed just before, moves the parts to the specified new position (according to the coordinate device value), and displays it there.
With parts movement, it is also possible to remain that the parts displayed just before the movement.
Such display is called parts locus display.

Parts
Parts comprise figures and are used with the "parts display" and "parts movement" functions.
The figures that can be used in parts include text and image data.

Password
The GOT1000 has two types.
  Screen data upload/download password
  Security function password

Periodic trigger
A trigger that updates the data display timing each time it is specified

Project (file)
The collection of all the information displayed on a single GOT is called a project.
A project comprises screen information, parts information, etc.
This information (project) is created in one file.
However, the library information only is created in a separate file.

Recipe
The recipe function writes and reads the values of devices specified by the PLC CPU according to the specification conditions (device ON/OFF).
The read-out data can be saved in a CSV-format file on a PC card for editing on a PC.

RST (reset)
To initialize the PLC (the same as when it is switched from OFF to ON)
With MELSEC, all coils except latch devices go OFF, and timers, counters, and data registers go to 0.
A command reset switches OFF all coils that are ON.

RISC chip
A RISC (Reduced Instruction Set Computer) is a computer whose central processing can execute high-frequency processing in a concentrated manner and at high speed through the analysis of high-level language programs.
Such a CPU narrows the number and types of commands to increase speed and is appropriate for equipment processing large volumes of data at high speed, such as workstations.

Rising (trigger)
This is the status when the devices goes from OFF to ON.
With a GOT, the condition established just once at the rise is called a rising trigger.
Be aware that after the device rises, if the time until it goes OFF is short, sometimes the rise cannot be detected and display is not possible.
By setting "initial display", the rising can be forcibly established once even if no trigger is generated when the screen is switched.
Screen

There are two types of screens: the base screen and the window screen.
The screen comprises objects and figures.

Screen Name

With GT Designer2, the project title and screen title can be set.
Project title: Comprises the title information, detailed information, and author name.
Screen title: Comprises the title information and detailed information.

Screen preview

This function can reproduce the screen display image or other displays on GT Designer2.

Screen saver function

This is a function that turns off the display on the GOT display if it goes untouched for a certain period of time.
While the display is OFF, the display can be switched to ON by touching any on the screen.
In this case, the touch switch belonging pressed does not operate.

Screen switching

This switches between the GOT base screen and window screen.
To switch between the screens, the word device for base and or window screen switching must be set.
In addition to the PLC word devices, GOT dedicated devices (GD) in the GOT can be also used.

Script function

The script functions are functions designed to control the GOT display with the GOT’s original programs.
Controlling the GOT display with the GOT side script drastically reduces the load on the system side (e.g. PLC CPU, microcomputer) display.

Self check

This is a function with which the GOT (CPU) detects its own errors.
This function tests the GOT hardware, communications, memory, display, etc.

Serial communication

This is a method of communication that sends the data per bit along one line as the time goes by over time, one bit.

Serial communication unit

The module that provides the functions for connecting with the PLC and a computer (GOT or personal computer) and reading/writing PLC devices.
When connecting the GOT1000, a communications module for the GOT is required.

Set

To switch ON the bit device or the specified bit of the word device of the PLC
The signal switched ON remains ON until it is reset.

Setting value

This is the setting value for a PLC timer (T) or counter (C) and is the numeric value used as the goal.
In sequence programs, setting values can be set with fixed values or specified indirectly.
With a GOT, setting values can be monitored and changed from the system monitor screen.
Shortcut keys

Shortcut keys are keys or combinations of keys that allow operations without opening the menu.
Shortcut keys operate combining alphanumeric keys with Ctrl key or Alt key.

Special (D)/(SD)

These are registers with determined applications in the PLC.
A variety of information can be viewed, including PLC CPU information and MELSECNET information.
The QCPU and QnACPU have dedicated SD devices.
With the ACPU, these are D9000-.

Special internal relay (M)/special relay (SM)

These are internal relays (M) with determined applications in the PLC.
A variety of information can be viewed, including PLC CPU information and MELSEC information.
The QCPU and QnACPU have dedicated SM devices.
With the ACPU, these are M9000-.

Status display bar

The status display bar is the bottom line of the GT Designer2 display. It displays guidance, cursor information, position information, etc.

STN

STN (Super Twisted Nematic) liquid crystal
A simple matrix type LCD that seals liquid crystals between multiple transparent electrodes lined up vertically and horizontally and that displays the desired image by applying signal voltage to the electrodes to control the liquid crystal array state at the intersections. Pixels are switched ON/OFF by twisting liquid crystal molecules and by aligning them into straight lines.
The GOT1000 can display 256 colors or 16 tones of monochrome (black and white).

System information

This function transmits the GOT status (screen number being displayed, error number, etc.) to the PLC, and outputs information (GOT error resets etc.) from the PLC to the GOT. This function is set to a word device.
A read device reads information to the GOT.
A write device writes information from the GOT.

---

Template

Templates are for easily saving and reading figures and objects.

Text file

This is a file containing only letters, numbers, and symbols.
A comment can be output to a text file, edited with an editor, and the edited file can be input.
Since object settings and other GOT screen information can be output to a text file with the print function, it is also possible to read this file into a word processor and create an original document.
TFT
A color liquid crystal display using TFTs (Thin Film Transistors)
Thin-film transistors are laid out at the intersection of transparent electrodes lined up vertically and horizontally. This is an active-matrix type of LCD in which the liquid crystal is driven by these thin-film transistors so laid out.
The response is fast. For color display, there are three TFTs for each pixel, and the light from each TFT is passed through a red, green, or blue color filter.
Compared to simple matrix LCDs, there is no tendency to low contrast, and the number of scanning lines can be increased, and intermediate tone expression is also easy, so this type of LCD can display with high quality. On the other hand, the structure is complex, resulting in high cost.
On the GOT1000, display is 256 colors/65536 colors.

Timer (T)
This is a device that has the function of operating the timer coil after the specified time (timer setting value). The objective is to delay or hold an operation.
There are two types of timers: 10ms and 100ms.
The timer has a contact, coil, current value, and setting value. On the GOT monitor screen, all of these except the setting value can be monitored and written.
The setting value can be monitored/written with the system monitor function.

Tool bar
This is a list of buttons etc. for menu items used relatively frequently.
The following types of GT Designer2 toolbars are available.
Tool bar (Standard): The standard group of functions such as New or Save
Tool bar (View): A group of functions for setting the display, such as screen zoom or grid color
Tool bar (Figures): A group of functions for setting figures such as straight line or text
Tool bar (Objects): A group of functions for setting objects such as touch switches
Tool bar (Figure edit): A group of functions for editing figures, such as front line display or flip horizontal
Tool bar (Alignment): A group of functions for arranging the positions of figures and objects
Tool bar (Figure drawing): A group of functions for setting display attributes such as the line style or pattern foreground color
Tool bar (Communications): A group of functions for data transfer between a GOT and PC card
Tool bar (Comment): A group of functions for setting the comment function

Touch switch
By pressing the screen, screen switching or writing to a device can be performed.
The minimum size is a unit of one double-byte character (16 by 16 dots).

Transfer format OS program
See "Install".

Transparent function
When connecting a GOT and PLC CPU with direct CPU connection or a bus connection, connecting a PC or other peripheral device allows the sequence programs of the CPU to be read, written and monitored.
Trigger write
Operating (displaying or writing) only when the set conditions are met.
These conditions are called trigger conditions. See "Ordinary write".

Unicode system
Unicode is an international standard for character codes.
The advantage of the Unicode system is that it provides a completely universal means for multi-nationalizing applications.

Upload
To read screen data from the GOT using GT Designer2
The read-out screen data can be re-edited, then transferred back (downloaded) to the GOT

Window screen
A pop-up screen that appears over the base screen.
A window screen can be closed by touching the button at the top right of the window screen.
The top row on the window is the window screen move key. If this move key is touched, and another location is touched, the window screen is moved so that its top left coordinate is at the location you touched.
The same as for the base screen, all objects can be set on the window screen.
If a touch switch on the base screen is overlaid by the window screen, that switch is disabled.

Word device
Of the PLC devices, word devices are those that transmit information with 16 bits (one word).
With a GOT, word devices can be handled with 16 bits or 32 bits.
As data types, word devices support signed integers, unsigned integers, and real numbers.

Word device set
This is a function that writes the specified value to a word device when there is input at a touch switch.
The specification type can be selected from fixed value, value of another word device, and fixed value added to (or subtracted from) the current device value.
Specifications subject to change without notice.